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© 1997 Adaptec, Inc. All rights reserved. No part of this publication may be repro-
duced, stored in a retrieval system, or transmitted in any form or by any means, elec-
tronic, mechanical, photocopying, recording or otherwise, without the prior written 
consent of Adaptec, Inc., 691 South Milpitas Blvd., Milpitas, CA 95035.

Trademarks
Adaptec, the Adaptec logo, Array1000, ArrayConfig, CI/O, RAIDport, the RAIDport 
On Board logo, AAA, and ARO are trademarks of Adaptec, Inc. which may be regis-
tered in some jurisdictions. 
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Changes
The material in this document is for information only and is subject to change with-
out notice. While reasonable efforts have been made in the preparation of this docu-
ment to assure its accuracy, Adaptec, Inc. assumes no liability resulting from errors or 
omissions in this document, or from the use of the information contained herein.

Adaptec reserves the right to make changes in the product design without reservation 
and without notification to its users.

Adaptec Technical Support and Services
If you have questions about installing or using your Adaptec product, check this 
user’s guide first—you will find answers to most of your questions here. If you need 
further assistance, please contact us. We offer the following support and information 
services:

Electronic Support
Technical information, including product literature, answers to commonly asked 
questions, information on software upgrades and other topics is available electroni-
cally through the following:

■ Adaptec World Wide Web (WWW) site at http://www.adaptec.com.
■ File Transfer Protocol (FTP) server at ftp.adaptec.com.

■ Adaptec USA Bulletin Board Service (BBS) at 408-945-7727; supports up to 
28,800 bps (bits per second), 8 data bits, 1 stop bit, no parity. No product litera-
ture is available on the Adaptec BBS.

■ Interactive Fax System at 408-957-7150; available 24 hours a day, 7 days a week.

Technical and Product Support

■ For technical support and information about many of Adaptec’s electronic sup-
port services, call 800-959-7274 or 408-945-2550, 24 hours a day, 7 days a week.

■ To use the Adaptec Interactive Support System, call 800-959-7274 or 
408-945-2550, 24 hours a day, 7 days a week. The system prompts you with 
questions regarding your problem and then provides step-by-step trouble-
shooting instructions.

■ To speak with a product support representative, call 408-934-7274, M–F, 
6:00 A.M. to 5:00 P.M., Pacific Time. After hours, on weekends, and on holidays, 
product support is also available for a fee at 800-416-8066.
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Sales and Ordering Information

■ For sales information, call 800-959-7274 or 408-945-2550, M–F, 6:00 A.M. to 5:00 
P.M., Pacific Time.

■ To order Adaptec software and SCSI cables, call 800-442-7274 or 408-957- 7274, 
M–F, 6:00 A.M. to 5:00 P.M., Pacific Time.

■ To request additional documentation for Adaptec products, call 800-934-2766 
or 510-732-3829, M–F, 6:00 A.M. to 5:00 P.M., Pacific Time.

Errata
To review errata information associated with the Array1000 Family product and its 
documentation, view the readme files in a text editor or word processing program. 
You can find the readme files on the Adaptec CI/O Array Management Software 
compact disc and on the Array1000 Family Manager Set diskette.
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1▼  ▼  ▼  ▼
Getting Started
This document explains how to manage arrays with the software 
included with your Adaptec® Array1000™ Family product. It 
includes instructions on using all the software features and informa-
tion on how to replace drives, reconstruct arrays, etc. The Installation 
and Hardware Guide for your Adaptec Array1000 Family product has 
instructions on how to install the software (including drivers) on the 
server and on networked clients.

The Adaptec Array1000 Family currently includes the following 
products: 

Note: The three AAA™-13x array adapters are part of the 
AAA-130 Series.

■ AAA-131 Array Adapter, a half-size PCI form factor board 
with one SCSI channel. This array adapter supports up to 15 
Fast/Wide SCSI or UltraSCSI devices—both disk drives and 
other kinds of SCSI devices.

■ AAA-132 Array Adapter, a full-sized PCI form factor board 
with two SCSI channels. This array adapter supports up to 30 
Fast/Wide SCSI or UltraSCSI devices—both disk drives and 
other kinds of SCSI devices.

■ AAA-133 Array Adapter, a full-sized PCI form factor board 
with three SCSI channels. This array adapter supports up to 45 
Fast/Wide SCSI or UltraSCSI devices—both disk drives and 
other kinds of SCSI devices.
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■ ARO™-1130 PCI RAIDport™ Card, a RAID co-processor 
upgrade card for RAIDport™ On-board systems and mother-
boards. RAIDport On-board systems and motherboards 
include a RAIDport connector and one or more Adaptec 
UltraSCSI ASICs on the motherboard. The ARO-1130 upgrades 
one, two, or three UltraSCSI channels on the motherboard to 
Adaptec RAID. The ARO-1130 card itself has no internal or 
external SCSI connectors.

Array Management Software Overview
Here is a brief description of the array management software 
included with your Adaptec Array1000 Family product.

■ ArrayConfig™ Initial Boot Array Installation Utility - After 
you install your Adaptec Array1000 Family product in a server 
or workstation you use the ArrayConfig program to create the 
first array, to designate a boot array (if desired), and to create 
spares. ArrayConfig runs from a self-booting diskette and can 
be used before you install NetWare or another operating sys-
tem on the server. ArrayConfig is documented in Part 1 (Chap-
ter 2) of this document.

■ Adaptec CI/O™ Array Management Software (NetWare 
server) You install the character-based version of Adaptec 
CI/O Array Management Software on servers running under 
NetWare. This program is used for ongoing management of 
the server on which it is installed: adding arrays and spares, 
viewing array and device information, scheduling array opera-
tions, and so on. The NetWare version of Adaptec CI/O Array 
Management Software is documented in Part 2 (Chapters 3 
through 6) of this document.

■ Adaptec CI/O Array Management Software (Windows NT™ 
server) - You install the graphical user interface (GUI) version 
of Adaptec CI/O Array Management Software on servers run-
ning under Windows NT. Like the NetWare version, this pro-
gram is used for ongoing management of the server on which 
it is installed. The Windows NT version of Adaptec CI/O 
Array Management Software is documented in Part 3 (Chap-
ters 7 through 12) of this document. 

■ Adaptec CI/O Array Management Software (Windows® 
client) - You install the Windows client version of Adaptec 
1-2
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Getting Started
CI/O Array Management Software on networked clients run-
ning under Windows 3.11, Windows® 95, or Windows NT 
Workstation 3.51 or 4.0. Like the Windows NT server version, 
this program is used to monitor and manage server and array 
activities. Unlike the other versions, it gives you access to 
information on multiple servers to which the client is con-
nected via the network. The Windows client version of 
Adaptec CI/O Array Management Software is documented 
together with the Windows NT server version in Part 3 (Chap-
ters 7 through 12) of this document because the appearance 
and operation of these applications is nearly identical.

Using the Array Management Software
Here is some general information on using the Adaptec array man-
agement software most effectively.

■ Use ArrayConfig to create your first array(s) when you are con-
figuring the server. We recommend that you use RAID 1, 
RAID 0/1, or RAID 5 arrays because of their data redundancy 
features. (RAID 0 arrays are also supported.)

■ We recommend that you create a bootable array so you can 
boot the server from it instead of from a stand-alone disk drive. 
A bootable array protects your network operating system files 
and data files from a disk drive failure.

■ Use the password feature of Adaptec CI/O Array Manage-
ment Software to prevent unauthorized users from changing 
your array configuration.

■ Use Adaptec CI/O Array Management Software to monitor 
the status of arrays and other devices on the server. It is espe-
cially convenient to use the Windows client version to do this, 
because you can receive status updates (event notifications) 
from multiple remote servers. You can simultaneously monitor 
servers running under different operating systems.

■ Be sure that arrays are adequately protected with spare pools 
(recommended) or dedicated spares. You can create and delete 
spares with any of the array management software programs.

■ Use Adaptec CI/O Array Management Software to set up reg-
ularly scheduled verification of fault-tolerant arrays and test-
1-3
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ing of spares. Respond immediately to arrays in Critical status, 
and replace failed spare disks promptly.

■ Use Adaptec CI/O Array Management Software, running 
either on the server console or on a networked client, to add, 
delete, or reconfigure arrays after the server has already been 
in use. (You need special access rights in order to change the 
server configuration.) Or use ArrayConfig to do these tasks 
from the server while the server is off-line.

Conventions and Advisories
This document uses the following typographic conventions:

bold
Used for key names (… press the Enter key …) and for options 
you are told to select (… select Configure SCSI Channels…).

Helvetica
Used for screen messages (…Save changes?…) and for text 
that must be typed exactly as shown.

Helvetica Italics
Used for program and file names when referenced in the text 
(… these changes are made to the config.sys file…).

This document uses two kinds of advisories:

Note: This kind of advisory presents reminders, tips, or sug-
gestions for using the array management software.

Caution: This kind of advisory cautions you about actions 
that could destroy data or damage the computer system.

Use caution when handling any electrical equipment. Advisories in 
this document can only cover the procedures contained here, and 
not all situations may have been addressed. Adaptec does not claim 
to have included every condition or situation that might require a 
Caution or Warning. You must refer to the documentation for your 
computer and peripheral devices when you are installing equipment 
or changing its configuration.

❒
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2▼  ▼  ▼  ▼
Using the ArrayConfig 
Initial Boot Array 
Installation Utility
This chapter explains how to use the ArrayConfig Initial Boot Array 
Installation Utility to create and delete arrays and spare disks. You 
can use ArrayConfig to create a bootable array for the server. We rec-
ommend that you configure the server to boot from an array instead 
of from a single disk. This provides greater protection for network 
operating system files and data files stored on the array.

ArrayConfig runs from a diskette, so you can run it when the server 
is off-line and the operating system is not running. Nearly all 
ArrayConfig functions except creating a bootable array can also be 
performed with Adaptec CI/O Array Management Software, which 
runs under Windows and NetWare.

See the Installation and Hardware Guide for your Adaptec Array1000 
Family product for information on connecting SCSI devices, install-
ing software, preparing to run ArrayConfig, and creating your first 
array with ArrayConfig.
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Creating an Array with Array Config
You can create arrays with ArrayConfig or with Adaptec CI/O Array 
Management Software, which is described in Parts 2 and 3 of this 
document. However, if you want to install the operating system on 
the array, you must create the array with ArrayConfig. The following 
instructions can be used to create a bootable or a non-bootable array.

Note: To select ArrayConfig menu options, type the hot key—
the letter that appears in a different color. (The hot key let-
ters are underlined in the following instructions). You can 
also press the ↑ and ↓ keys until the option is highlighted 
and then press Enter. If you have a monochrome monitor 
and the highlight bar is not visible, press Ctrl-B to change to 
monochrome mode.

1 Insert the copy of the ArrayConfig diskette in drive A of the 
server with the Adaptec Array1000 Family product and boot 
the server. The program will start automatically.

2 Select Disk Array Operations from the Main Menu.

3 Select Create New Array from the Disk Array Operations 
menu.

4 Type an array name and press Enter. The name can be up to 15 
characters long and can include spaces and any other printable 
characters.

5 Select an array type from the list. Your options are

– RAID 0: Data is striped across the disks in a RAID 0 array, 
allowing for faster I/O performance than a single disk. 
RAID 0 arrays do not store redundant data; if any disk in 
the array fails, all data is lost.

– RAID 1: Data is mirrored on one pair of disks. If one disk 
fails, data is still safe. The actual usable data capacity of the 
array equals half the available disk space.

– RAID 5: The array contains redundant (parity) data dis-
tributed across all disks in the array. If any one disk fails, 
data can be reconstructed from the parity information. If a 
second disk fails before the array has been reconstructed, 
all data is lost. The actual usable data capacity of the array 
2-2
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is equal to one less than the total number of disks. (One 
disk’s worth of capacity is needed to hold the parity infor-
mation.)

– RAID 0/1: Data is striped and mirrored on two or more 
pairs of disks. If one disk in a pair fails, data is still safe. 
The actual usable data capacity of the array equals half the 
total available disk space.

See Appendix B, Understanding Arrays and RAID Technology, for 
more information on RAID levels and RAID technology.

6 Type the number of drives you want in the array and press 
Enter. This number should not include spares (drives that will 
automatically replace failed array drives). The number of 
drives available for assignment is listed on the screen.

Note: This step does not apply to RAID 1 arrays, 
which have two drives by definition.

7 When the next screen appears, press Tab to highlight a channel 
(if your Adaptec Array1000 Family product has more than one 
channel). When the drives on the highlighted channel appear in 
the SCSI IDs on Channel menu, select drives for the array. To 
do this, press the ↑ and ↓ keys until the drive name is high-
lighted, and then press Ins or Enter. The names of selected 
drives appear to the right, in the Adaptec Array # box.

To select drives on a different channel (if necessary) press Tab 
to select another channel and then select the drives from the 
SCSI IDs on Channel menu. To deselect the drive you most 
recently added, press Del.

Caution: A warning appears if you select a disk that 
has partitions. Do not select disks with partitions if 
they contain data you want to keep, because any exist-
ing data will be erased when the disk becomes part of 
the array.

When you have selected the number of drives you specified in 
Step 6, the next screen appears automatically. If you are creat-
ing a RAID 1, RAID 0/1, or RAID 5 array, and if there are any 
2-3
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unassigned drives, the screen prompts you to define dedicated 
spare drives for the array. (We recommend that you use a spare 
pool instead of dedicated spares. See Adding a Disk to a Spare 
Pool on page 2-9 for more information.)

Note: A spare must have at least the capacity of the 
smallest drive in the array.

8 If you do not want a spare, type n and continue with Step 10. If 
you want to select dedicated spares, follow these steps:

a At the prompt, type y.

b At the next prompt, type 1 or 2.

c Select one or two spares, using the same method you used 
to select disks for the array.

9 When the Initialize Mode menu appears, select Initialize 
Array to Zero. Formatting begins immediately. A graph on the 
screen shows the progress of this operation.

Caution: If the drives contain data, all the data is lost 
when you initialize the array.

Select Low-Level Format only if the drives were previously 
formatted on another system or if you think they may have 
surface defects. Low-level formatting takes a long time for 
large disk drives. (See Initializing an Array on page 2-7 for more 
information.)

Note: If your disk drives initialize very slowly when 
you create arrays, you may be able to speed them up 
by changing a setting in the arconfig.ini file (located on 
the ArrayConfig diskette). To do this, open arconfig.ini 
in a text editor and find this line: rem WriteSame=Yes. 
Delete the letters rem and save the file in text-only for-
mat. The next time you run ArrayConfig the disks 
should initialize faster.
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10 When the menu of block sizes appears, select a block size. (This 
menu does not appear if the array is a mirrored array with only 
two drives.)

The allowable block sizes are 8, 16, 32, 64 (the default), and 
128 KBytes. The default block size gives the best overall 
performance in most network server environments.

11 When you see the message Initialization of [array name] is com-
plete, press any key to return to the Disk Array Operations 
menu.

12 To create additional arrays (if disks are available), repeat Steps 
3-10. When all arrays are created, exit from ArrayConfig, 
remove the ArrayConfig diskette, and reboot the computer. 
After you reboot you can write data to the arrays.

Making the Array Bootable
Follow these steps if you want the server to boot from the newly cre-
ated array or if you want to change the boot order of existing arrays:

1 Select Display Boot Order from the Main Menu. The Boot 
Order for Singles and Arrays window appears.

2 If the newly created array is at the top of the list, preceded by 
the words Unit 0, no changes are necessary; if it has some other 
unit number, highlight the array name and press Enter to select 
it.

3 Use the arrow keys to move the selected array to the top of the 
list. Then press Enter to de-select it. If you want to change the 
boot order of another array, select it, move it with the arrow 
keys, and press Enter again.

4 When you are finished, press Esc to return to the Main Menu.

Note: You cannot use this procedure to change the boot 
order of a SCSI disk drive that is not part of an array. If you 
want to do this, create a one-disk RAID 0 array from the 
disk. (Data is not actually striped on a one-disk array.)

For more important information on creating a bootable array, see the 
Installation and Hardware Guide for your Adaptec Array1000 Family 
product.
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Other Array Config  Options
The remainder of this chapter explains how to use the other 
ArrayConfig options. You can also create and manage arrays with 
the Adaptec CI/O Array Management Software, which is described 
in Sections 2 and 3 of this document.

Displaying Array Information
Follow these steps to display information about existing arrays on 
the server or workstation:

1 Select Disk Array Operations from the Main Menu.

2 Select Display Arrays from the Disk Array Operations menu.

3 When the list of arrays appears, highlight the array for which 
you want information and press Enter.

4 View the information that appears on the screen. This includes 
array type and status, array size, and information about each 
disk in the array.

5 Press any key to return to the Disk Array Operations menu.

Deleting an Array

Caution: All data is lost when you delete an array! Before 
you delete an array, back up any data you want to keep.

Follow these steps to delete an array:

1 Select Disk Array Operations from the Main Menu.

2 Select Delete Array from the Disk Array Operations menu.

3 When the list of arrays appears, select the array you want to 
delete.

Caution: A warning appears if you select an array that 
has partitions. Do not delete an array with partitions if 
it contains data you want to keep, because any exist-
ing data will be erased. Be especially careful not to 
select your boot array!
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4 View information about the array and make sure you really 
want to delete it. Press any key to continue.

5 Type y to delete the array (or n to cancel the operation).

6 When the message [Array name] deleted appears, press any 
key to continue.

The drives that were formerly part of the array can now be used as 
stand-alone drives or as members of another array. Deleting an array 
may change the boot order and the drive assignment.

Initializing an Array
When you create a new array, you are automatically prompted to 
initialize (format) it. You can also select the Format/Initialize Array 
option as a separate command, perhaps to reinitialize an array that 
has become corrupted.

Here is more information on the two initialization methods:

■ Initialize Array to Zero: (Recommended method) Fills the 
array with zeroes. This option is faster than a low-level format, 
but it does not verify the integrity of the disks.

■ Low-level Format: Performs a low-level SCSI format. This 
writes a consistent pattern to the disks, checks the disks for 
defects, and fills the array with zeroes. Low-level formatting 
can take a long time if the disks are large.

Caution: Formatting or initializing an array erases all data 
on the array and cannot be aborted once it has started. If the 
array contains data you want to keep, be sure to back it up 
first!

Follow these steps to initialize an array:

1 Select Disk Array Operations from the Main Menu.

2 Select Format/Initialize Array from the Disk Array Operations 
menu.

3 When the list of arrays appears, select the array you want to 
initialize.

4 Type y to confirm that you want to format the array.
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Caution: A warning appears if you select an array that 
has partitions. Do not initialize an array with partitions 
if it contains data you want to keep, because any exist-
ing data will be erased. Be especially careful not to ini-
tialize your boot array!

5 When the Select Format Mode menu appears, select Initialize 
Array to Zero or Low-Level Format.

6 When the list of block sizes appears, select a block size. The 
allowable block sizes are 8, 16, 32, 64 (the default), or 
128 KBytes. (This menu does not appear if the array is a mir-
rored array with only two drives.) The default block size pro-
vides the best overall performance for most applications. 
Formatting begins immediately.

7 When you see the message Initialization of [array name] is com-
plete, press any key to return to the Disk Array Operations 
menu.

Creating and Deleting Spares
Spare disks (spares) are an important data protection and real-time 
recovery feature of RAID 1, RAID 0/1, and RAID 5 arrays. (RAID 0 
arrays do not support spares.) If a disk in an array fails while the 
server is running, a spare is activated immediately to take its place. 
The array software automatically reconstructs the necessary data on 
the new disk, and array operation continues uninterrupted.

You can create one or two dedicated spares, which can be used only by 
a single specified array. We recommend, however, that you create a 
spare pool instead. The spares in a spare pool can be used as needed 
by any array connected to the same controller, if the spare is at least 
as large as the smallest disk in the array. A spare pool can have up to 
eight disks.
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Adding a Disk to a Spare Pool
Follow these steps to create a new spare pool or to add a disk to an 
existing spare pool. You should add a disk to the spare pool when-
ever one of these spares is automatically used to replace a failed 
array member.

1 Select Spare Pool Operations from the ArrayConfig Main 
Menu.

2 Select Add Device to Spare Pool from the Spare Pool menu.

3 Select a channel from the list, if necessary.

4 Highlight a disk to add to the spare pool and press Enter.

Caution: A warning appears if you select a disk that 
has partitions. Do not select disks with partitions if 
they contain data you want to keep, because any exist-
ing data will be erased when the disk is added to the 
spare pool. Be especially careful not to select your boot 
disk as a spare!

The spare is added immediately. Press any key to return to the 
Spare Pool Operations menu.

5 Repeat Steps 2-4 to add another disk to the spare pool. Spare 
pool disks can be connected to any channel on the adapter.

Note: You can add a disk of any size to the spare pool, 
even if the disk is too small to protect the existing 
arrays. For example, if you have created two arrays 
with 1 GByte members, you can add a 500-MByte disk 
to the spare pool, even though this disk is too small to 
replace any failed array member. If you later create a 
third array with 500-MByte members, the smaller 
spare pool disk can automatically replace a failed 
member of that array.

6 When you have finished adding disks, press Esc to return to 
the ArrayConfig Main Menu.
2-9

Adaptec Array1000 Family Array Management Guide
Stock Number: 511468-00, Rev. A Page: 2-9
Print Spec Number: 496645-00
Current Date: 3/2/99 ECN Date: 4/29/97



Adaptec Array1000 Family Array Management Guide
Deleting a Disk from a Spare Pool
Follow these steps to delete a disk from a spare pool:

1 Select Spare Pool Operations from the ArrayConfig Main 
Menu.

2 Select Delete Device from Spare Pool from the Spare Pool 
menu. The disk most recently added to the spare pool is imme-
diately deleted. Press any key to return to the Spare Pool 
menu.

3 Repeat Step 2 to delete another disk from the spare pool, if 
desired.

4 When you have finished deleting disks, press Esc to return to 
the ArrayConfig Main Menu.

Viewing Spare Pool Information
Follow these steps to view information about disks in a spare pool:

1 Select Spare Pool Operations from the ArrayConfig Main 
Menu.

2 Select Display Spare Pool Devices from the Spare Pool menu.

3 View the spare pool information that appears on the screen. 
When you are finished, press any key to return to the Spare 
Pool menu.

Adding a Dedicated Spare
When you create an array you have the option of adding one or two 
dedicated spares to it. You can also add dedicated spares to an exist-
ing array at a later time.

Note: We recommend that you create a spare pool instead of 
using dedicated spares. See Creating and Deleting Spares on 
page 2-8 for more information.

You cannot add dedicated spares to an array if

■ The array already has two dedicated spares

■ The remaining single disks are not at least as large as the small-
est disk in the selected array
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Follow these steps to add one or two dedicated spares to an array:

1 Select Disk Array Operations from the Main Menu.

2 Select Add/Delete Spare Drive from the Disk Array Opera-
tions menu.

3 Select the array to which you want to add the dedicated spare.

4 Select Add Spare Drive from the Add/Delete Spare menu.

5 Select a SCSI channel on the left, if necessary, and then press → 
to move to the list of disks on the right. Disks are grayed out if 
they are already used in an array or if they are smaller than the 
members of the array. Highlight an available disk and press 
Enter. Then select another disk for the second spare, if 
necessary. The new dedicated spare is added immediately.

Caution: A warning appears if you select a disk that 
has partitions. Do not select disks with partitions if 
they contain data you want to keep; any existing data 
will be erased when the disk becomes a spare. Be espe-
cially careful not to select your boot disk as a spare!

6 Press any key to continue.

Deleting a Dedicated Spare
Follow these steps to delete a dedicated spare:

1 Select Disk Array Operations from the Main Menu.

2 Select Add/Delete Spare Drive from the Disk Array Opera-
tions menu.

3 When the list of spare drives appears, select the one you want 
to delete and press Enter.

4 Select Delete Spare Drive from the Add/Delete Spare Drive 
menu. The dedicated spare is deleted immediately.

5 Press any key to continue. The disk that was formerly a dedi-
cated spare can now be used as a spare for another array or as a 
member of another array.

❒
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3▼  ▼  ▼  ▼
Configuring Arrays and 
Spares
This chapter explains how to use the menu-driven NetWare version 
of Adaptec CI/O Array Management Software to configure arrays 
and spares on your NetWare server. (See the Installation and Hard-
ware Guide for your Adaptec Array1000 Family product for instruc-
tions on installing Adaptec CI/O Array Management Software.) You 
can also configure arrays and spares with the ArrayConfig utility, as 
described in Chapter 2, or from a networked client, as described in 
Chapter 8.

When you are running the NetWare version of Adaptec CI/O Array 
Management Software you can press F1 on most screens to view on-
screen Help information.

Starting and Exiting the Program
Your server console may already be configured to start Adaptec 
CI/O Array Management Software automatically when you boot 
the server. Follow these steps if the program does not start 
automatically:

1 Start the server, if it is not already running.

2 Mount the sys volume, if it is not already mounted.

3 At the NetWare prompt, enter the command load cioams.nlm.
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Note: The Adaptec CI/O Array Management Software 
NLM may load automatically when you start 
NetWare, depending on the options you chose when 
you installed it.

4 When the Main Menu appears, as shown in Figure 3-1, you are 
ready to use Adaptec CI/O Array Management Software.

5 To exit Adaptec CI/O Array Management Software, return to 
the Main Menu and press Esc.

6 Type y in response to the prompt to confirm that you want to 
exit. Then reboot the server if necessary. (You must reboot 
before you can write data to newly-created arrays.)

Adaptec CI/O Array Management Software   NetWare Loadable Module

<  >Moves Cursor,<Enter> Selects Option,<ESC> Exits

Display information 
about devices connected
to Adaptec controllers

CI/O Array Manager Main Menu

Display Device Information
Device Operations
Disk Array Operations
Spare Pool Operations
Activity Scheduler
Rescan System
Display Event Log
Display Server Log
Set Remote Access Password
About CI/O Array Manager

<F1> Help

Figure 3-1. CI/O Array Management Software Main Menu
3-2

Adaptec Array1000 Family Array Management Guide
Stock Number: 511468-00, Rev. A Page: 3-2
Print Spec Number: 496645-00
Current Date: 3/2/99 ECN Date: 4/29/97



Configuring Arrays and Spares
Creating an Array
Follow these steps to create a new array on your NetWare server:

1 Select Disk Array Operations from the Main Menu.

2 When the Array Operations menu appears, select Create a 
New Array. The Select Drives to Create Array window 
appears, similar to Figure 3-2.

Note: An error message appears if no disks are avail-
able to create the array.

The window lists all the disks that are available to create the 
new array.

3 Highlight each disk you want to include as a member of the 
array (not as a spare) and press F5 to mark it. The disks can be 
on different SCSI channels of the same Adaptec Array1000 
Family product.

Caution: When a disk becomes an array member, any 
data that was on the disk is lost. Be sure to back up 
any data on the disk that you want to keep.

<  >Moves Cursor,<Enter> Selects Option,<ESC> Exits

Select new array members using

the <F5> key. Press ENTER 

when done.

Array Operations

Display Array Configuration
Create a New Array
Delete an Array

Blink Member Drives of an Array
Change Name of an Array
Make First Virtual Device

<F1> Help

Using <F5>, Select Drives to Create Array

Ch#A ID#0  SEAGATE ST32155W   0016   Cap:2049(MB) <Single Device>
Ch#A ID#1  SEAGATE ST32155W   0016   Cap:2049(MB) <Single Device>
Ch#A ID#2  SEAGATE ST32155W   0016   Cap:2049(MB) <Single Device>
Ch#A ID#3  SEAGATE ST32155W   0016   Cap:2049(MB) <Single Device>
Ch#A ID#4  SEAGATE ST32155W   0016   Cap:2049(MB) <Single Device>

Adaptec CI/O Array Management Software   NetWare Loadable Module

Figure 3-2. Select Drives to Create Array Window
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The following table shows the maximum and minimum num-
ber of array members and spares allowed for each type of 
array (see Appendix B, Understanding Arrays and RAID Technol-
ogy, for more information on RAID technology):

4 When all the disks needed for the array are highlighted, press 
Enter.

A warning message appears if you have selected a disk with a 
partition. If the partition is recognized by the operating sys-
tem, you cannot use the disk in the array. If the partition is not 
recognized by the operating system, you can use the disk in the 
array.

You are prevented from using disks with recognized partitions 
for the array so you will not, for example, accidentally erase 
the server’s boot disk or erase files currently being used by the 
server.

5 When the prompt appears, enter a name for the array. You can 
use up to 15 characters, including spaces and any other print-
able characters. The name is used to display the array and to 
identify the source of event notifications. Press Enter when you 
have typed the name.

RAID Level
Minimum 

Disks
Maximum 

Disks 1

1 This is the maximum number of disks supported by the software driver. The maximum for your 
computer system may be less, depending on how many SCSI channels and devices you have.

Dedicated 
Spares

Pool
Spares

RAID 0 (Striped) 12

2 The purpose of one-disk RAID 0 arrays is to give you more control over the virtual device order 
of disks controlled by the Adaptec Array1000 Family product. This is also useful for defining the 
system’s boot device.

16 None None

RAID 1 (Mirrored) 2 2 1 or 2 up to 8

RAID 0/1 (Mirrored & 
Striped)3

3 RAID 0/1 arrays must have an even number of disks.

4 16 1 or 2 up to 8

RAID 5 (Striped, with 
Distributed Parity)

3 16 1 or 2 up to 8
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Note: You can change the array name later, if neces-
sary. See Renaming an Array on page 5-7 for more 
information.

6 When the prompt appears, select a RAID level for the array. 
Then press Enter.

The available RAID levels depend on how many disks you 
chose for the array. For example, RAID 1 and RAID 0/1 are not 
available if you chose three disks, because they require an even 
number of disks. See Selecting a RAID Level for an Array on 
page 13-5 for information about the different RAID levels.

7 When the prompt appears, select a Stripe Size for the array. 
Then press Enter. (This menu does not appear if the array is 
mirrored and has only two disks.) The recommended stripe 
size of 64 KBytes usually provides the best overall perfor-
mance for most servers.

8 (Optional) When you are prompted, select dedicated spares for 
the array by highlighting one or two disks and pressing F5.

Note: We recommend that you use a spare pool 
instead of dedicated spares. See Using a Spare Pool on 
page 3-12 for more information.

You can add one or two dedicated spares to RAID 1, RAID 0/1, 
and RAID 5 arrays. Disks already selected as array members 
are marked with *Reserved*. An error message appears if you 
try to select one of these disks as a spare. The spare(s) you 
select should be at least as large as the smallest array member.

9 Press Enter when you are finished selecting spares. An event 
notification may appear at this point. Press Esc to remove this 
notification. Event notifications are recorded in the Event Log. 
For more information, see Viewing the Server Log on page 4-3.

10 When prompted, select Yes to initialize the array.

If you prefer to initialize the array later, select no at this 
prompt. If you choose not to initialize the array now, you 
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should initialize it later (see Initializing an Array on page 3-10). 
RAID 1, RAID 0/1 and RAID 5 arrays must be initialized 
before you can write data to them. RAID 0 arrays can be used 
without being initialized. However, we recommend that you 
initialize them anyway to verify the media surface.

11 Read the event notifications that indicate the array has been 
created successfully. Then press Esc to continue. (Skip to 
Step 13 if you chose not to initialize the array.)

If a red text window appears with the message Failed to Create 
Array, open the Server Log and see if there is a description of 
the error. Reboot the server, restart Adaptec CI/O Array Man-
agement Software, and rescan the system to assure that all 
devices are responding (see Rescanning the Server on page 4-8). 
Then try again to create the array.

12 A message appears indicating that the initialization process 
has started successfully. Press Esc to dismiss this message. If 
you wish, you can press Alt-Esc to view a graph showing the 
progress of the initialization process, as shown in Figure 3-3.

Detailed information about the array appears in a window 
above the graph. If you want to abort the initialization (not rec-
ommended), press F7 from the screen with the graph and 
select Yes.

You can perform other tasks in Adaptec CI/O Array Manage-
ment Software while the array is being initialized, as long as 
they do not interfere with the initialization process. For exam-
ple, you can view array information, but you cannot delete the 
array that is being initialized.

Percent Complete INITIALIZE on Array "Array1"

60%

Figure 3-3. Graph of Initialization Process
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13 If you want to create another array, return to Step 1 and repeat 
the process. When you have defined all the arrays and spares 
you want, exit from Adaptec CI/O Array Management Soft-
ware and reboot the server so NetWare can recognize the new 
array(s).

After you create an array you must reboot the server and partition 
the array as you would partition a stand-alone disk. If you want to 
make the array bootable, continue with the next section, Making an 
Array the First Virtual Device.

Making an Array the First Virtual Device
You can configure the server to boot from a stand-alone disk or from 
an array. If you want to boot from a stand-alone SCSI disk, we rec-
ommend that you assign SCSI ID 0 to this disk and that you connect 
it to Channel A of the Adaptec Array1000 Family product (if it has 
more than one channel). We recommend that you configure the 
server to boot from a fault-tolerant (RAID 1, RAID 0/1, or RAID 5) 
array to provide better data protection and better I/O performance 
than a single disk.

Note: You can also use the ArrayConfig program to select a 
boot array. See Making the Array Bootable on page 2-5.

You make an array bootable by assigning it virtual device order #0. 
The virtual device order is the sequence in which the server’s operat-
ing system detects arrays, single disks, and other devices connected 
to the Adaptec Array1000 Family product when the server boots. 
You may also need to move the Adaptec Array1000 Family product 
to a different PCI slot. For more information, see the Installation and 
Hardware Guide for your Adaptec Array1000 Family product.
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Follow these steps to make an array the first virtual device:

1 Select Disk Array Operations from the Main Menu.

2 Select Make First Virtual Device from the Array Operations 
menu. The Make First Virtual Device window appears, similar 
to Figure 3-4.

3 Highlight the array you want to select as the boot array, and 
press Enter.

4 When the message appears, select Yes to confirm that you 
want this array to be the boot array. An event notification 
appears.

5 Read the event notification and press Esc to continue. The noti-
fication should indicate that the array has been made bootable.

6 Exit Adaptec CI/O Array Management Software. If the 
selected array does not already have a bootable partition on it, 
reboot the server to a bootable floppy disk. Then install DOS 
and NetWare on the array and configure it as required so the 
server can boot from it. See the Installation and Hardware Guide 
for your Adaptec Array1000 Family product for more 
information, including information on installing NetWare from 
a CD.

<  >Moves Cursor,<Enter> Selects Option,<ESC> Exits

Set the virtual device order of an array 

to 0 so that it is recognized as the 

first device by the operating system.

Array Operations

Display Array Configuration
Create a New Array
Delete an Array

Reconstruct an Array
Pause/Resume I/O on an Array
Blink Member Drives of an Array
Change Name of an Array

Make First Virtual Device

<F1> Help

Make First Virtual Device (Select Array with <ENTER>)

Array1     Type: RAID 5  Logical ID:0 (0 = First Array)
Array2     Type: RAID 5  Logical ID:1 (0 = First Array)

Adaptec CI/O Array Management Software   NetWare Loadable Module

Figure 3-4. Make First Virtual Device Window
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Deleting an Array

Caution: Back up the data on an array before you delete it. 
All data on the array disks is lost when you delete the array.

When you delete an array, all the disks that were members of the 
array become single, stand-alone disks again. You can then use them 
as spares or as members of a new array. If you want to delete an 
array that has a NetWare volume, you must dismount the volume 
first.

Follow these steps to delete an array:

1 Select Disk Array Operations from the Main Menu.

2 When the Array Operations menu appears, select Delete an 
Array. The Delete Array window appears, similar to 
Figure 3-5.

3 Highlight the array you want to delete, and press Enter.

A warning message appears if the selected array has a parti-
tion. If the partition is recognized by the operating system, you 
cannot delete the array. You are prevented from deleting an 
array with recognized partitions so you will not accidentally 
erase the server’s boot array or lose important information. If 
you still want to delete the array, dismount the NetWare 

<  >Moves Cursor,<Enter> Selects Option,<ESC> Exits

Select the array to delete.
Array Operations

Display Array Configuration
Create a New Array
Delete an Array

Reconstruct an Array
Pause/Resume I/O on an Array
Blink Member Drives of an Array
Change Name of an Array
Make First Virtual Device

<F1> Help

Delete Array (Select Array with <ENTER>)

Array1     Type: RAID 5  Capacity: 4094(MB)  Status: Online
Array2     Type: RAID 5  Capacity: 4094(MB)  Status: Online

Adaptec CI/O Array Management Software   NetWare Loadable Module

Figure 3-5. Delete Array Window
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volume of the array, and delete its partition with NetWare 
tools. Then you can delete the array with Adaptec CI/O Array 
Management Software.

4 When the message appears, select Yes to confirm that you 
want to delete this array.

5 Read the event notifications that appear on the screen and 
press Esc to continue.

Note: After you delete an array you can immediately use the 
disks that formerly belonged to the array to create spares or 
a new array without rebooting the server. However, you 
must reboot the server before you can use the disks as single 
disks that are not members of an array. Deleting an array 
may change the boot order and the drive assignment.

Initializing an Array
When you create a new array you are automatically prompted to ini-
tialize it, as described on page 3-5. If you wish, you can skip that 
step and initialize the array later by following the instructions in this 
section. You can also reinitialize an array that has already been in 
use. For example, you may wish to delete data that was written to 
the array by a system test sequence.

You can also perform a low-level SCSI format on the array with 
ArrayConfig, as explained in Initializing an Array on page 2-7. 

Caution: Back up the data on an array before you reinitialize 
it. All data on the array disks is lost when you initialize the 
array.

Follow these steps to initialize an array to which data has previously 
been written or a new array that has been defined but not initialized:

1 Select Disk Array Operations from the Main Menu.
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2 When the Array Operations menu appears, select Initialize an 
Array. The Initialize an Array window appears, similar to 
Figure 3-6.

3 Highlight the array you want to initialize and press Enter.

A warning message appears if you have selected a disk with a 
partition. If the partition is recognized by the operating sys-
tem, you cannot initialize the array. If the partition is not recog-
nized by the operating system, you can initialize the array.

You are prevented from initializing an array with recognized 
partitions so you will not accidentally erase the server’s boot 
array.

4 Select Yes to confirm that you want to initialize the array.

5 A message appears indicating that the initialization process 
has started successfully. Press Esc to dismiss this message. If 
you wish, you can press Alt-Esc to view a graph showing the 
progress of the initialization process, as shown in Figure 3-3 on 
page 3-6.

You can perform other tasks in Adaptec CI/O Array Manage-
ment Software while the array is being initialized, as long as 
they do not interfere with the initialization process. For 
example, you can view information for another array, but you 
cannot delete the array that is being initialized.

<  >Moves Cursor,<Enter> Selects Option,<ESC> Exits

Initialize the data and 

parity of an array, filling 

it with zeroes.

Array Operations

Display Array Configuration
Create a New Array
Delete an Array

Reconstruct an Array
Pause/Resume I/O on an Array
Blink Member Drives of an Array
Change Name of an Array
Make First Virtual Device

<F1> Help

Initialize an Array (Select Array with <ENTER>)

Array1     Type: RAID 5  Capacity: 4094(MB)  Status: Online
Array2     Type: RAID 5  Capacity: 4094(MB)  Status: Online

Adaptec CI/O Array Management Software   NetWare Loadable Module

Figure 3-6. Initialize an Array Window
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6 Press Alt-Esc to return to the other screen. If you want to abort 
the initialization (not recommended), select Activity Sched-
uler from the Main Menu, and select Abort a Running Activ-
ity from the Activity Scheduler menu. Then highlight the 
Initialize activity on the list that appears and press Enter. An 
event notification appears to confirm the action.

7 When the initialization process is complete, exit Adaptec CI/O 
Array Management Software and reboot the server.

Creating and Deleting Spares
Spare disks (spares) are an important data protection feature of fault-
tolerant arrays. If a disk in an array fails while the server is running, 
a spare is activated immediately to take its place. The array software 
automatically reconstructs the data on the new disk, and array oper-
ation continues uninterrupted.

Note: When you install Adaptec CI/O Array Management 
Software it is automatically configured to test all spares on 
the server once a day to assure they are always available, if 
needed, to replace failed disks in arrays. We recommend 
that you leave this default setting so that all spares will be 
tested regularly.

Using a Spare Pool
We recommend that you create a spare pool instead of creating dedi-
cated spares. The spares in a spare pool can be used as needed by 
any array connected to the same Adaptec Array1000 Family product, 
provided that the spare is at least as large as the smallest disk in the 
array. You can create a spare pool before any arrays are defined.

A spare pool is preferable to dedicated spares assigned to each array. 
For example, if three arrays are connected to your Adaptec 
Array1000 Family product, you can create a spare pool of two disks 
to give adequate protection for all the arrays. If one of the spare pool 
disks is used to replace a bad disk, you can immediately add another 
spare to the pool to protect the three arrays. But if you used dedi-
cated spares, you would need at least three spares to protect the 
arrays.
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Note: You can add a disk of any size to the spare pool, even 
if the disk is too small to protect the existing arrays. For 
example, if you have created two arrays with 1 GByte disks, 
you can add a 500-MByte disk to the spare pool, even 
though this disk is too small to replace any failed array 
member. The spare pool feature is designed like this to give 
you additional flexibility. For example, you may be plan-
ning to create a third array later with 500-MByte disks.

Adding a Disk to the Spare Pool
Follow these steps to create a new spare pool or to add a disk to an 
existing spare pool:

1 Select Spare Pool Operations from the Main Menu.

2 Select Create a Pool Spare from the Spare Pool Operations 
menu. A screen similar to Figure 3-7 appears.

The window located in the center of the screen lists the single 
disks that are available for pool spares.

3 Highlight a disk on the list and press Enter.

A warning message appears if you have selected a disk with a 
partition. If the partition is recognized by the operating sys-
tem, you cannot use the disk as a spare. If the partition is not 

<  >Moves Cursor,<Enter> Selects Option,<ESC> Exits

Highlight the device to create

as a spare, then press Enter.
Spare Pool Operations

Display Spare Pool Devices
Create a Pool Spare

<F1> Help

Create a Pool Spare  (Select Device with <Enter>)

Ch#A ID#3  DISK SEAGATE ST32155W Cap:2049(MB) <Single Device>
Ch#A ID#4  DISK SEAGATE ST32155W Cap:2049(MB) <Single Device>

Adaptec CI/O Array Management Software   NetWare Loadable Module

Figure 3-7. Create a Pool Spare Window
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recognized by the operating system, you can use the disk as a 
spare.

You are prevented from using disks with recognized partitions 
as spares so you will not accidentally erase the server’s boot 
disk or delete important information.

4 Select Yes to confirm your choice.

5 Read the event notifications that appear on the screen and 
press Esc to dismiss them.

6 Repeat Steps 2-5, if necessary, to add more disks to the spare 
pool.

Deleting a Disk from the Spare Pool
Follow these steps to delete a disk from a spare pool. Once it is 
deleted, the disk is available to use as a member of another array or 
as a dedicated spare:

1 Select Spare Pool Operations from the Main Menu.

2 Select Delete a Pool Spare from the Spare Pool Operations 
menu. A screen similar to Figure 3-8 appears.

The window located in the center of the screen lists the disks in 
the spare pool.

3 Highlight a disk on the list and press Enter.

<  >Moves Cursor,<Enter> Selects Option,<ESC> Exits

Remove a device from the 

Spare Pool of an Adaptec 

Array controller.

Spare Pool Operations

Display Spare Pool Devices
Create a Pool Spare  
Delete a Pool Spare  
Test All Spares

<F1> Help

Spare Pool Information (Select Spare with <ENTER>)

Ctlr: #0  Ch: #0  SCSI ID:3  SEAGATE ST3215W   0172
Ctlr: #0  Ch: #0  SCSI ID:4  SEAGATE ST3215W   0172

Adaptec CI/O Array Management Software   NetWare Loadable Module

Figure 3-8. Delete a Pool Spare Window
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4 Select Yes to confirm your choice.

5 Read the event notifications that appear on the screen and 
press Esc to dismiss them.

6 Repeat Steps 2-5, if necessary, to delete other disks from the 
spare pool.

Viewing Spare Pool Information
Follow these steps to view information about the disks in a spare 
pool:

1 Select Spare Pool Operations from the Main Menu.

2 Select Display Spare Pool Drives from the Spare Pool Opera-
tions menu. A screen similar to Figure 3-9 appears.

The window located in the center of the screen lists the disks in 
the spare pool.

3 Press Enter to display detailed information about the selected 
spare pool device. Press Esc when you are finished.

<  >Moves Cursor,<Enter> Selects Option,<ESC> Exits

Display information about the 

drives in the Spare Pool

of each Adaptec Array 

controller.

Spare Pool Operations

Display Spare Pool Drives
Create a Pool Spare  
Delete a Pool Spare  
Test All Spares

<F1> Help

Spare Pool Information (Select Spare with <ENTER>)

Ctlr: #0  Ch: #0  SCSI ID:3  SEAGATE ST3215W   0172
Ctlr: #0  Ch: #0  SCSI ID:4  SEAGATE ST3215W   0172

Adaptec CI/O Array Management Software   NetWare Loadable Module

Figure 3-9. Spare Pool Information Screen
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Adding a Dedicated Spare
Follow these steps to add a dedicated spare to an existing RAID 1, 
RAID 0/1, or RAID 5 array. Each array can have a maximum of two 
dedicated spares.

1 Select Disk Array Operations from the Main Menu.

2 Select Create a Dedicated Spare from the Array Operations 
menu. A list of arrays appears.

3 Highlight the array to which you want to add a dedicated 
spare and press Enter. A list of available disks appears.

4 Highlight the disk you want to use as a spare and press Enter. 
Spares must have at least as much capacity as the smallest 
array member.

5 Select Yes to confirm that you want to add the dedicated spare.

A warning message appears if you have selected a disk with a 
partition. If the partition is recognized by the operating sys-
tem, you cannot use the disk as a spare. If the partition is not 
recognized by the operating system (for example, if the disk 
was previously partitioned under another operating system), 
you can use the disk as a spare.

You are prevented from using disks with recognized partitions 
as spares so you will not accidentally erase the server’s boot 
disk.

6 Read the event notifications that appear on the screen and 
press Esc to dismiss them.

7 Repeat this process, if necessary, to add a second dedicated 
spare to the array.
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Deleting a Dedicated Spare
Follow these steps to delete a dedicated spare from an existing 
RAID 1, RAID 0/1, or RAID 5 array.

1 Select Disk Array Operations from the Main Menu.

2 Select Delete a Dedicated Spare from the Array Operations 
menu. A list of arrays appears.

3 Highlight the array whose dedicated spare(s) you want to 
delete and press Enter. A list of array members and dedicated 
spares appears.

4 Highlight the dedicated spare you want to delete and press 
Enter.

5 Select Yes to confirm that you want to delete the dedicated 
spare.

6 Read the event notifications that appear on the screen and 
press Esc to dismiss them.

7 Repeat this process, if necessary, to delete another dedicated 
spare from the array.

❒
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4▼  ▼  ▼  ▼
Viewing Server, Array, and 
Device Information
Adaptec CI/O Array Management Software for the NetWare con-
sole allows you to view information about arrays, SCSI devices, and 
server events.

Viewing the Event Log
The Event Log is a list of recent event notifications generated by the 
Adaptec CI/O Array Management Software. The screen is refreshed 
every time a new event is received. Only ten lines of the most recent 
event notifications are displayed. (Some notifications take two 
lines.) There is no scrolling capability. Whenever you exit the pro-
gram and restart it the Event Log listings start over again.

If you want to view more complete information about server events, 
open the Server Log, as described in Viewing the Server Log on 
page 4-3.

Event notification messages also pop up on the screen when new 
events are added to the log. Press Esc to remove these popup 
messages.
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Follow these steps to view the Event Log:

1 Select Display Event Log from the Main Menu. The Event Log 
appears, similar to Figure 4-1.

2 View the Event Log entries.

The newest entries appear at the beginning of the list. Each 
entry has an ID number and the time and date at which the 
entry was generated. The Severity column indicates the severity 
level of the event, as follows:

– Critical event messages indicate problems that require the 
user’s immediate attention, such as an array with a down 
drive or an off-line array.

– Warning event messages indicate problems that are not 
serious enough to cause a failure but which may require 
the user’s attention. An example is a message indicating 
that the last spare has been used.

– Informational event messages are generated for routine 
events such as adding a new array, verifying an array, or 
changing an array name.

3 When you are done viewing the Event Log, press Esc to return 
to the Main Menu.

<ESC> Exits<F1> Help

Event Log

 ID

0019
0018
0017
0016

0015

0014
0013

Severity

INFO
INFO
INFO
INFO

INFO

INFO
INFO

 Date

4/22/96
4/22/96
4/22/96
4/22/96

4/22/96

4/22/96
4/22/96

 Time

12:59:04
12:53:21
12:51:33
12:50:40

12:10:40

11:59:19
11:48:20

             Description

Array AR1 is added to server.
Array name AR1 changed to AR2.
Array AR3 is added to server.
Dedicated spare [bus=1, ch=A, id=1] added 
to array AR3.
Dedicated spare [bus=1, ch=A, id=2] added 
to array AR3.
Array AR1 is deleted from server.
A verify has been started on array AR3.

Adaptec CI/O Array Management Software   NetWare Loadable Module

Figure 4-1. Event Log
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Viewing Server, Array, and Device Information
Viewing the Server Log
The Server Log file, which is maintained on the server, lists all 
events generated by the server since it was brought online. Some 
examples of events are the creation of a new array, the successful 
completion of an array initialization, and a failed disk in an array. 
When you open the Server Log you can scroll backwards to view all 
the entries in the log. You can also clear all the log entries, which you 
should do periodically to keep the log from getting too large.

Note: You can keep the Server Log file from getting too large 
by specifying a maximum size for it in the initialization file. 
For more information, see Appendix A, Configuration Set-
tings.

Follow these steps to view the Server Log:

1 Select Display Server Log from the Main Menu. The Server 
Log appears, similar to Figure 4-2.

2 View the log entries. The most recent entries are listed first. 
Each entry lists the time and date when it was generated and 
some descriptive text.

– To view more entries, press Ins and then press Pg Up or Pg 
Dn to scroll up or down in the log.

<F1> Help <  > Moves Cursor  <INS> Scroll Display  <DEL> Clear Log  <ESC> Exits

Server Log Display 

04/20/96
04/20/96

04/20/96

04/20/96
04/20/96
04/20/96

Press <ENTER> to view detailed data, <INS> to scroll 10 more 
entries, <DEL> to clear the log file, or <ESCAPE> to exit.

10:11:55
09:40:12

09:35:12

09:00:10
08:42:12
08:15:41

Array "AR1" is deleted from server.
Dedicated spare [bus=1, ch=A, id=1] added to 
array "AR3".
Dedicated spare [bus=1, ch=A, id=2] added to 
array "AR3".
Array "AR3" is added to server.
Array name "AR1" changed to "AR2".
Array "AR1" is added to server.

Adaptec CI/O Array Management Software   NetWare Loadable Module

Figure 4-2. Server Log
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– To view detailed information about any entry, highlight it 
and press Enter. (See the previous section for information 
about severity levels.) Press Esc to remove the window 
with the detailed information.

– To clear all log entries, press Del.

3 When you are done viewing the Server Log, press Esc to return 
to the Main Menu.

Viewing Array Information
Follow these steps to view information about arrays on the server:

1 Select Disk Array Operations from the Main Menu.

2 Select Display Array Configuration from the Array Opera-
tions menu. A screen similar to Figure 4-3 appears.

3 Select an array and press Enter. Read the array information 
listed in the window. This includes array name, RAID level, 
total data storage capacity, status, stripe size, etc.

Fault Tolerant is the status that indicates RAID 1, RAID 0/1, 
and RAID 5 arrays are operating correctly; for RAID 0 arrays it 
is Normal.

<  >Moves Cursor,<Enter> Selects Option,<ESC> Exits

Array Operations

Display Array Configuration
Create a New Array
Delete an Array

Reconstruct an Array
Pause/Resume I/O on an Array
Blink Member Drives of an Array
Change Name of an Array
Make First Virtual Device

<F1> Help

Array1    Type: RAID 5  Capacity: 4094(MB)  Status: Online
Array2    Type: RAID 5  Capacity: 4094(MB)  Status: Online

Array Information (Select Array with <ENTER>)

Adaptec CI/O Array Management Software   NetWare Loadable Module

Select array to display

member information.

Figure 4-3. Array Information
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Viewing Server, Array, and Device Information
A Critical status may indicate that an array disk has failed, or 
that a failed disk is being rebuilt. See Responding to a Critical 
Array on page 13-1 for more information.

An OffLine status indicates that the array was just created and 
you have not rebooted the server yet, or that the array is in 
danger of losing data, or that array data has already been lost. 
See Responding to an Off-line Array on page 13-3 for more 
information.

4 Press Enter again. The Array Members Information window 
appears.

5 Read the additional information, which includes the disk sta-
tus (OKAY is the normal status), and controller/channel/SCSI 
ID information.

6 To view detailed information on a single array member or 
spare, including manufacturer and storage capacity, highlight 
the entry and press Enter. An additional window of detailed 
information appears.

7 When you have finished viewing this information, press Esc 
until you return to the Main Menu.

Viewing Spare Information
■ To view information on dedicated spares, follow the instructions 

in the previous section, Viewing Array Information. When you 
get to Step 6, highlight the dedicated spare and press Enter.

■ To view information about spares in a spare pool, follow the 
directions in Viewing Spare Pool Information on page 3-15.
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Viewing Controller and Channel Information
Follow these steps to view information about Adaptec Array1000 
Family products and channels on the server:

1 Select Display Device Information from the Main Menu. A 
screen similar to Figure 4-4 appears.

2 Use the ↑ and ↓ keys to highlight the Adaptec Array1000 Fam-
ily product you want in the window on the left. Then read the 
information that appears in the window below it.

3 Press the → key to move to the Channels window, and high-
light the device you want (if there is more than one channel). 
Then read the channel information that appears in the window 
below it.

4 Press the → key to move to the Device Information window, 
and highlight the device you want. Then read the device infor-
mation that appears in the information window.

5 When you have finished viewing information, press Esc to 
return to the Main Menu.

<      > Moves Cursor and Get Information   <ESC> Exits<F1> Help

Device Information

Ctlr: #0  AAA-132
Board Version: 1.00
Cache Size:    4096(KB)  Channels: 2
Host Bus: PCI (bus #1)
Capabilities:  8  pool spares
               2 dedicated spares per Array
               Supports Write Through only

ChannelsControllers

ID#0 SEAGATE ST32155W !f
ID#1 SEAGATE ST32155W !f
ID#2 SEAGATE ST32155W !f
ID#3 SEAGATE ST32155W !f
ID#4 SEAGATE ST32155W !f
ID#5 SEAGATE ST32155W !f
ID#6 SEAGATE ST32155W !f

Channel A
Channel B

Ctlr #0:  AAA-132

Adaptec CI/O Array Management Software   NetWare Loadable Module

Figure 4-4. Controller and Channel Information
4-6

Adaptec Array1000 Family Array Management Guide
Stock Number: 511468-00, Rev. A Page: 4-6
Print Spec Number: 496645-00
Current Date: 3/2/99 ECN Date: 4/29/97



Viewing Server, Array, and Device Information
Viewing SCSI Device Information
In addition to viewing information about array members, you can 
also view information about individual SCSI devices installed in the 
server, including CD-ROM drives, scanners, and other non-disk 
devices. Some of these SCSI devices may be array members, but 
when you use this command you only see information about each 
individual device. There are two ways to do this:

■ Follow the instructions in Viewing Controller and Channel Infor-
mation on page 4-6. When you reach Step 4 you can view infor-
mation for all the SCSI devices on the channel.

■ Follow the numbered instructions below.

1 Select Device Operations from the Main Menu.

2 Select Display Device Information from the Select Device 
Operation menu. A screen similar to Figure 4-5 appears.

3 Read the device information in the window.

4 To view additional information, highlight a device in the win-
dow and press Enter.

5 Read the additional SCSI device information, then press Esc 
repeatedly until you return to the Main Menu.

<  >Moves Cursor,<Enter> Selects Option,<ESC> Exits

Select Device Operation

Display Device Information

<F1> Help

Ch#A ID#0  DISK  SEAGATE ST32155W !f Cap: 2049(MB) <Array Member>
Ch#A ID#1  DISK  SEAGATE ST32155W !f Cap: 2049(MB) <Array Member>
Ch#A ID#2  DISK  SEAGATE ST32155W !f Cap: 2049(MB) <Array Member>
Ch#A ID#3  DISK  SEAGATE ST32155W !f Cap: 2049(MB) <Array Member>
Ch#A ID#4  DISK  SEAGATE ST32155W !f Cap: 2049(MB) <Array Member>
Ch#A ID#5  DISK  SEAGATE ST32155W !f Cap: 2049(MB) <Array Member>
Ch#A ID#6  DISK  SEAGATE ST32155W !f Cap: 2049(MB) <Dedicated Spare>

Drive Information (Select Device with <ENTER>)

Adaptec CI/O Array Management Software   NetWare Loadable Module

Figure 4-5. Drive Information
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Rescanning the Server
Whenever you boot the server the operating system software scans 
the server to find all installed hardware devices such as Adaptec 
Array1000 Family products, arrays, and SCSI devices.

If you are using an array enclosure and you make a hardware 
change while the server is running—for example, adding a new 
disk—you must use the Rescan command to allow Adaptec CI/O 
Array Management Software to detect the new device. A rescan is 
done automatically if you pause I/O on a channel and then resume 
I/O. You can pause I/O to a channel, insert a new disk in a currently 
unoccupied slot and assign it a new SCSI ID. When you resume I/O 
a rescan is done automatically, and Adaptec CI/O Array Manage-
ment Software sees the disk as a single (stand-alone) disk. (The oper-
ating system does not detect the disk until you reboot the server, 
however.)

Follow these steps to rescan the system:

1 Select Rescan System from the Main Menu. 

2 Select Yes to confirm that you want to rescan the system. A 
message appears on the screen while the rescan is taking place.

3 Wait until the System rescan complete message appears.

4 Press Esc to clear the message.

❒
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5▼  ▼  ▼  ▼
Performing Array, Device, 
and Password Operations
Performing Array Operations

Reconstructing an Array
If a member of a fault-tolerant (RAID 1, RAID 0/1, RAID 5) array 
fails, the array status changes to Critical. If a spare disk is available, it 
is automatically activated, and the data on the failed disk is recre-
ated on the spare. If no spare is available, you may need to use the 
Reconstruct command to restore the array to fault-tolerant status.

Follow these steps to reconstruct an array with a failed disk and no 
available spare:

1 Determine which array is in Critical status and which disk in 
the array has failed. To do this, follow the instructions in View-
ing Array Information on page 4-4.

It is possible that a RAID 0/1 array in Critical status may have 
more than one failed disk. The array can still be reconstructed 
as long as at least one disk of each mirrored pair is still good.
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2 If the drive enclosure does not support hot swapping1, pause 
I/O to the array. (See Pausing I/O on an Array on page 5-3.) This 
is not necessary if the array enclosure supports hot swapping.

3 Replace the failed disk (or disks) with a good disk of at least 
the same storage capacity. Be sure that the SCSI ID of the new 
disk is different from the SCSI ID of other installed devices. Or, 
if an array disk was accidentally disconnected, reconnect it.

4 Wait for I/O to resume after the pause period, if you paused it 
in Step 2.

5 If you installed a new disk (or disks), make the disk into a 
spare by following the directions in Creating and Deleting Spares 
on page 3-12.

6 Select Disk Array Operations from the Main Menu.

7 Select Reconstruct an Array from the Array Operations menu. 
The Reconstruct Array window appears.

8 Highlight the Critical array and press Enter. A list of array 
members appears, similar to the one shown in Figure 5-1.

1 Hot swapping support means that the array enclosure electrically isolates the 
bad disk’s SCSI connector from the SCSI bus while the disk is being 
swapped to prevent data corruption. Data can still be transferred to and 
from the remaining good disks while the bad disk is replaced. Check with 
the manufacturer of the array enclosure if you are not sure whether it sup-
ports hot swapping.

<  >Moves Cursor,<Enter> Selects Option,<ESC> Exits

Array Operations

Display Array Configuration
Create a New Array
Delete an Array

Change Name of an Array 
Make First Virtual Device

<F1> Help

<Array Member>   Status:AVAILABLE   Ctlr#0   Ch#A   ID#0
<Array Member>   Status:AVAILABLE   Ctlr#0   Ch#A   ID#1
<Array Member>   Status:DOWN        Ctlr#0   Ch#A   ID#2
<Array Member>   Status:AVAILABLE   Ctlr#0   Ch#A   ID#3
<Array Member>   Status:AVAILABLE   Ctlr#0   Ch#A   ID#4

Reconstruct Array

Reconstruct a fault tolerant
array which is in a critical
state.

Adaptec CI/O Array Management Software   NetWare Loadable Module

Figure 5-1. Reconstruct Array Window
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Performing Array, Device, and Password Operations
9 Highlight the array member whose status is Down and press 
Enter. (In this example, the disk at ID#2 is down; you should 
have already replaced the bad disk with a good disk or recon-
nected the disconnected disk.)

10 Select Yes to confirm that you want to reconstruct the array.

11 A message appears indicating that the reconstruct process has 
been started successfully. Press Esc to remove this message. If 
you wish, you can press Alt-Esc to view a graph showing the 
progress of the reconstruct. A window with detailed array 
information appears above the graph.

You can perform other tasks in Adaptec CI/O Array Manage-
ment Software while the array is being reconstructed, as long 
as they do not interfere with the reconstruct process. For exam-
ple, you can view information for another array, but you can-
not delete the array that is being reconstructed.

12 Press Alt-Esc to return to the other screen. Press Esc to remove 
the event notification that appears when the reconstruct is 
finished.

13 View the Event Log to verify that the reconstruction completed 
successfully. (See Viewing the Event Log on page 4-1.)

If you wish, you can schedule the reconstruct to occur at a later time 
when there will be less I/O activity on the server. See Scheduling a 
New Activity on page 6-2 for more information.

Pausing I/O on an Array
Use this option to pause data I/O on an array while you replace a 
disk or reconnect a loose connection in an enclosure that does not 
support hot swapping2. You may need to do this when you are 
restoring a Critical array to Fault-tolerant status. (See Responding to a 
Critical Array on page 13-1 for more information.) When you pause 
an array, all devices connected to the Adaptec Array1000 Family 

2 Hot swapping support means that the array enclosure electrically isolates the 
bad disk’s SCSI connector from the SCSI bus while the disk is being 
swapped to prevent data corruption. Data can still be transferred to and 
from the remaining good disks while the bad disk is replaced. Check with 
the manufacturer of the array enclosure if you are not sure whether it sup-
ports hot swapping.
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product are electrically paused. I/O resumes automatically after a 
specified pause interval.

Note: The Pause I/O command is disabled if a Verify, Recon-
struct, or Initialize operation is running.

Follow these steps to pause I/O on an array:

1 Select Disk Array Operations from the Main Menu.

2 Select Pause/Resume I/O on an Array from the Array Opera-
tions menu. The Pause Array window appears with a list of 
arrays.

3 Highlight the array you want to pause and press Enter.

4 Read the message and enter a pause period that does not 
exceed the maximum pause period.

Note: The minimum pause period is 5 seconds; the 
maximum pause period is 120 seconds.

5 Press Enter to pause I/O, and then wait a few seconds for all 
data I/O to stop.

6 Do whatever you need to do to the array disks, such as recon-
necting a cable or replacing a disk. Be sure you complete your 
work before the end of the pause period.

A rescan is done automatically when I/O is resumed.

You can also pause data I/O to a single disk. See Pausing I/O to a 
Drive on page 5-12.

Verifying the Integrity of an Array
Use this option to verify the integrity of redundant data stored on 
fault-tolerant (RAID 0/1, RAID 1, RAID 5) arrays. When you run 
this operation, Adaptec CI/O Array Management Software checks 
the array for miscompares and corrects parity errors automatically. 
A miscompare occurs when the parity information on a RAID 5 array 
does not match the user data or when some part of the data on a 
mirrored disk pair in a RAID 0/1 or RAID 1 array does not match.
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In Adaptec CI/O Array Management Software you can schedule the 
Verify operation to run later or schedule it to run at a regularly 
occurring interval. We recommend that you schedule a verification 
of all arrays at least once a week. See Scheduling a New Activity on 
page 6-2 for more information.

Follow these steps to verify the integrity of array data:

1 Select Disk Array Operations from the Main Menu.

2 Select Verify Integrity of an Array from the Array Operations 
menu. The Verify Array window appears with a list of fault-
tolerant arrays.

3 Select the array you want to verify.

4 Select Yes to allow the program to automatically fix data mis-
compares, if any are detected. The verification process begins 
immediately.

5 A message appears indicating that the verification has started 
successfully. Press Esc to remove this message. If you wish, 
you can press Alt-Esc to view a graph showing the progress of 
the verification process. A window with detailed array infor-
mation appears above the graph.

You can perform other tasks in Adaptec CI/O Array Manage-
ment Software while an array is being verified, as long as the 
tasks do not interfere with the verification process. For exam-
ple, you can view information for another array, but you can-
not delete the array that is being verified. To abort the array 
verification, press F7 and select Yes (this is not recommended).

6 Press Alt-Esc to return to the other screen and wait for the ver-
ification process to finish.

Blinking Member Drive Lights of an Array
If you are not sure which physical disks are members of an array, 
you can identify them by blinking their drive lights. This works best 
when no data I/O is occurring. (The lights will already be blinking if 
data is being written to or read from the array.)

Follow these steps to blink the drive lights of all disks in an array:

1 Select Disk Array Operations from the Main Menu.
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2 Select Blink Member Drives of an Array from the Array Oper-
ations menu. A screen similar to Figure 5-2 appears.

3 Highlight the array whose lights you want to blink and press 
Enter. 

4 Select Yes to confirm that you want to blink the array lights. A 
message appears to indicate that the disk lights are blinking.

5 Observe which disk lights are blinking. If the light on a drive 
that you know is an array member is not blinking, the drive 
may be disconnected or non-operational.

6 Press Esc to remove the message and stop the lights from 
blinking.

You can also blink the light of a single disk. See Blinking a Device on 
page 5-13.

<  >Moves Cursor,<Enter> Selects Option,<ESC> Exits

Blink all array member drive

LEDs to visually identify

them.

Array Operations

Display Array Configuration
Create a New Array
Delete an Array

Reconstruct an Array
Pause/Resume I/O on an Array
Blink Member Drives of an Array
Change Name of an Array
Make First Virtual Device

<F1> Help

Blink Member Drives of an Array

Array1     Type: RAID 5  Capacity: 8197(MB)  Status: Online
Array2     Type: RAID 5  Capacity: 8197(MB)  Status: Online

Adaptec CI/O Array Management Software   NetWare Loadable Module

Figure 5-2. Blink Member Drives of an Array Window
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Reactivating an Off-line Array
An array may go off-line because a cable is disconnected or because 
you mistakenly remove the wrong disk when you are replacing a 
failed disk. Or you may deliberately take the disk off-line. In these 
situations, the array shuts down temporarily and the integrity of the 
data on the array is not affected. To determine the status of an array, 
follow the directions in Viewing Array Information on page 4-4.

Follow these steps to reactivate an off-line array:

1 Select Disk Array Operations from the Main Menu.

2 Select Reactivate Offline Array from the Array Operations 
menu. The Reactivate Array window appears, with all arrays 
listed.

3 Highlight the off-line array on the list and press Enter.

4 Select Yes to confirm that you want to reactivate the array. A 
confirmation message appears, and the array goes online.

5 Read the message and press Esc to dismiss it.

Renaming an Array
You assign a name to an array when you create it. Follow these steps 
to change the name of the array at a later time:

1 Select Disk Array Operations from the Main Menu.

2 Select Change Name of an Array from the Array Operations 
menu. A list of arrays appears.

3 Select the array you want to rename from this list and press 
Enter.

4 Erase the current name with the Backspace key and type a new 
name for the array. You can use up to 15 characters, including 
spaces and any other printable characters.

5 Press Enter.

6 Read the event notifications that appear and press Esc to 
remove them.
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Forcing the Use of a Spare
You can force a spare to replace a specified disk in an array. A typical 
use of this operation is replacing a disk in an array when you receive 
a S.M.A.R.T.3 alert for the disk. Some types of disk drives generate 
an alert when the drive is giving indications that it may fail soon. 
What actually happens when you force a spare is that the disk you 
select is downed and the spare automatically takes its place. The 
array does not go off-line when you do this, and you do not need to 
reboot the server.

Follow these steps to force a spare:

1 Be sure that one or more spares are available for the array. 
These can be either dedicated spares or pool spares.

2 Select Disk Array Operations from the Main Menu.

3 Select Force the Use of a Spare from the Array Operations 
menu. A list of arrays appears in a window.

3 S.M.A.R.T. stands for Self-Monitoring, Analysis and Reporting Technology. 
Hard disk drives that support this technology continually analyze their 
level of reliability and generate an alert if they determine that the disk is 
likely to fail soon. Adaptec CI/O Array Management Software generates an 
event notification if it receives a S.M.A.R.T. alert, allowing you to replace 
the disk before it actually fails.
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4 Select an array and press Enter. A list of array members 
appears, similar to the one shown in Figure 5-3. An error mes-
sage appears if no available spares are detected.

5 Select the array member for which you want to force the use of 
a spare and press Enter.

6 Select Yes to confirm your choice.

7 Read the messages indicating that the disk has been downed 
and that a spare is being activated to replace it. Press Esc to dis-
miss the messages.

The spare is automatically activated to take the place of the 
disk that you indicated. The array does not go off-line while 
this process occurs, and you do not need to reboot the server.

Note: If both dedicated spares and pool spares are available, 
the dedicated spares are used first. If there are pool spares, 
you cannot control which disk from the pool will be 
activated.

<  >Moves Cursor,<Enter> Selects Option,<ESC> Exits

Select the device to down in

order to force a spare.

<F1> Help

Array Operations

Display Array Configuration
Create a New Array
Delete an Array

Reconstruct an Array
Pause/Resume I/O on an Array
Blink Member Drives of an Array
Change Name of an Array
Make First Virtual Device

Force a Spare

Ch#A ID#0  DISK SEAGATE ST32155W Cap:2049(MB) <Single Member>
Ch#A ID#1  DISK SEAGATE ST32155W Cap:2049(MB) <Single Member>
Ch#A ID#2  DISK SEAGATE ST32155W Cap:2049(MB) <Single Member>
Ch#A ID#3  DISK SEAGATE ST32155W Cap:2049(MB) <Single Member>

Adaptec CI/O Array Management Software   NetWare Loadable Module

Figure 5-3. Force a Spare Window
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Testing All Spares
Use this option to verify the integrity of all spares in the server. You 
can perform this operation immediately or schedule it to run later. 
(See Scheduling a New Activity on page 6-2 for more information.)

Note: When you install Adaptec CI/O Array Management 
Software it automatically sets up a daily Test All Spares 
operation on the server. We recommend that you leave this 
default setting unchanged so that all spares are tested 
regularly.

Follow these steps to test all spares on the server immediately:

1 Select Spare Pool Operations from the Main Menu.

2 Select Test all Spares from the Spare Pool Operations menu. A 
message appears indicating that the spares are being tested.

3 Press Esc to dismiss the message. Testing all spares takes very 
little time.

4 Read the popup message that appears when the test is com-
pleted. (The message is also recorded in the Server Log and the 
Event Log.)

If the message text indicates that any spares failed the test, look 
in the Server Log. An entry will list the PCI bus number, chan-
nel number, and SCSI ID of the failed spare.

5 If there are any failed spares, replace the disks with good disks 
of at least the same capacity and create new spares from them.
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Performing Device Operations

Downing a Device
Use this option to stop all data I/O to a member of an array. You 
might need to do this if the disk generates a S.M.A.R.T.4 alert indi-
cating that it may fail soon. When you down an array member, a 
spare is activated immediately (if available) to replace it.

Caution: Do not down a disk if data is being written to the 
array. Also, do not down a disk on an array in Critical status. 
If you do, and if data is being written to the array at the 
time, the array will go off-line automatically, and data could 
be lost.

Follow these steps to down a device:

1 Select Device Operations from the Main Menu.

2 Select Down a Drive from the Device Operations menu. A list 
of drives appears.

3 Highlight a drive on the list and press Enter.

4 Select Yes to confirm that you want to down the drive.

5 Read the event notification message that appears and press Esc 
to dismiss it.

A spare is activated at this point, if one is available, to replace the 
downed drive, and the new array member is reconstructed. A mes-
sage appears when the operation is completed.

4 S.M.A.R.T. stands for Self-Monitoring, Analysis and Reporting Technology. 
Hard disk drives that support this technology continually analyze their per-
formance and generate an alert if they determine that the disk is likely to fail 
soon. Adaptec CI/O Array Management Software generates an event noti-
fication if it receives this alert, allowing you to replace the disk before it 
actually fails.
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Pausing I/O to a Drive
Use this option to pause all data I/O on a disk drive. You might 
need to do this if you want to replace the disk and the array enclo-
sure does not support hot swapping5. When you pause a drive, all 
other drives connected to the Adaptec Array1000 Family product 
are paused as well. I/O resumes automatically after a specified 
pause interval.

Follow these steps to pause I/O to a drive:

1 Select Device Operations from the Main Menu.

2 Select Pause/Resume I/O on Drive from the Device Opera-
tions menu. The Pause Device window appears with a list of 
drives.

3 Highlight the drive you want and press Enter.

4 Read the message and enter a pause period that does not 
exceed the maximum pause period.

Note: The minimum pause period is 5 seconds; the 
maximum pause period is 120 seconds.

5 Press Enter to pause I/O.

6 Do whatever you need to do to the disk, such as reconnecting a 
cable or replacing a disk. Be sure you complete your work 
before the end of the pause period.

A rescan is done automatically when I/O is resumed.

You can also pause data I/O to an array. See Pausing I/O on an Array 
on page 5-3.

5 Hot swapping support means that the array enclosure electrically isolates the 
bad disk’s SCSI connector from the SCSI bus while the disk is being 
swapped to prevent data corruption. Data can still be transferred to and 
from the remaining good disks while the bad drive is replaced. Check with 
the manufacturer of the array enclosure if you are not sure whether it sup-
ports hot swapping.
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Blinking a Device
If you are not sure which physical disk corresponds to a particular 
SCSI ID, you can identify it by blinking its drive light. This works 
best when no data I/O is occurring, since the light will already be 
blinking if data is being written to or read from the disk.

Follow these steps to blink the drive light of a disk device:

1 Select Device Operations from the Main Menu.

2 Select Blink a Device from the Device Operations menu. A 
screen similar to Figure 5-2 appears.

3 Highlight the disk whose light you want to blink and press 
Enter.

4 Select Yes to confirm that you want to blink the device’s light. 
A confirmation message appears.

5 Observe which light is blinking in the RAID enclosure.

6 Press Esc to remove the message and stop the light from 
blinking.

You can also blink the lights of all disks in an array. See Blinking 
Member Drive Lights of an Array on page 5-5.

Setting the Remote Access Password
No password is required to run Adaptec CI/O Array Management 
Software from a NetWare server console. However, users who run 
the networked client version of the program must enter a password 
before they make any changes to array configuration. The network 
administrator controls the password.

The NetWare version of Adaptec CI/O Array Management Software 
allows the network administrator to set the server’s remote access 
password initially from the server console and to change the pass-
word at any time. See Chapter 12, Setting Security Options, for more 
information about setting and using the password.
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Caution: When you install Adaptec CI/O Array Manage-
ment Software on a server, you must initially set the pass-
word from the server. Remote users cannot access server 
information until the password is set.

Follow these steps to set the server’s remote access password:

1 Select Set Remote Access Password from the Main Menu. The 
screen shown in Figure 5-4 appears.

2 Type the new password, using any combination of upper- or 
lower-case letters and the numerals 0-9. Then press Enter. 
Passwords are case-sensitive and can be up to 16 characters 
long.

3 When you are prompted, type the new password again and 
press Enter. A message appears notifying you that the pass-
word has been changed.

4 Press Esc to remove the message from the screen.

Users must now enter the new password to monitor the server from 
a networked client on which Adaptec CI/O Array Management 
Software is running.

❒

<  >Moves Cursor,<Enter> Selects Option,<ESC> Exits<F1> Help

Specify the new remote access password

>

Enter a maximum of 16 upper/lower case letters or
numbers 0-9. (The password will not be echoed as it is entered.)

Adaptec CI/O Array Management Software   NetWare Loadable Module

Figure 5-4. Remote Access Password Screen
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6▼  ▼  ▼  ▼
Scheduling and Monitoring 
Array Activities
Adaptec CI/O Array Management Software allows you to schedule 
the following kinds of array activities to run at a later time or to run 
at a regularly occurring interval:

■ Verify Array

■ Reconstruct Array

■ Test All Spares

The advantage of scheduling these activities instead of running 
them immediately is that they can be done at a time when few users 
are logged on to the server and when slower data I/O performance 
will not be a problem. Also, the system administrator does not need 
to be present to run the activities.

We recommend that you schedule a verify of all arrays at least once 
a week and that you test all spares daily. Reconstructing an array is 
done whenever an array enters a Critical status. Reconstruction can 
be done immediately, or it can be scheduled for a later time when 
fewer users would be affected by the increased I/O activity.
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Scheduling a New Activity
Follow these steps to schedule a new activity:

1 Select Activity Scheduler from the Main Menu.

2 Select Schedule a New Activity from the Activity Scheduler 
menu. A screen similar to Figure 6-1 appears.

3 Select an activity from the list. A list of arrays appears.

4 Select an array from the list.

a If you selected Verify Array, select Yes or No for the Auto 
fix in case of error option. Then continue with Step 5.

b If you selected Reconstruct Array, select the array member 
to reconstruct. Then continue with Step 5.

c If you selected Test All Spares, continue with Step 5.

5 If you are running a Verify or Reconstruct activity, select Low, 
Medium, or High priority for the activity. (You can change the 
priority later if you wish. See Changing an Activity’s Priority on 
page 6-6 for more information.)

<  >Moves Cursor,<Enter> Selects Option,<ESC> Exits

Activity Scheduler

Display Activity Queue
Schedule a New Activity
Delete a Scheduled Activity
Abort a Running Activity
Change Priority of an Activity
Watch Activity Progress

<F1> Help

Select Activity to Schedule

Schedule a new Activity:
Verify, Reconstruct, or Test
All Spares.

VERIFY ARRAY
RECONSTRUCT ARRAY
TEST ALL SPARES

Adaptec CI/O Array Management Software   NetWare Loadable Module

Figure 6-1. Select Activity to Schedule Window
6-2

Adaptec Array1000 Family Array Management Guide
Stock Number: 511468-00, Rev. A Page: 6-2
Print Spec Number: 496645-00
Current Date: 3/2/99 ECN Date: 4/29/97



Scheduling and Monitoring Array Activities
6 Select one of the following Activity Schedule Modes (enter the 
options, if any, and press Enter):

– Run Activity Immediately

– Run Activity Once: Select this option to run the activity 
once at a later time. Then select a day of the week, hour, 
and minute. Note that a 24-hour clock is used to enter the 
hour and minute.

– Run Activity Daily: Select a start time for the daily activity.

– Run Activity Weekly: Select a day, hour, and minute for 
the weekly activity.

– Custom Schedule to Run Periodically: Select an hourly 
interval for the activity to run (for example, every 10 
hours). Specify a date for the activity to start. Specify the 
hour and minute of the first start time for the activity.

A confirmation message appears on the screen.

7 Press Esc to remove the message. The newly-scheduled activ-
ity is now an entry in the activity queue.
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Viewing the Activity Queue
Follow these steps to view the current activity queue:

1 Select Activity Scheduler from the Main Menu.

2 Select Display Activity Queue from the Activity Scheduler 
menu. A screen similar to Figure 6-2 appears.

3 View the information in the Scheduled Activity Information 
window. The activity status can be Running, Complete, Ready, 
or In Wait Queue.

Activities that are currently running always appear in the 
Scheduled Activity Information window, whether they are 
scheduled or not. For example, if you issue a command to ver-
ify an array immediately, the Verify activity appears in the 
window while it is running.

4 Press Esc to continue.

<  >Moves Cursor,<Enter> Selects Option,<ESC> Exits

Activity Scheduler

Display Activity Queue
Schedule a New Activity
Delete a Scheduled Activity
Abort a Running Activity
Change Priority of an Activity
Watch Activity Progress

<F1> Help

Activity:     Array:     Status:        Mode:     Priority:  

Display information about 
all running or scheduled 
Activities.

TEST SPARES               IN WAIT QUEUE  DAILY    LOW
VERIFY         Array2     IN WAIT QUEUE  DAILY    MEDIUM

Adaptec CI/O Array Management Software   NetWare Loadable Module

Figure 6-2. Scheduled Activity Information Window
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Deleting a Scheduled Activity
Follow these steps to completely remove a scheduled activity from 
the activity queue. Use this command only if the activity is not cur-
rently running. If it is running, first abort it and then delete it:

1 Select Activity Scheduler from the Main Menu.

2 Select Delete a Scheduled Activity from the Activity Sched-
uler menu. A screen similar to Figure 6-2 appears.

3 Highlight an activity on the queue and press Enter.

4 Select Yes to confirm the immediate deletion of the activity.

5 Press Esc to dismiss the confirmation message.

Aborting a Running Activity
Follow these steps to abort a running activity. If the activity has been 
scheduled to run at a regular interval, such as once a day, it will con-
tinue to run in the future at the scheduled interval. (If you want to 
completely delete the activity, follow the instructions in Deleting a 
Scheduled Activity above.)

1 Select Activity Scheduler from the Main Menu.

2 Select Abort a Running Activity from the Activity Scheduler 
menu. A list of running activities appears.

3 Highlight an activity on the list and press Enter to abort it.

4 Select Yes to confirm that you want to abort the activity. An 
event notification appears.

5 Read the event notification and press Esc to dismiss it.
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Changing an Activity’s Priority
You can change the priority of Verify and Reconstruct activities 
while they are running.

1 Select Activity Scheduler from the Main Menu.

2 Select Change Priority of an Activity from the Activity Sched-
uler menu. A list of running activities appears.

3 Highlight a Verify or Reconstruct activity and press Enter. The 
Select Activity Priority window appears.

4 Highlight the priority level you want—Low, Medium, or 
High—and press Enter.

5 Read the confirmation message and press Esc to delete it.
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Monitoring the Progress of an Activity
Follow these steps to open a window that displays the progress of a 
scheduled activity that is running:

1 Select Activity Scheduler from the Main Menu.

2 Select Watch Activity Progress from the Activity Scheduler 
menu. A list of running activities appears in the Watch Activity 
Progress window.

3 Highlight an activity in the Watch Activity Progress window 
and press Enter. A Running Activity Progress window 
appears, as shown in Figure 6-3.

The Running Activity Progress window shows the percentage 
of completion of the running activity and disappears when the 
activity is completed. You can also press Alt-Esc to toggle to 
another screen with a dynamically updated graph of the run-
ning activity.

4 Wait until the window disappears, or press Esc to remove it 
and continue.

❒

<  >Moves Cursor,<Enter> Selects Option,<ESC> Exits

Activity Scheduler

Display Activity Queue
Schedule a New Activity
Delete a Scheduled Activity
Abort a Running Activity
Change Priority of an Activity
Watch Activity Progress

<F1> Help

Watch Activity Progress (Select Activity with <ENTER>)

Display the completion
percentage of a running
activity.

VERIFY

Running Activity Progress

Activity Progress = 52 percent complete

Adaptec CI/O Array Management Software   NetWare Loadable Module

Figure 6-3. Running Activity Progress Window
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Using Adaptec CI/O Array Management
Software for Windows
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7▼  ▼  ▼  ▼
Entering and Viewing 
Client and Server 
Information
Adaptec CI/O Array Management Software allows you to view 
information about Array1000 Family storage device events that 
occur on a single server (if you are running it on a server console), or 
on multiple servers (if you are running it on a networked Windows-
based client). The software also lets you view information about the 
configuration of Array1000 Family arrays and other storage devices 
on the server (or servers). This chapter explains how to view this 
information from Windows-based clients and servers.

Entering and Viewing Server Information

Adding a New Server Address

Note: You only use this procedure when you are running 
Adaptec CI/O Array Management Software from a net-
worked client. 

You must enter information about each server you want to monitor 
from a networked client with Adaptec CI/O Array Management 
Software. Once this information is recorded in a configuration file, 
Adaptec CI/O Array Management Software automatically finds the 
server(s) when you run the program from this networked client.
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Follow these steps to add a new server address to Adaptec CI/O 
Array Management Software running on a networked client:

1 Start the program by double-clicking the  icon in the 
Adaptec CI/O Array Management Software group.

2 Click the  button. The New Server dialog box appears, 
as shown in Figure 7-1.

3 Select the IP or IPX radio button to indicate which kind of 
access is the default.

4 Enter the server’s name or IP/IPX address, which can be up to 
32 characters. This name will appear beneath the server icon in 
the Server View window.

– Servers running under NetWare usually use IPX protocol. 
Select the IPX button and type the name of the server. To 
view the server name, open Windows File Manager and 
select Network Connections from the Disk menu. Then 
view the scrollable list of Data drives. If you get an error 

Figure 7-1. New Server Dialog Box
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Entering and Viewing Client and Server Information
message when you click OK in the New Server dialog box, 
verify the server name and the use of IPX with the System 
Administrator.

If you need to enter an IPX address, the format is 
xxxxxxxx.xx-xx-xx-xx-xx-xx, where the first eight x’s are hex 
digits that define the network number, and the six pairs of 
hex digits are the host address or MAC address.

– Servers running under Windows NT usually use IP proto-
col. For Windows NT you can always enter the server 
address, if you know it. Otherwise, enter the server name. 
This could be something like mainserver or mainserver.uni-
system.com. Be sure that your networked client is set up 
with either a hosts file or with the name of a domain 
resolver. Ask the System Administrator if you are not sure.

The format of a TCP/IP address is nnn.nnn.nnn.nnn, where 
each group of three decimal digits is a number between 0 
and 255 (for example, 123.23.45.145).

5 Enter a description of the server—for example, Application 
Server or Video Server. This description appears when you 
double-click the server icon in the Server View window.

6 Click OK to add the new server information. You will see one 
of the following error messages if the server name/address is 
not correct:

– RPC transport error. This means that you entered a server 
address with correct IP or IPX syntax, but there is no server 
with this address. Check your typing for errors and try 
again.

– Transport not present. This means that you entered an IP 
address when an IPX address was required, or vice-versa.

– Duplicate server exists. This means that you are trying to 
enter a server name or address that has already been added 
for this networked client.
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Viewing and Editing Server Information
Follow these steps if you need to enter or change a server’s network 
address information:

1 Click the  button on the toolbar. The Server View win-
dow appears. Each server is represented by an icon in the top 
part of the window. The appearance of the icon indicates the 
server status, as shown here:

Server is online and available

Server is unavailable, perhaps due to a network failure. 
The networked client will automatically attempt to re-
attach to the server every 10 minutes. Double-click the 
server icon at any time to attempt a re-attach.

Server has generated a critical event message.

Server has generated an informational event message

Guest access to server is disabled. To access server infor-
mation, double-click the icon and enter the server pass-
word when prompted.

Server has generated a warning event message, such as 
a message that an array has gone to Critical status
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Entering and Viewing Client and Server Information
2 Double-click a server icon in the Server View window. The 
Server Information dialog box appears, similar to Figure 7-2.

3 View the server name, IP address, or IPX address.

4 View or edit the server description. The description is for your 
information only and appears only in this dialog box.

5 Click OK to exit the Server Information dialog box and to reg-
ister any updated server information.

Figure 7-2. Server Information Dialog Box
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Deleting a Server Address

Note: This procedure applies only to the networked client 
version of Adaptec CI/O Array Management Software. 

When you delete a server address, the icon for the server no longer 
appears in the Server View window and you can no longer view 
information for that server or manage it with Adaptec CI/O Array 
Management Software from the networked client.

Follow these steps to delete a server address:

1 Select Server View from the File menu.

2 Click the icon  of the server you want to delete.

3 Select Server Delete from the File menu. A prompt appears 
asking you to confirm the deletion of the currently selected 
server address.

4 Click Delete to delete the server address.

Viewing a List of Current Server Events
When you run Adaptec CI/O Array Management Software on a net-
worked client, you can use the Server View window to monitor 
events on all servers to which you are connected. Event notifications 
appear at the top of the list as they are received, starting from the 
time when you connect to the network. When you run Adaptec 
CI/O Array Management Software from a server console, you can 
monitor events occurring on that server only. A color-coded circle at 
the beginning of each message gives you a quick indicator of its 
severity.

If you minimize Adaptec CI/O Array Management Software, the 
icon flashes whenever a new event notification is received.
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Entering and Viewing Client and Server Information
Follow these steps to view a list of current server events in the 
Server View window:

1 Select Server View from the File menu. The Server View win-
dow appears. The Global Current Event Log at the bottom of 
this window lists server events, as shown in Figure 7-3.

2 View the event information for one or all servers. New entries 
appear on the list as the server events occur, and a date and 
time is listed for each event. See Interpreting and Responding to 
Server Event Messages on page 7-13 for more information on 
how to respond to these messages.

Figure 7-3. Listing of Server Events
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3 To view detailed information about an event, double-click the 
list entry. The Log Detail dialog box appears, as shown in 
Figure 7-4.

The information displayed in the Log Detail dialog box is simi-
lar to what appears in the one-line log entry, but the format is 
more readable.

4 Click OK when you are finished viewing the Log Detail dialog 
box. When you do this, you notify Adaptec CI/O Array Man-
agement Software that you have read the event notification.

– To acknowledge all new event notifications from all servers 
without reading each one individually, click the OK to All 
button at the bottom of the Server View window. This will 
stop the Adaptec CI/O Array Management Software icon 
from flashing when the application is minimized.

– To acknowledge all new event notifications from the cur-
rently selected server without reading each one individually, 
click the OK to Server button at the bottom of the Server 
View window.

Figure 7-4. Log Detail Dialog Box
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Entering and Viewing Client and Server Information
5 Click Filter in the Server View window to filter the events noti-
fications in this window by severity. (See Changing Filter 
Options on page 7-9.)

6 Click Save As in the Server View window to save the event list 
to a file.

7 Close the Server View window when you are finished viewing 
the server events or, if you wish, leave it open so you are aware 
of server events as they occur.

Changing Filter Options
You can control what kinds of event entries are listed in the Global 
Current Event Log (part of the Server View window) and the Server 
Historic Event Log window. You can set the filter options globally, or 
you can customize them for individual windows. Follow these steps 
to change the filter settings globally:

1 Click the  button on the toolbar. The Preferences dialog 
box appears.

2 Click Filter. The Default Event Viewing Filter dialog box 
appears, as shown in Figure 7-5.

3 Select or deselect the Critical, Warning, or Informational 
entries to control which kinds of messages appear in the Global 
Current Event Log and the Server Historic Event Log. (We rec-
ommend that you select all the boxes.)

Figure 7-5. Default Event Viewing Filter Dialog Box
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If you choose not to display some kinds of messages, the Items 
displayed number above the log entries lists the number of mes-
sages that are actually displayed. The Items total field always 
indicates the total number of messages of all types.

4 Click OK to record the filter option changes.

If you want to change the filter options only for a specific window, 
open the Server View or Server Historic Event Log window and 
click Filter. Change the options as described above and click OK. 
The changed settings apply only to this window while it is open; the 
settings will return to the defaults if you close and re-open the win-
dow or if you restart Adaptec CI/O Array Management Software.

Selecting Notification Settings

The notification settings determine how you are notified of events 
that occur on servers to which Adaptec CI/O Array Management 
Software is connected. The text describing these events appears in 
the list of current server events and the Server Historic Event Log 
window.

Follow these steps to choose notification settings:

1 Click the  button on the toolbar. The Preferences dialog 
box appears.

2 Click the Notification button; the Event Notification Options 
dialog box appears, as shown in Figure 7-6.

Figure 7-6. Event Notification Options Dialog Box
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Entering and Viewing Client and Server Information
3 Select Pop-up Box, Beep, and/or Flash Title Bar to control 
how you will be notified of events that occur on servers to 
which Adaptec CI/O Array Management Software is 
connected.

Note: Regardless of the options you choose, Adaptec 
CI/O Array Management Software will always notify 
you of Critical events with a pop-up message, a beep, 
and a flashing title bar.

4 Click OK to save these settings.

Viewing Historical Server Information
You can view a log of historical information for any server to which 
Adaptec CI/O Array Management Software is connected. This 
information is retrieved from the server.
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Follow these steps to view historical server information:

1 Click the  button on the toolbar. The Server Historic 
Event Log window for the currently selected server appears, as 
shown in Figure 7-7.

2 View the historical information for the server. New entries are 
added to the top of the list as they occur. A color-coded circle at 
the beginning of each message indicates its severity. (See the 
next section, Interpreting and Responding to Server Event Mes-
sages, for more information.)

3 To view detailed information about an entry on the list, 
double-click the entry. The Log Detail dialog box appears, as 
shown in Figure 7-4 on page 7-8.

4 Click OK when you are finished viewing the Log Detail dialog 
box.

5 Click Filter to change the message filter options. Click Clear 
All to delete all existing log entries. Click Save As to save the 
log to a file.

Figure 7-7. Server Historic Event Log Window
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Entering and Viewing Client and Server Information
Note: When you open the Server Historic Event Log 
window, only the most recent log entries are initially 
retrieved from the server. If you scroll down beyond 
these entries, another group of entries is retrieved. 
This avoids the delay that might occur if an entire 
large log file were retrieved from the server at one 
time. To keep the Server Log file from getting too 
large, specify a maximum size for it in the initializa-
tion file. (See Appendix A, Configuration Settings.)

6 Close the window when you are finished viewing log entries, 
or minimize it as an icon on the screen.

Interpreting and Responding to Server Event 
Messages
There are three severity levels for server events:

■ Critical event messages (red dot) indicate an array or 
server problem that requires immediate action. An example is 
an array going off-line because two array members have failed. 
See Responding to an Off-line Array on page 13-3 for more 
information.

■ Warning event messages (yellow dot) indicate an array or 
server problem that may require attention. An example is a 
paused channel.

■ Informational event messages (green dot) contain infor-
mation about some normal operation, such as creating a new 
array, adding a spare, or verifying an array.
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Entering and Viewing Preference Information
You use the Preferences dialog box to enter or view information 
about how event notifications are received from servers and to 
enable and configure password protection for servers and net-
worked clients.

Follow these steps to change or view preferences information:

1 Click the  button. The Preferences dialog box appears, as 
shown in Figure 7-8.

2 If you wish, enter a different name for the configuration file 
that is stored on the networked client. Click the Browse button 
if you want to store this file in a different directory on the cli-
ent’s hard disk drive.

The configuration file (configs.dat) contains array configura-
tion information for all servers in the server list. Information is 
automatically written to this file every time you exit from 
Adaptec CI/O Array Management Software. The next time 
you start the program, it reads the information from the file so 
you do not have to re-enter it.

Figure 7-8. Preferences Dialog Box
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Entering and Viewing Client and Server Information
3 Click the Notification button to change the way in which you 
are alerted of event notifications sent from servers. The Event 
Notifications Options dialog box appears, as shown in 
Figure 7-6 on page 7-10. Select one or more of the available 
options.

4 Click the Filter button to view the Log Filter dialog box. By 
selecting or deselecting the check boxes, you can filter the 
types of messages that appear in the window. We recommend 
that you select all the boxes so you are fully informed of server 
events.

5 Select a Password Time-out option to set the level of password 
protection for this workstation or server. See Setting Password 
Time-out Options on page 12-4 for more information.

6 Click OK to change the option information or to close the dia-
log box.

Editing the Permanent List
Each server maintains a permanent list and an active list of networked 
clients. Clients that communicate with the server are automatically 
added to the server’s active list. Adding a client name to the perma-
nent list allows that client to receive event notifications from the 
server even when it is not actively monitoring the server. (If a client 
is on the server’s permanent list but not the active list, the server 
icon does not appear in the Server View window.) You can delete the 
client name if you no longer want to be notified of events on a par-
ticular server.

You can only edit the permanent list from a networked client, not 
from the server console. When you do this, you are required to enter 
the server password.

Caution: We recommend that you do not use the permanent 
notification feature for normal communications between 
servers and networked clients. Servers can use the active list 
to rapidly communicate new events to networked clients.
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Follow these steps to add or delete from the permanent list.

1 Open the Server View window and select the icon of the server 
whose permanent list you want to edit.

2 Select Server Administration from the View menu.

3 Select Edit Permanent List. Enter the server’s password when 
you are prompted to do so. The Edit Permanent List dialog box 
appears, as shown in Figure 7-9.

The list box shows the entries that are currently in the selected 
server’s permanent notification list.

4 To add a new networked client entry, type the IP or IPX 
address in the field at the top of the screen, select the IP or IPX 
radio button, and click the Add button.

5 To delete a networked client entry, highlight the entry in the 
list box and click the Delete button.

6 Click Close when you are finished. The changes are registered 
in the server’s permanent list file.

❒

Figure 7-9. Edit Permanent List Dialog Box
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8▼  ▼  ▼  ▼
Configuring Arrays and 
Spares
This chapter explains how to use the Windows versions of Adaptec 
CI/O Array Management Software to add and delete arrays and 
spares. You can do this with the server console version of the pro-
gram or with the networked client version. The menus and com-
mands are the same for all supported versions of Windows.

Note: If you are using an Adaptec Array1000 Family prod-
uct in a Windows NT desktop computer system, you should 
interpret server or server console to mean desktop system wher-
ever the term is used in Part 3 (Chapters 7-12) of this 
document.

You must know the Adaptec CI/O Array Management Software 
password if you want to add and delete arrays and spares. See 
Chapter 12, Setting Security Options, for more information.

The following topics are explained in this chapter:

■ Creating an Array on page 8-4

■ Making an Array the First Virtual Device on page 8-10

■ Deleting an Array on page 8-11

■ Initializing an Array on page 8-13

■ Creating Dedicated Spares or a Spare Pool on page 8-14

■ Deleting a Spare on page 8-17
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Starting the Program
Follow these steps to start the Adaptec CI/O Array Management 
Software and prepare to configure arrays and spares. This assumes 
that the software is already installed and that communications have 
been established between the server and the networked clients, as 
explained in the Installation and Hardware Guide for your Adaptec 
Array1000 Family product.

1 Start Windows.

2 Double-click the  icon in the Adaptec CI/O Array Man-
agement Software group to start the program.

Note: If you are running Adaptec CI/O Array Man-
agement Software from a networked client and the 
message Guest Access Disabled appears at this point, 
this means that the server to which you are trying to 
connect does not allow remote users to view its config-
uration information. See Controlling Guest Access on 
page 12-5 for more information.

3 If you are running Adaptec CI/O Array Management Software 
from a server console, skip to Step 5. If you are running 
Adaptec CI/O Array Management Software from a networked 
client, open the Server View window by clicking the 

button on the toolbar.

Note: If no server icons appear in the upper part of the 
window, you need to enter information about the 
servers you want to monitor before you continue. See 
Adding a New Server Address on page 7-1 for more 
information.
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Configuring Arrays and Spares
4 Click the icon of the server whose arrays and spares you want 
to configure, as shown in Figure 8-1. You can identify the 
server by the name that appears beneath it.

If the icon is grayed out, the server is off-line or otherwise 
unavailable. (See Entering and Viewing Server Information on 
page 7-1 for more information about server icons.)

5 Open the Storage Configuration window by clicking the 

 icon on the toolbar. All array and spare configuration 
tasks are done from within this window.

Note: Depending on your system configuration, the Storage 
Configuration window may open automatically when you 
start the Adaptec CI/O Array Management Software. See 
the How-To Topics section of the Adaptec CI/O Array Man-
agement Software on-line Help for more information about 
this window.

If you are running Adaptec CI/O Array Management Software from 
a networked client, you can open other Storage Configuration win-
dows for other servers to which you are connected. To do this, 
return to the Server View window, select a different server icon, and 

click the  button again.

Figure 8-1. Server Icons
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Creating an Array
Follow these steps to create arrays with Adaptec CI/O Array Man-
agement Software.

1 Start Adaptec CI/O Array Management Software and open the 
Storage Configuration window, as described in Starting the Pro-
gram on page 8-2. This window looks similar to the one shown 
in Figure 8-2.

The icons on the left side of the Storage Configuration window 
represent the server’s physical resources—the Adaptec 
Array1000 Family products, channels, and SCSI devices 
installed in the server. The icons on the right side represent the 
server’s Array resources—the arrays and spares you define. You 
click the buttons in the middle of the window to perform oper-
ations on selected device icons.

2 Before you start defining the new array, decide what RAID 
level you want to use, how many disks you want it to have, 
and whether you want to define dedicated spares (spares that 
can only be used by this array). The following table lists your 
array options. See Selecting a RAID Level for an Array on 

Figure 8-2. Storage Configuration Window
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page 13-5 for information on the advantages and disadvan-
tages of each RAID level. Also see Appendix B, Understanding 
Arrays and RAID Technology

3 Select disks for the new array by clicking disk icons that 
have the word Single beneath them, as shown in Figure 8-3.

Do not include disks that you want to use as spares. Click a sec-
ond time on an icon to deselect it, or click the Clear Selection 
button if you want to deselect all disk icons.

RAID Level
Minimum 

Disks 
Maximum 

Disks 1

1 This is the maximum number of disks supported by the software driver. The maximum for your 
computer system may be less, depending on how many SCSI channels and devices you have.

Dedicated 
Spares

Pool 
Spares

RAID 0 (Striped) 12

2 The purpose of one-disk RAID 0 arrays is to give you more control over the virtual device order 
of disks controlled by the Adaptec Array1000 Family product. This is also useful for defining the 
system’s boot device.

16 None None

RAID 1 (Mirrored) 2 2 1 or 2 up to 8

RAID 0/1 (Mirrored & 
Striped)3

3 RAID 0/1 arrays must have an even number of disks.

4 16 1 or 2 up to 8

RAID 5 (Striped, with 
Distributed Parity)

3 16 1 or 2 up to 8

Figure 8-3. Selecting Array Members
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A warning appears if you select a disk that has a partition. If 
the operating system recognizes the partition, you cannot use 
the disk in the array. If the operating system does not recognize 
the partition (for example, if the disk was previously parti-
tioned under another operating system), you can use the disk 
in the array.

You are prevented from using disks with recognized partitions 
for the array so you will not accidentally erase the server’s 
boot disk. To find out if a disk has a partition, double-click the 

icon and click the Check Partitions button in the SCSI 
Information dialog box. A small popup box indicates whether 
the selected disk has a partition and whether the partition is 
visible to the operating system. If you really want to use a disk 
with a recognized partition in the array, exit from Adaptec 
CI/O Array Management Software, back up any data you 
want to keep, and delete the partition from the disk.

Caution: All data on a disk is deleted when it becomes an 
array member! Back up any data you want to keep 
before selecting a disk as an array member.
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4 Click the Create Array... button. The Create Array dialog box 
appears, as shown in Figure 8-4.

The number of disks in the array and the array capacity are 
listed on the right of the dialog box.

5 Type a name for the new array. The name can be up to 15 char-
acters, including spaces and any other printable characters.

6 Select a RAID level for the array by clicking one of the buttons 
on the left. The bar graphs on the right show you the relative 
levels of data protection, read performance, write perfor-
mance, and capacity utilization for each RAID level.

RAID levels are grayed out if they are not consistent with the 
number of disks you have selected. (See the table on page 8-5.) 
For example, RAID 0/1 is grayed out if you selected three 
disks, because a RAID 0/1 array must have at least four disks.

7 Select one or two disks from the list as dedicated spares (if 
desired). (Use Ctrl-Click to select multiple disks.) The disks on 
the list are the single disks you did not select as array mem-
bers. The spare(s) you select should be at least as large as the 
smallest array member. Otherwise the usable capacity of each 
array member will be reduced to the capacity of the spare.

Figure 8-4. Create Array Dialog Box
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Note: We recommend using a spare pool instead of 
dedicated spares. See Creating Dedicated Spares or a 
Spare Pool on page 8-14 for more information. Spares 
in a spare pool can be used by any array on the 
controller.

8 Click the Advanced... button if you want to examine or change 
the Advanced Array options. The Advanced Array Options 
dialog box appears. See Setting Advanced Array Options on 
page 8-9 for more information.

9 Click OK and then click Yes to confirm that you want to create 
the array. You will see error messages if your array selections 
are inconsistent. If this happens, change your selections and 
click OK again. You will see a warning if you selected a dedi-
cated spare that is smaller than the array members.

The array is initialized at this point, unless you deselected 
auto-initialize in Advanced Array Options. (If you deselected 
auto-initialize, skip to Step 11.) If you want to abort the initial-
ization process (not recommended), open the Array Activity 

Monitor window, select the icon for that array, and 
click Abort.

10 Wait until the new array is initialized. A popup box will 
appear to inform you that event notifications are waiting and 
can be viewed in the Server View window. Then an icon like 

this for the new array appears in the right-hand sec-
tion of the Storage Configuration window. Another event noti-
fication is generated when the initialization process finishes.

Note: Event notifications may appear as popups or just 
as entries in the Server Historic Event Log and Event 
Log, depending on the Event Notification options you 
selected in the Client Settings dialog box.
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11 Exit from Adaptec CI/O Array Management Software. Then 
reboot the server. (You cannot use the new array until you 
reboot.) You must then partition the new array using the 
Windows NT Disk Administrator, just as you would partition 
a new stand-alone disk drive.

Setting Advanced Array Options
The Advanced Array Options dialog box is shown in Figure 8-5. Do 
not change these options from their default settings unless you fully 
understand what the options mean and you have a specific reason 
for changing them.

Here is a brief description of the advanced options:

■ Stripe Size is the size that will be used to stripe data or parity 
information across the disks in the array. The optimal stripe 
size depends on factors such as the type of data being stored 
on the array and the server operating system. The default 
stripe size of 64 KBytes works best in most cases.

■ Deselect auto-initialize if you want to create the array now but 
initialize it at a later time. You might want to do this if you plan 
to define several arrays and initialize them all at the same time. 

Figure 8-5. Advanced Array Options Dialog Box
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Caution: All arrays except RAID 0 arrays must be ini-
tialized or low-level formatted before you can write 
data to them. We recommend that you zero-initialize 
RAID 0 arrays as well.

■ Click the Restore Defaults button if you want to restore the 
default Advanced Array Options settings.

Note: The default settings are the settings that existed 
when you opened the dialog box. If you change the 
settings and click OK, these become the new default 
settings for this array.

Making an Array the First Virtual Device
Use this command if you want the server to boot from an array 
instead of from a stand-alone disk. (If you want to use a stand-alone 
SCSI disk as your boot device, we recommend that you assign SCSI 
ID 0 to this device and that you connect it to Channel A of the 
Adaptec Array1000 Family product.)

You make an array bootable by assigning it virtual device order #0. 
The virtual device order is the sequence in which the server’s operat-
ing system detects the arrays, single disks, and other devices con-
nected to the Adaptec Array1000 Family product when the server 
boots. You may also need to move the Adaptec Array1000 Family 
product to a different PCI slot. See your Adaptec Array1000 Family 
product’s Installation and Hardware Guide for more information.

Caution: When you make an array bootable, the drive letters 
assigned to other drives and arrays on the server may 
change, which can cause data access problems on your sys-
tem. You may find it more convenient to create a bootable 
array with ArrayConfig, which gives you more control of the 
virtual device order of all SCSI devices on the server. See 
Making the Array Bootable on page 2-5 for more information.
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Follow these steps to create a bootable array:

1 Start Adaptec CI/O Array Management Software and open the 
Storage Configuration window, as described in Starting the Pro-
gram on page 8-2.

2 Click the icon in the right part of the window for the 
array that you want to make bootable.

3 Click the Operations button.

4 Click the button.

5 When the message appears, click OK to confirm that you want 
to make this array the boot device.

6 Exit from the Adaptec CI/O Array Management Software. If 
the selected array does not already have a bootable partition 
on it, reboot the server to a floppy disk.

7 Install the operating system on the array. See your Adaptec 
Array1000 Family product’s Installation and Hardware Guide for 
more information.

The next time you boot the server it will attempt to use this array as 
the boot device.

Deleting an Array

Caution: Back up the data on an array before you delete it. 
All data on the array disks is lost when you delete the array.

If you delete an array, all the disks that were part of the array 
become single, stand-alone disks. You can then use the disks as spares 
or as members of a new array. 

Follow these steps to delete an array:

1 Start Adaptec CI/O Array Management Software and open the 
Storage Configuration window, as described in Starting the Pro-
gram on page 8-2.
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2 Click the icon in the right-hand area of the window 
for the array you want to delete.

3 Click the Operations button.

4 When the Array Operations dialog box appears, click the 

 button to delete the array.

A warning appears if the selected array has a partition. If the 
partition is recognized by the operating system, you cannot 
delete the array. If the partition is not recognized by the operat-
ing system, you can delete the array.

You are prevented from deleting an array with a recognized 
partition so you will not accidentally delete the server’s boot 
array. To find out if an array has a partition, double-click the 

icon and click the Check Partitions button in the 
Array Information dialog box. A small popup box indicates 
whether the selected array has a partition and whether the par-
tition is visible to the operating system. If you really want to 
delete an array with a recognized partition, exit from Adaptec 
CI/O Array Management Software, back up any data you 
want to keep, and delete the partition from the disk. Then start 
Adaptec CI/O Array Management Software again and delete 
the array.

5 When the confirmation message appears, click OK to confirm 
that you want to delete the array.

Note: After you delete an array you can immediately use the 
disks that formerly belonged to the array to create spares or 
a new array without rebooting the server. However, you 
must reboot the server before you can use the disks as single 
disks that are not members of an array. Deleting an array 
may change the boot order and the drive assignment.
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Initializing an Array
When you create a new array it is initialized immediately by default 
unless you deselect the auto-initialize option, as described on 
page 8-9. If you choose to deselect auto-initialize, you can initialize 
the array later by following the instructions in this section. You can 
also reinitialize an array that was previously zero-initialized or low-
level formatted.

Caution: All arrays except RAID 0 arrays must be initialized 
or formatted before you can write data to them. We recom-
mend that you zero-initialize RAID 0 arrays as well. All 
data on the disks is overwritten when you initialize an array.

If you want to low-level format the array instead of initializing it 
with zeros, use the ArrayConfig program. Low-level formatting 
checks the surface of the disks for defects.

Follow these steps to initialize an array to which data has previously 
been written or a new array that has been defined but not initialized:

1 Start Adaptec CI/O Array Management Software and open the 
Storage Configuration window, as described in Starting the Pro-
gram on page 8-2.

2 Click the icon of the array you want to initialize. The 
Operations button becomes active.

3 Click the Operations button.

4 When the Array Operations window appears, click the 

button.

A warning appears if the selected array has a partition. If the 
partition is recognized by the operating system, you cannot ini-
tialize the array. If the partition is not recognized by the operat-
ing system, you can initialize the array.

You are prevented from initializing an array with a recognized 
partition so you will not accidentally erase the server’s boot 
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array. To find out if an array has a partition, double-click the 

icon, and click the Check Partitions button in the 
Array Information dialog box. A small popup box indicates 
whether the selected array has a partition and whether the par-
tition is visible to the operating system. If you really want to 
initialize an array with a recognized partition, exit from 
Adaptec CI/O Array Management Software, back up any data 
you want to keep, and delete the partition from the disk. Then 
start Adaptec CI/O Array Management Software again and 
initialize the array.

5 When the confirmation message appears, click Initialize to 
confirm that you want to initialize the array.

If you want to abort the initialization process (not recom-
mended), open the Array Activity Monitor window, select the 

icon, and click Abort.

It may take a long time to initialize an array. If you wish, you can 
watch the progress of the initialization process in the Array Activity 
Monitor window.

Creating Dedicated Spares or a Spare Pool
Each RAID 1, RAID 0/1, or RAID 5 array can have one or two dedi-
cated spares, which automatically replace failed disks only for that 
array. You can create dedicated spares when you create the array, or 
you can add them to the array at a later time. You can also create a 
spare pool of up to eight disks which automatically replace disks that 
fail in any array on the controller.

We recommend using a spare pool instead of dedicated spares if you 
have two or more arrays on a controller. Spare pools give you more 
flexibility and provide good data protection with fewer disks than 
what is required for dedicated spares.
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Note: When you install Adaptec CI/O Array Management 
Software it is automatically configured to test all spares on 
the server once a day to assure they are always available, if 
needed, to replace failed disks in arrays. We recommend 
that you leave this default setting so that all spares are 
tested regularly.

Follow these steps to add a dedicated spare or a pool spare:

1 Start Adaptec CI/O Array Management Software and open the 
Storage Configuration window, as described in Starting the Pro-
gram on page 8-2.

2 Select the disk you want to configure as a spare by clicking on 
its icon in the left-hand part of the window. (Select a disk that 
has the word Single beneath it.)

3 Click Create Spare... The Create Spare dialog box appears, as 
shown in Figure 8-6. A list of already-defined spares appears 
on the right. Names of existing arrays appear on the left only if 
the disk you selected is large enough to protect that array as a 
spare.

Figure 8-6. Create Spare Dialog Box
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Note: In the Storage Configuration window, pool 
spares are labeled p-spare and dedicated spares are 
labeled d-spare in both the left and right parts of the 
window.

4 If you want to dedicate the spare to a specific array, select Ded-
icated To and click the array name in the scrollable list. If you 
want to add the spare to the pool of spares available to all 
arrays on the controller, do not select the Dedicated To box.

5 Click OK to create the spare. A warning message appears if 
you select a disk that has a partition. If the partition is recog-
nized by the operating system, you cannot use the disk as a 
spare. If the partition is not recognized by the operating system 
(for example, if the disk was previously partitioned under 
another operating system), you can use the disk as a spare.

You are prevented from using disks with recognized partitions 
so you will not accidentally erase the server’s boot disk. To 

find out if a disk has a partition, double-click the icon 
and click the Check Partitions button in the SCSI Information 
dialog box. A small popup box indicates whether the selected 
disk has a partition and whether the partition is visible to the 
operating system. If you really want to use a disk with a recog-
nized partition as a spare, exit from Adaptec CI/O Array Man-
agement Software, back up any data you want to keep, and 
delete the partition from the disk.

Newly-created spares are immediately available for use, with-
out rebooting the server. If an array is in Critical status, it will 
be reconstructed as soon as you have created the spare (unless 
the spare is dedicated to another array).
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Note: You can add a disk of any size to the spare pool, even 
if the disk is too small to protect the existing arrays. For 
example, if you have created two arrays with 1 GByte disks, 
you can add a 500-MByte disk to the spare pool, even 
though this disk is too small to replace any failed array 
member. The spare pool feature is designed like this to give 
you additional flexibility. For example, you may be plan-
ning to create a third array later with 500-MByte disks.

To see which arrays are protected by an existing spare, select the 
spare in the Existing Spares list; the arrays covered by this spare are 
highlighted in the Existing Arrays list. You can double-click an array 
or a spare to view detailed information about it.

Deleting a Spare
You can delete a spare if you want to use it as a stand-alone disk.

Follow these steps to delete a spare:

1 Start Adaptec CI/O Array Management Software and open the 
Storage Configuration window, as described in Starting the Pro-
gram on page 8-2.

2 Click the icon in the Array part of the window for the spare 
you want to delete.

3 When the confirmation message appears, click OK to confirm 
that you want to delete the spare.

After you delete an existing spare, and before you reboot the server, 
you can use a former spare to create a new array or spare. However, 
this disk does not become visible to the server operating system as a 
single disk until after you reboot the server.

❒
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9▼  ▼  ▼  ▼
Viewing Array and Device 
Information
The Adaptec CI/O Array Management Software allows you to view 
information about arrays, spares, SCSI channels, and SCSI devices 
on any server to which you have access.

You view this information in the Storage Configuration window. 
Follow these steps to open the Storage Configuration window:

1 Select Configuration from the View menu, or click the  
icon on the toolbar.

2 When the Storage Configuration window appears, double-
click the icon that represents the device for which you want to 
view information. The icons for the more commonly used 
devices are as follows:

– Array

– Spare

– Controller

– Channel
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– Disk Device

– CD-ROM Drive

– Tape Drive

Note: There are also icons for CD changer, SCSI 
printer, SCSI scanner, etc.

The array and spare icons are virtual devices that appear on 
the right side of the Storage Configuration window. Virtual 
means that arrays and spares do not exist until you configure 
them on the server.

The Adaptec Array1000 Family product, channel, and SCSI 
device icons are physical devices that appear on the left side of 
the window. Physical means that the icons correspond to actual 
devices installed in the server, such as a SCSI disk drive or a 
CD-ROM drive.

The following sections explain the information that appears when 
you click an icon for a virtual or physical device.
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Viewing Array Information

When you double-click an array icon  in the Storage Config-
uration window, the Array Information dialog box appears, as 
shown in Figure 9-1.

The following information appears in the Array Information dialog 
box:

■ Status: current status of the array, such as OK, Off-line, Fault-
tolerant, Critical, etc.

■ Model: model name of the Adaptec Array1000 Family product 
to which the array disks are connected.

■ Array type: RAID level of the array. The supported levels are 
RAID 0, RAID 1, RAID 0/1, and RAID 5.

■ Capacity: total usable disk space available in the array, in 
MBytes.

■ Member size: size of the array members.

■ Array members: number of disks in the array.

■ Dedicated spares: number of spare disks dedicated to this 
array.

■ Available pool spares: number of pool spares available to pro-
tect this array.
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Click the Check Partitions button to determine if the array has a 
partition. A small dialog box indicates whether the selected array 
has a partition and whether the partition is visible to the operating 
system.

When you click the Detail button, you can view the following addi-
tional information about the array:

■ Stripe size: data and parity striping size used on this array.

■ Virtual device order: the sequence in which the server’s oper-
ating system detects this array when it boots. If the array’s vir-
tual device order is 0, then this array is the first device the 
operating system detects at boot time.

■ Creation date: date on which the array was created.

■ Date of last verify: date on which the array was last verified. 
See Verifying Array Integrity on page 10-6 for information on 
how to verify an array.

■ Date of last reconstruct: date on which the array was last 
reconstructed. See Reconstructing an Array on page 10-2 for 
information on how to reconstruct an array.

Click Close to close the Array Detail and Array Information dialog 
boxes.
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Viewing Spare Information

When you double-click a spare icon in the right side of the Stor-
age Configuration window the Spare Information dialog box 
appears, as shown in Figure 9-2.

If you double-click a spare icon in the left side of the window you 
will see the SCSI Information dialog box, the same as for a single 
SCSI disk.

The Spare Information dialog box shows which array the spare is 
dedicated to, whether it is a member of a spare pool, its capacity, and 
its current status. An Available status means the spare is fully func-
tional and is available to replace a failed array disk.

Note: The spare icons in the Storage Configuration window 
are labeled p-spare for pool spares and d-spare for dedi-
cated spares.

Click Close to close the Spare Information dialog box or SCSI Infor-
mation dialog box.

Figure 9-2. Spare Information Dialog Box
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Viewing Controller Information

When you double-click a controller icon , the Controller 
Information dialog box appears, as shown in Figure 9-3.

The information in the Controller Information dialog box is self-
explanatory. The PCI bus number field indicates which PCI slot the 
Adaptec Array1000 Family product is installed in. You may need to 
know this information if you want to configure the server to boot 
from an array. For more information, read the server documentation.

Click the Capabilities button to view a list of the features supported 
by this Adaptec Array1000 Family product. The list is informational 
only; you cannot enable or disable the capabilities on the list. Here is 
a list of controller capabilities that may appear on the list. (Not all 
features appear for every product):

■ Auto Verify: indicates that the product automatically verifies 
SCSI parity.

■ Auto Fix: indicates that the product automatically corrects data 
and parity miscompares.

■ Supported RAID Levels: lists the RAID levels the product 
supports.

■ Maximum Number of Spares: lists the maximum number of 
dedicated spares per array that the product supports.

■ Maximum Number of Physical Arrays: lists the maximum 
number of arrays the product supports.

Figure 9-3. Controller Information Dialog Box
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■ Maximum Number of Drives for a Single Array: lists the 
maximum number of disks the product supports for a single 
array.

■ Maximum/Minimum Stripe Size: lists the range of data and 
parity stripe sizes that the product supports.

■ Spare Pool: indicates that the Adaptec Array1000 Family prod-
uct supports using spares from a spare pool.

Click Close to close the Capabilities dialog box and the Controller 
Information dialog box.

Viewing Channel Information

When you double-click a channel icon , the Channel Informa-
tion dialog box appears, as shown in Figure 9-4.

The following information appears in the Channel Information dia-
log box:

■ Status: current operational status of the channel (for example, 
Active, Inactive).

■ Channel type: type of this channel—for example, SCSI.

■ Maximum Devices: maximum number of SCSI devices that 
the channel supports. If this number is 16 (for example) it 

Figure 9-4. Channel Information Dialog Box
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means you can connect up to 15 devices, since the channel 
itself counts as one device.

■ Current Devices: number of SCSI devices currently connected 
to the channel.

Click Close to close the Channel Information dialog box.

Viewing SCSI Device Information

When you double-click a SCSI device icon, such as a disk or 

a CD-ROM drive , the SCSI Information dialog box appears, 
as shown in Figure 9-5.

The information in this dialog box is self-explanatory. When you are 
creating an array you can view this dialog box to determine if a disk 
you want to use for the array has partitions on it. Simply click the 
Check Partitions button and read the text in the popup window.

Figure 9-5. SCSI Information Dialog Box
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Note: You cannot use a disk in an array if it has a partition 
that is visible to the operating system. (This prevents you 
from accidentally deleting data or erasing your boot disk.) If 
you want to use a disk with a recognized partition in the 
array, exit from Adaptec CI/O Array Management Soft-
ware, back up any data you want to keep, delete the parti-
tion, and then run Adaptec CI/O Array Management 
Software again.

Click the Blink Drive Light button if you are not sure which physi-
cal device the icon represents. The light on the front of the drive will 
flash briefly. (This option is not available for other kinds of SCSI 
devices, such as CD-ROM drives.)

Click Close to close the SCSI Information dialog box.

Rescanning the Server
Whenever you boot the server the operating system software scans 
the server for installed devices such as arrays and SCSI devices. 
Adaptec CI/O Array Management Software displays icons for these 
devices in the Storage Configuration window.

Sometimes you need to issue a Rescan command while Adaptec 
CI/O Array Management Software is running so it can “see” the 
new hardware configuration. You need to do a Rescan if

■ you connect a new SCSI device to the Adaptec Array1000 Fam-
ily product without using the Pause I/O command

■ you disconnect a SCSI device from the Adaptec Array1000 
Family product without using the Pause I/O command

A Rescan is done automatically whenever you pause I/O and 
resume I/O to an array or a device. You do not need to issue a Res-
can command to detect a failed array member. Adaptec CI/O Array 
Management Software will detect the failed member automatically 
if I/O is occurring on the array.
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Follow these steps to rescan the server:

1 Click the  button on the toolbar. The Storage Configu-
ration window appears.

2 Click the Rescan button, which appears in the area between 
the Physical Resources and Array areas of the window.

3 When the message appears, click Yes to confirm that you want 
to rescan the server. When the rescan is complete, any hard-
ware changes are reflected in the icons in the Storage Configu-
ration window.

4 Click OK when the message appears indicating that the rescan 
was completed successfully.

Note: You cannot use the Rescan command to recognize an 
entire array that was transferred from another server. You 
must reboot the server before it recognizes the transferred 
array. However, if you remove a disk that is an array mem-
ber, replace it with another disk, and issue a Rescan com-
mand, Adaptec CI/O Array Management Software will 
detect that the new disk is no longer an array member.

❒
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10▼  ▼  ▼  ▼
Performing Array, Spare, 
and Disk Operations
In Adaptec CI/O Array Management Software you can perform a 
number of operations on arrays, spares, and stand-alone disks. 
These operations include verifying the SCSI parity of arrays, recon-
structing an array, testing spares, and blinking the lights on one or 
more disks. Some of the operations are performed immediately; oth-
ers can be scheduled for a later time, or scheduled to occur periodi-
cally at stated intervals.

To perform array, spare, and disk operations you first open the Stor-
age Configuration window. To do this:

1 Select Configuration from the View menu, or click the 

icon on the toolbar.

2 When the Storage Configuration window appears, single-click 

the icon that represents the array , spare , or SCSI 

disk you want to work on.

When you do this, the Operations button becomes active. 

3 Click the Operations button. The Array Operations, Spare 
Operations, or Disk Operations dialog box appears.
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4 Click the button for the operation you want to perform. See the 
appropriate section of this chapter for a description of these 
operations.

Performing Array Operations
Here is a list of the array operations. Note that some of these opera-
tions are described in Chapter 8, Configuring Arrays and Spares.

■ Reconstructing an Array on page 10-2

■ Pausing I/O on an Array on page 10-5

■ Verifying Array Integrity on page 10-6

■ Blinking Array Drive Lights on page 10-8

■ Reactivating an Off-line Array on page 10-9

■ Changing an Array Name on page 10-9

■ Forcing a Spare on page 10-10

■ Making an Array the First Virtual Device on page 8-10

■ Deleting an Array on page 8-11

■ Initializing an Array on page 8-13

Reconstructing an Array
If a spare disk is available when an array disk fails, the array is auto-
matically reconstructed, and you do not need to use the Reconstruct 
operation. However, if a disk in an array fails and no spare is avail-
able to replace it, you receive an event notification that the array is 
Critical. You may need to reconstruct the array with this command 
after the drive is replaced. In either case, data on the array is not lost.

You can reconstruct an array immediately after you replace the 
failed disk, or you can schedule the reconstruct to occur at a later 
time. Since the reconstruction process may take a long time, you 
may want to schedule it for a time when there is less activity on the 
server.

Follow these steps to reconstruct an array when a disk fails:

1 Determine which array is in Critical status and which disk in 
the array has failed.
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Performing Array, Spare, and Disk Operations
It is possible that a RAID 0/1 array in Critical status may have 
more than one failed disk. The array can still be reconstructed 
without data loss as long as at least one disk of each mirrored 
pair is still good.

2 If the array enclosure does not support hot swapping1, pause 
I/O to the array. (See Pausing I/O on an Array on page 10-5.) 
This is not necessary if the array enclosure does support hot 
swapping.

3 Replace the failed disk (or disks) with a good disk of at least 
the same storage capacity. Be sure that the SCSI ID of the new 
disk is different from the SCSI ID of other installed devices. Or, 
if an array disk was accidentally disconnected, reconnect it.

4 If you paused I/O in Step 2, wait until it automatically 
resumes after the pause period. If you did not pause I/O, issue 
a Rescan command to detect the new disk.

5 If you installed a new disk (or disks), make the disk into a 
spare by following the directions in Creating and Deleting Spares 
on page 3-12. Be sure the new spare disk is at least as large as 
the smallest array member.

Note: When the spare is created, Adaptec CI/O Array 
Management Software should automatically start a 
Reconstruct operation on the array. If for some reason 
the reconstruct does not begin automatically, follow 
the remaining steps to perform it manually.

6 Select Configuration from the View menu. The Storage Con-
figuration window appears.

7 Click on the array icon that looks like this . The Opera-
tions button becomes active.

1 Hot swapping support means that the array enclosure electrically isolates the 
bad disk’s SCSI connector from the SCSI bus while the disk is being 
swapped to prevent data corruption. Data can still be transferred to and 
from the remaining good disks while the bad drive is replaced. Check with 
the manufacturer of the array enclosure if you are not sure whether it sup-
ports hot swapping.
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8 Click the Operations button. The Array Operations dialog box 
appears, as shown in Figure 10-1.

9 Click the button. If the array has one failed drive the 
Scheduler dialog box appears.

If you have a RAID 0/1 array with two or more failed disks, 
and at least one disk of each mirrored pair is still good, a dialog 
box appears with a list of the failed disks. You must reconstruct 
the disks one-at-a-time, starting over each time at the begin-
ning of these steps. Select one of the drives on the list and click 
OK; the Scheduler dialog box appears. (This assumes that you 
have already physically replaced all of the failed drives with 
good drives.)

10 Enter the required information for the Reconstruct operation in 
the Scheduler dialog box. You can select Immediate to recon-
struct the drive immediately or select Once to schedule the 
operation for a later time. (See Setting Scheduling Options on 
page 11-1 for more information.)

11 Select an Execution Priority - high, medium, or low.

12 Click OK.

13 When the message appears, confirm that you want to recon-
struct the array member.

Figure 10-1. Array Operations Dialog Box
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Performing Array, Spare, and Disk Operations
14 Read the event notifications that appear in the Server View 
window (they may also appear as popups on the screen) to 
determine when the reconstruct is complete.

Open a Watch box if you want to monitor the progress of the array 
reconstruction. (See Monitoring Activities that are Running on 
page 11-5.)

Pausing I/O on an Array
Use this option to pause data I/O on an array while you replace a 
disk, reconnect a loose connection, etc. If your array enclosure sup-
ports hot swapping2, you probably do not need to pause I/O in 
order to replace a disk. See the array enclosure documentation for 
more information.

When you pause an array, all other devices on all channels on the 
Adaptec Array1000 Family product are also paused. I/O is automat-
ically resumed after a specified pause interval.

Note: The Pause I/O command is disabled if a Verify, Recon-
struct, or Initialize operation is running.

Follow these steps to pause and resume I/O on an array:

1 Open the Storage Configuration window and select the icon of 

the array you want to pause.

2 When the Array Operations dialog box appears, click the 

button.

3 When the Pause I/O dialog box appears, enter a pause interval 
that does not exceed the maximum allowable pause period, 

2 Hot swapping support means that the array enclosure electrically isolates the 
bad disk’s SCSI connector from the SCSI bus while the disk is being 
swapped to prevent data corruption. Data can still be transferred to and 
from the remaining good disks while the bad drive is replaced. Check with 
the manufacturer of the array enclosure if you are not sure whether it sup-
ports hot swapping.
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and click OK to pause the array. (You may need to enter the 
server password at this point.) Wait a few seconds until data 
I/O stops.

Note: The minimum pause period is 5 seconds; the 
maximum pause period is 120 seconds.

4 Do whatever you need to do with the array disks. Data I/O 
resumes automatically at the end of the pause period.

Verifying Array Integrity
Use this option to verify the integrity of redundant data stored on 
fault-tolerant (RAID 0/1, RAID 1, RAID 5) arrays. When you run 
this operation, Adaptec CI/O Array Management Software checks 
the array for miscompares and corrects parity errors automatically. 
A miscompare occurs when the parity information on a RAID 5 array 
does not match the user data or when some part of the data on a 
mirrored disk pair in a RAID 0/1 or RAID 1 array does not match.

In Adaptec CI/O Array Management Software you can schedule the 
Verify operation to run later or schedule it to run at a regularly 
occurring interval. We recommend that you schedule a verification 
of all arrays at least once a week. See Setting Scheduling Options on 
page 11-1 for more information.

Follow these steps to verify the integrity of redundant array data:

1 Select Configuration from the View menu. The Storage Con-
figuration window appears.

2 Click on the array icon . The Operations button becomes 
active.

3 Click the Operations button.
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Performing Array, Spare, and Disk Operations
4 When the Array Operations dialog box appears, click the 

 button to verify the data on the array. The Scheduler 
dialog box appears, as shown in Figure 10-2.

5 Leave the autocorrect box checked so that any data parity or 
mirroring mismatches will be corrected automatically.

6 Select Immediate if you want to verify parity immediately, or 
select Scheduled if you want to schedule the operation for a 
future time.

7 If you select Scheduled, enter a start time, start day of the 
week, and other information. (See Setting Scheduling Options on 
page 11-1 for more information.)

8 Select an Execution priority - high, medium, or low. This 
determines how much system resources are devoted to the 
operation. A high priority means the Verify operation will use 

Figure 10-2. Scheduler Dialog Box
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a lot of system resources, which may slow down other system 
activity.

9 Click OK to start the operation (if you selected Immediate) or 
to enter it on the list of scheduled activities.

10 When the message appears, confirm that you want to verify 
parity information.

You can open a Watch window to monitor the progress of the opera-
tion as it is running. See Monitoring Activities that are Running on 
page 11-5 for more information.

Blinking Array Drive Lights
You can issue a command to blink the drive lights of all the disks in 
a selected array. This allows you to see which physical drives actu-
ally form the array.

Follow these steps to blink the drive lights of the disks in an array:

1 Select Configuration from the View menu. The Storage Con-
figuration window appears.

2 Click on an array icon in the right side of the dialog box. The 
Operations button becomes active.

3 Click the Operations button.

4 When the Array Operations dialog box appears, click the 

 button.

5 Look at the array enclosure to see which disks are members of 
the array.

6 Click the Unblink all button in the Storage Configuration dia-
log box to stop the drive lights from blinking.
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Performing Array, Spare, and Disk Operations
Reactivating an Off-line Array
An array may go off-line because a cable is disconnected or because 
you mistakenly removed the wrong disk while trying to replace a 
failed disk. In these situations, the array shuts down temporarily. 
Depending on the reason why the array went off-line, it is possible 
that you can reactivate it and resume I/O without data loss. See 
Responding to an Off-line Array on page 13-3 for more information.

After you correct any hardware problems, follow these steps to reac-
tivate an off-line array:

1 Select Configuration from the View menu. The Storage Con-
figuration window appears.

2 Click on the grayed-out icon of the off-line array. The Opera-
tions button becomes active.

3 Click the Operations button.

4 When the Array Operations dialog box appears, click the 

 button.

5 When the message appears, confirm that you want to reacti-
vate the array. Be sure that any hardware problems are cor-
rected before you do this.

Changing an Array Name
When you create an array, you assign it a name of your choosing. 
This name appears beneath the array icon and in many of the win-
dows and dialog boxes. It is also used to identify the source of event 
notifications. You can change this name at a later time, if necessary.

Follow these steps to change the name of an existing array:

1 Select Configuration from the View menu. The Storage Con-
figuration window appears.

2 Click the icon of the array whose name you want to 
change. The Operations button becomes active.

3 Click the Operations button.
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4 When the Array Operations dialog box appears, click the 

 button. The Change Name dialog box appears.

5 Type the new array name and click OK.

6 When the confirmation message appears, confirm that you 
want to change the array name. This change appears immedi-
ately in the Storage Configuration window.

Forcing a Spare
Forcing a spare means issuing a command for a spare disk to replace 
a specific disk in an array. You can do this if the array disk is not per-
forming well and is giving some indication that an array member 
may fail soon. (If an array member actually does fail, a spare 
replaces it automatically without requiring you to force a spare.)

Follow these steps to force a spare:

1 Be sure that one or more spares are available for the array. 
These can either be dedicated spares for the array or spares 
from a spare pool. See Creating Dedicated Spares or a Spare Pool 
on page 8-14 for more information on configuring spares.

2 Select Configuration from the View menu. The Storage Con-
figuration window appears.

3 Click on the icon of the array with the suspect disk. The Opera-
tions button becomes active.

4 Click the Operations button.

5 When the Array Operations dialog box appears, click the 

 button. This button is grayed out if no spares are 
available.

6 Select the disk that you want to replace.

7 Click OK to replace this disk with a spare.

8 When the confirmation message appears, confirm that you 
want to replace the disk with the spare.
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Performing Array, Spare, and Disk Operations
At this point data I/O is paused to the disk, and the spare is 
automatically activated to replace it.

If there is a pool of available spares, you cannot control which disk 
from the pool is activated when you force a spare. You can control 
this if there is only one dedicated spare or one pool spare. If both ded-
icated spares and pool spares are available, the dedicated spares are 
used first. An error message appears if the spare is not at least as 
large as the smallest disk in the array. If this happens, add a larger 
spare.

Performing Spare Operations
Here is a list of the spare operations available in Adaptec CI/O 
Array Management Software. (Note that Deleting a Spare is covered 
in an earlier chapter):

■ Testing All Spares on page 10-11

■ Blinking the Spare Drive Light on page 10-13

■ Deleting a Spare on page 8-17

Note: If you are running Adaptec CI/O Array Management 
Software from a networked console, all spare operations 
apply only to the spares on the currently selected server.

Testing All Spares
Reliable spares must be available to immediately (and automati-
cally) replace any array disk that fails. Spares should be tested regu-
larly to assure that they are working properly. We recommend that 
you test all spares daily. You can run this operation immediately by 
issuing a command, or you can use the Scheduler function to set up 
a recurring check of all the spares at a time when few, if any, users 
are logged on to the server.

Note: When you install Adaptec CI/O Array Management 
Software it automatically sets up a daily Test All Spares 
operation on the server. We recommend that you leave this 
default setting so that all spares are tested regularly.
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Follow these steps to test all spares:

1 Select Configuration from the View menu. The Storage Con-
figuration window appears.

2 Click on the icon of any spare on the right side of the dialog 
box. The Operations button becomes active.

3 Click the Operations button.

4 When the Spare Operations dialog box appears, click the 

 button. The Scheduler dialog box appears, as shown in 
Figure 10-2 on page 10-7.

5 Select Immediate if you want to test all spares immediately, or 
select Scheduled if you want to schedule the operation for a 
later time.

6 If you select Scheduled, enter a starting time, starting day, and 
other information.

7 Select an Execution priority - high, medium, or low.

8 Click OK to start the operation (if you selected Immediate) or 
to enter it on the list of scheduled activities.

9 When the confirmation message appears, confirm that you 
want to test the spares.

10 Read the popup message that appears when the test is com-
pleted. (The message is also recorded in the Server Historic 
Event Log and the Server View window.) If any spares failed 
the test, look at the spare disk icons in the Storage Configura-
tion window. The icons of the failed disks will look like this 

.

11 Replace any failed disks immediately with good disks of at 
least the same capacity.
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Performing Array, Spare, and Disk Operations
Blinking the Spare Drive Light
You can issue a command to blink the drive light of a spare whose 
icon you have selected. This allows you to see which physical drive 
is the actual spare.

Follow these steps to blink the drive light of a spare:

1 Select Configuration from the View menu. The Storage Con-
figuration window appears.

2 Click on a spare icon in the right side of the dialog box. The 
Operations button becomes active.

3 Click the Operations button.

4 When the Spare Operations dialog box appears, click the 

 button.

5 Look at the array enclosure to see which disk light is blinking.

6 Click the Unblink all button in the Storage Configuration win-
dow to stop the drive light from blinking.
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Performing Disk Operations
You can perform the following disk operations with a single disk or 
with a selected disk in an existing array:

■ Blinking the Drive Light on page 10-14

■ Downing the Drive on page 10-15

■ Pausing I/O to a Disk Drive on page 10-16

Blinking the Drive Light
You can issue a command to blink the light of a disk whose icon you 
have selected. This allows you to see which physical disk corre-
sponds to the disk icon.

Follow these steps to blink a drive light:

1 Select Configuration from the View menu. The Storage Con-
figuration window appears.

2 Click on a disk icon in the left side of the window. The Opera-
tions button becomes active.

3 Click the Operations button.

4 When the Drive Operations window appears, click the  
button.

5 Look at the array enclosure to see which disk light is blinking.

6 Click the Unblink all button in the Storage Configuration dia-
log box when you want to stop the drive light from blinking.
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Downing the Drive
Use this option to stop all data I/O to a member of an array. You 
might need to do this if the disk generates a S.M.A.R.T.3 alert indi-
cating that it is about to fail. When you down an array member, a 
spare is activated immediately (if available) to replace it, and a 
reconstruct is triggered for RAID levels that support it.

Note: The Down a Drive command can only be used for 
array members, not for spare disks or single disks.

Follow these steps to down a disk:

1 Select Configuration from the View menu. The Storage Con-
figuration window appears.

2 Select the icon of the disk you want to pause.

3 Click the Operations button.

4 When the Drive Operations dialog box appears, click the 

button. If a spare is available, it replaces the downed 
disk immediately and a reconstruct of the array is triggered.

5 Wait until the Reconstruct operation is completed, and then 
continue with your work in the program.

3 S.M.A.R.T. stands for Self-Monitoring, Analysis and Reporting Technology. 
Hard disk drives that support this technology continually analyze their per-
formance and generate an alert if they determine that the disk is likely to fail 
soon. Adaptec CI/O Array Management Software generates an event noti-
fication if it receives this alert, allowing you to replace the disk before it 
actually fails.
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Pausing I/O to a Disk Drive
Use this option to pause data I/O on a disk drive. You might need to 
do this if you want to replace the disk and the array enclosure does 
not support hot swapping4. See the array enclosure documentation 
for more information. When you pause I/O to a disk drive, all other 
devices connected to the Adaptec Array1000 Family product are 
paused as well. I/O resumes at the end of the pause period.

Note: The Pause I/O command is disabled if a Verify, Recon-
struct, or Initialize operation is running.

Follow these steps to pause data I/O to a disk:

1 Select Configuration from the View menu. The Storage Con-
figuration window appears.

2 Select the icon of the disk you want to pause.

3 Click the Operations button. When the Array Operations dia-

log box appears, click the  button.

4 When the Pause I/O dialog box appears, enter a pause interval 
that does not exceed the maximum allowable pause period, 
and click OK to pause the disk. (You may need to enter the 
server at this point.) Wait a few seconds until data I/O stops.

Note: The minimum pause period is 5 seconds; the 
maximum pause period is 120 seconds.

5 Do whatever you need to do to the disk. Be sure to complete 
your work before the pause period expires. I/O resumes auto-
matically at the end of this period.

❒

4 Hot swapping support means that the array enclosure electrically isolates the 
bad disk’s SCSI connector from the SCSI bus while the disk is being 
swapped to prevent data corruption. Data can still be transferred to and 
from the remaining good disks while the bad drive is replaced. Check with 
the manufacturer of the array enclosure if you are not sure whether it sup-
ports hot swapping.
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11▼  ▼  ▼  ▼
Scheduling and Monitoring 
Array Operations
Adaptec CI/O Array Management Software enables you to sched-
ule certain kinds of operations to run at a later time, or to schedule 
them to run at regularly recurring intervals. You create these as 
scheduled jobs at the time you give the command to run the activity, 
as described in Verifying Array Integrity on page 10-6, Reconstructing 
an Array on page 10-2, and Testing All Spares on page 10-11.

Setting Scheduling Options
The Scheduler dialog box allows you to schedule the Reconstruct an 
Array, Verify Integrity of Array, and Test All Spares operations. 
Reconstruct an Array is a one-time event for which you can enter a 
date and time. Verify Integrity of Array and Test All Spares can be 
scheduled as hourly, daily, or monthly recurring events. The Sched-
uler appears automatically when you define a new scheduled 
operation.
Adaptec Array1000 Family Array Management Guide
Stock Number: 511468-00, Rev. A Page: 11-1
Print Spec Number: 496645-00
Current Date: 3/2/99 ECN Date: 4/29/97

11-1



Adaptec Array1000 Family Array Management Guide
Follow these steps to set scheduling options for a newly added 
operation:

1 Define a new scheduled operation: Reconstruct an Array, Ver-
ify Integrity of Array, or Test All Spares. The Scheduler dialog 
box appears, as shown in Figure 11-1.

2 Select Immediate to perform the action immediately or Sched-
uled to schedule it for later.

3 If you select Scheduled, select Once, Periodically, Daily, or 
Weekly. Enter other information such as day of the week or 
start time/date, as required.

Note: If you are scheduling an array reconstruct, you 
can only select the Once option.

4 Click OK to record the scheduling options. You may be 
prompted to confirm the activity.

Figure 11-1. Scheduler Dialog Box
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Viewing and Managing Scheduled Activities
You can view information about scheduled and currently running 
activities in the Array Activity Monitor window. You can abort 
activities that are running or delete scheduled activities. If you are 
running Adaptec CI/O Array Management Software from a net-
worked client, the Array Activity Monitor window shows scheduled 
tasks for the currently selected server. To view activities on another 
server, select the server’s icon in the Server View window and open 
a new Array Activity Monitor window.

Note: When you install Adaptec CI/O Array Management 
Software it automatically sets up a daily Test All Spares 
operation on the server.

Follow these steps to view and manage scheduled activities:

1 Select Activities from the View menu. The Array Activity 
Monitor window appears, as shown in Figure 11-2.

2 Select an activity icon from the left part of the window. Infor-
mation about the activity is shown in the window. Each kind of 

Figure 11-2. Array Activity Monitor Window
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activity has a distinctive icon. The icon labels indicate which 
array or spare the activity applies to.

To view more detailed information about the activity, double-
click the activity icon. The Scheduler dialog box appears, as 
shown in Figure 11-1. Click Cancel to close the dialog box.

3 If you want to change the priority of a Verify or Reconstruct 
operation that is currently running (as indicated by a moving 
icon), select the activity icon on the left of the window and then 
click Change Priority. When the Change Priority dialog box 
appears, select an option and click OK.

Note: The priority change applies only while the activ-
ity is running this time. If it is a regularly scheduled 
activity, the next time it runs it will have the priority 
originally assigned to it. You cannot change the prior-
ity of an Initialize or Test All Spares operation that is 
currently running.

4 If you want to delete an activity that is not currently running, 
select its icon and click the Delete button. After you confirm 
the command, the activity is deleted from the list.

5 If you want to abort a currently-running activity, select its icon 
and click the Abort button. After you confirm the command, 
the activity stops running immediately. If this is a regularly 
recurring activity, such as a nightly test of all spares, it will run 
again in the future at the next scheduled time. Use Abort and 
then Delete if you want the activity to never run again.

6 Click the Watch button to open a small window to monitor the 
selected, currently running activity. See the following section 
for more information.
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Monitoring Activities that are Running
You can open one or more Watch windows to monitor currently-
running array activities. You can leave these small windows open 
while you continue doing other work on the computer.

When a Verify operation completes, the Watch window shows the 
total number of miscompares. A miscompare occurs when the parity 
information on a RAID 5 array does not match the user data or 
when some part of the data on a mirrored disk pair in a RAID 0/1 or 
RAID 1 array does not match. If you checked the Auto Correct box 
in the Verify dialog box, the miscompares are automatically fixed.

Follow these steps to monitor activities that are running:

1 Select Activities from the View menu. The Array Activity 
Monitor window appears.

2 Select the icon of a currently-running activity from the scrolla-
ble list at the top of the window.

3 Click the Watch button. A small Watch window for this activ-
ity appears, as shown in Figure 11-3. Each window has a per-
cent complete graph and a Status field (OK, Done, Failed). If a 
Verify operation is running, there is also a field listing the num-
ber of miscompares found. Click Close to close the Watch win-
dow after the activity has completed.

❒

Figure 11-3. Watch Window
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12▼  ▼  ▼  ▼
Setting Security Options
Adaptec CI/O Array Management Software has simple but effective 
password protection to prevent unauthorized changes to array con-
figuration. Users who know the password can view server informa-
tion and can issue commands to add and delete arrays, add and 
delete spares, and make other changes to array configuration. Users 
who do not know the password can view server information but 
cannot change array configuration. The network administrator can 
disable the Guest Access feature (see page 12-5) on a per-server basis 
to prevent users who do not know the password from even viewing 
server information.

The network administrator sets the initial password for each server 
and controls users’ access to passwords.
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Setting the Initial Password
When you install Adaptec CI/O Array Management Software on a 
server, you must initially set the password from the server console. 
You cannot set the password initially from a networked client. 
Remote users cannot perform any operations that require password 
authorization from a networked client until the password is set at 
the server console.

The password must be set initially for each server on which Adaptec 
CI/O Array Management Software is installed. You can use the 
same password for all servers, or you can use different passwords.

Follow these steps to set the initial Adaptec CI/O Array Manage-
ment Software password from the server console:

1 Run Adaptec CI/O Array Management Software on the con-
sole of the server whose password you want to set.

2 Select Server Administration from the View menu. Then select 
Change Password. The Change Password dialog box appears, 
as shown in Figure 12-1.

No Old Password is required, because none has yet been 
defined.

3 Type the new password in the New Password field.

Passwords are case sensitive and can be up to 16 characters 
long, including the characters A-Z, a-z, and 0-9. Spaces are not 
allowed. Long passwords with a mixture of numerals and let-
ters provide better security. Do not use obvious passwords like 

Figure 12-1. Change Password Dialog Box
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your name, the name of a family member, your birthday, your 
social security number, etc.

4 Type the new password again in the Confirm Password field.

5 Click OK to register the initial password.

Changing the Password
After the Adaptec CI/O Array Management Software password is 
initially set for a server, you can change it either from the server con-
sole or from a remote client connected to that server. You must know 
the current password in order to change the password. We recom-
mend that you change each server’s password regularly for better 
system security.

Follow these steps to change the Adaptec CI/O Array Management 
Software password:

1 If you are working on a networked client, open the Server 

View window by clicking the  button. Then select the 
icon of the server whose password you want to change.

2 Select Server Administration from the View menu. Then select 
Change Password. The Change Password dialog box appears, 
as shown in Figure 12-1.

3 Type the existing password in the Old Password field.

4 Type the new password in the New Password field.

Passwords are case sensitive and can be up to 16 characters 
long, including the characters A-Z, a-z, and 0-9. Spaces are not 
allowed. 

5 Type the new password again in the Confirm Password field.

6 Click OK to accept the new password.
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Setting Password Time-out Options
The Password Time-out options allow you to control the way in 
which users are prompted to enter the server’s Adaptec CI/O Array 
Management Software password when they issue commands to 
change a server’s array configuration. The Password Time-out 
options are set individually for each networked client.

Follow these steps to change the Password Time-out options:

1 Click the  button on the toolbar. The Preferences dialog 
box appears.

2 Select one of the three Password Time-out options listed on the 
right of the dialog box. Here is a description of the options:

– No Password Time-out: Requires you to enter the pass-
word only the first time (during each session) that you issue 
a command to change array configuration. This option pro-
vides somewhat less security than the others: if you leave 
your workstation unattended after entering the password, 
another person can issue commands from the workstation 
without being prompted for the password.

– Always Require Password: Requires you to re-enter the 
password every time you issue a command to change array 
configuration.

– Enter Password Time-out Interval: Requires you to re-
enter the password at the stated time-out interval, when-
ever you issue commands to change the array configura-
tion. For example, suppose that the time-out interval is 10 
minutes. You start the program at 9:00 and issue a com-
mand to create a new array on a server. You are prompted 
to enter the password before the command is accepted. 
After entering the password, you issue a command at 9:05 
to add spares to the spare pool; no password is required. At 
9:16 you issue a command to delete an array; since you are 
beyond the 10-minute interval, you are prompted again to 
enter the password before the command is executed.

3 Click OK to accept the password time-out change. You may be 
required to enter the password in order to confirm the change.
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Controlling Guest Access
The Guest Access feature lets the network administrator control 
who is allowed to view information about the server configuration. 
Guest Access is enabled or disabled for each individual server; this 
must be done from a networked client connected to the server. Here 
is how Guest Access works:

■ When Guest Access is Enabled (the default), users who do not 
know the Adaptec CI/O Array Management Software pass-
word can view server information from a networked client 
connected to that server but cannot issue commands to change 
the server configuration.

■ When Guest Access is Disabled, users who do not know the 
Adaptec CI/O Array Management Software password cannot 
view server information from a networked client or issue com-
mands to change the server configuration. However, users can 
still view event notifications generated by servers that are on 
that client’s server list. Users who know the password can 
view server information by double-clicking the server icon and 
entering the password.

Note: If you do know the server’s password you can perform 
array operations such as creating and deleting arrays from 
any networked client, regardless of whether Guest Access is 
enabled or disabled.

Follow these steps to enable or disable Guest Access:

1 On the networked client, open the Server View window by 

clicking the  button. Then select the icon of the server 
whose Guest Access setting you want to change.

2 Select Server Administration from the View menu. Then select 
Guest Access.

3 When the Enable/Disable Guest Access dialog box appears, 
select or deselect the Enable Guest Access check box.
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4 Click OK to enter the change. Enter the Adaptec CI/O Array 
Management Software password when you are prompted to 
do so.

The Guest Access setting is changed on the server.

❒
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13▼  ▼  ▼  ▼
Managing Arrays and 
Spares
This chapter explains what to do when you need to replace a failed 
drive, physically reconfigure the disks in your server, and perform 
other tasks.

Responding to a Critical Array
A fault-tolerant (RAID 1, RAID 0/1 or RAID 5) array enters Critical 
status if one disk in the array fails. The array continues to operate 
normally, but you may lose data if a second disk in the array fails 
before the array is reconstructed. (RAID 0/1 arrays can continue 
operating in Critical status even if two or more disks fail, as long as 
at least one disk in each mirrored pair remains operational.)

If a spare disk is available, the array management software will 
reconstruct the Critical array automatically. When the reconstruct is 
complete, the array returns to Fault-tolerant status. If no spare disk 
is available, you should respond immediately to minimize the possi-
bility of data loss. The most effective strategy is prevention: be sure 
that arrays are always protected by a spare pool or by dedicated 
spares!

In addition, you should monitor the status of arrays at all times with 
Adaptec CI/O Array Management Software to detect arrays whose 
status is Critical. You can monitor arrays effectively by enabling the 
popup event notification option so that a message appears on the 
screen whenever an array enters Critical status. You can also tell that 
Adaptec Array1000 Family Array Management Guide
Stock Number: 511468-00, Rev. A Page: 13-1
Print Spec Number: 496645-00
Current Date: 3/2/99 ECN Date: 4/29/97

13-1



Adaptec Array1000 Family Array Management Guide
an array is in critical status if its icon in the Storage Configuration 

window looks like this .

Follow these steps to return a Critical array to Fault-tolerant status:

1 Click the array icon  and observe the disk icons of the 
array members on the left of the screen. One of the icons 

should look like this , indicating that the disk has failed.

2 Click the  icon and then click the Operations button.

3 When the Drive Operations window appears, click the 

button to blink the drive light on the failed disk.

4 Observe which drive light is blinking. This is the disk that you 
need to replace. If no lights are blinking, this could mean one 
of the following:

a The disk is still connected but has failed so badly that it 
cannot respond to the Blink command. Try blinking the 
drive lights of the array disks that have not failed. You may 
be able to determine by a process of elimination which disk 
has failed.

b The disk has been removed or its power cord or SCSI cable 
has been disconnected.

If an array disk has been disconnected or removed but the 
server has not been rebooted, the icon for this disk will still 
appear in the Storage Configuration window. If you know 
that the disk was disconnected accidentally and has not 
actually failed, reconnect the drive and resume I/O to the 
array.

If the server has been rebooted since the disk was discon-
nected, the disk will not appear. To determine if a disk is 
“missing” from an array, double-click the array icon, and 
read the Status field at the top of the Array Information 
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dialog box. If this field says Missing member, a disk is miss-
ing from the array.

c The disk does not have an LED that indicates I/O activity.

5 If the array enclosure does not support hot swapping1, pause 
I/O to the array before you continue. (Skip this step if the array 
enclosure supports hot swapping.) 

6 Replace the failed disk with a good disk, or replace the missing 
disk. Be sure to complete this step before the pause period 
expires.

7 After I/O resumes automatically, select the icon of the new 
disk, and issue a Create a Spare command.

8 When the spare has been created, select the array icon and 
issue a Reconstruct command, if necessary (it is possible that 
the reconstruct will start automatically at this point).

When the reconstruct is completed the array is in Fault-tolerant sta-

tus again, and the array icon will look like this 

Responding to an Off-line Array
You can tell that an array is in off-line status if OFFLINE appears in 
the array status field in Adaptec CI/O Array Management Software 
for NetWare or if the icon in the Storage Configuration window 

looks like this: . There are several reasons for an array going 
off-line, as described below:

■ A second disk has failed in a RAID 5 array that was critical, or 
both disks of a mirrored pair have failed in a RAID 1 or 
RAID 0/1 array that was critical.

1 Hot swapping support means that the array enclosure electrically isolates the 
bad disk’s SCSI connector from the SCSI bus while the disk is being 
swapped to prevent data corruption. Data can still be transferred to and 
from the remaining good disks while the bad drive is replaced. Check with 
the manufacturer of the array enclosure if you are not sure whether it sup-
ports hot swapping.
13-3

Adaptec Array1000 Family Array Management Guide
Stock Number: 511468-00, Rev. A Page: 13-3
Print Spec Number: 496645-00
Current Date: 3/2/99 ECN Date: 4/29/97



Adaptec Array1000 Family Array Management Guide
If this happens, delete the off-line array, create a new array, and 
restore the data from your most recent backup. You cannot 
recover the array data if a second disk fails.

■ You were trying to replace a failed disk in a Critical RAID 1, 
RAID 0/1, or RAID 5 array, but you mistakenly pulled the 
wrong disk out of the array enclosure.

If this happens, reinsert the drive you mistakenly removed and 
issue the Reactivate Array command, which returns the array 
to Critical status. Then replace the correct disk, down the 
server, reboot, and reconstruct the array.

■ A cable to a good disk in a RAID 5 array accidentally became 
disconnected, and the array already had one failed drive; or a 
cable to a good drive in a RAID 1 or RAID 0/1 array acciden-
tally became disconnected, and the other disk of the mirrored 
pair had already failed.

If this happens, reconnect the cable, and use the Reactivate 
Array command to return the drive to Critical status. Then 
replace the failed disk and reconstruct the array.

Optimizing Array Performance
If your Adaptec Array1000 Family product has multiple channels, 
you may be able to achieve better sequential data access with the 
arrays if some array members are connected to each channel.

The array management software and drivers allow you to use disks 
of various sizes and makes in the same array. To achieve the best 
performance, however, we recommend that you use disks of the 
same capacity and same model in an array. (If you use drives of dif-
ferent sizes, the amount of capacity actually used on each disk will 
be equivalent to that of the smallest disk in the array: For example, if 
you use five 1-GByte drives and one 500-MByte drive, only 
500 MBytes on each disk will be used.)

You can also optimize array performance by selecting a RAID level 
for the array that best meets your needs for data reliability, 
read/write performance, and capacity utilization. See the following 
section for more information.
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Selecting a RAID Level for an Array

Note: See Appendix B, Understanding Arrays and RAID Tech-
nology, for more information on RAID technology and on 
the advantages and disadvantages of the various RAID 
levels.

The term RAID means Redundant Array of Independent Disks. An 
array is a grouping of disks that, by means of array management 
software, appears to the computer’s operating system as one large 
disk. Part of the storage capacity of most kinds of arrays contains 
redundant information about the user data on the array2. If an array 
disk fails, the contents of the disk can be regenerated on a new disk 
from the redundant information on the other array disks.

Compared with single disks, arrays can provide one or more of 
these desirable properties:

■ improved Read and Write performance by striping data across 
the disks in the array. This allows data to be read from or writ-
ten to two or more disks simultaneously.

■ improved data reliability by storing redundant data to regener-
ate a failed array disk, as described above. This is especially 
important for servers, where arrays are most often used to 
store large amounts of mission critical data.

■ improved capacity utilization by allowing you to manage a 
large number of disks as if they were one large disk. This 
makes it easier to back up data, create directories, etc.

All disks of an array (including spares) must be connected to the 
same Adaptec Array1000 Family product, though they can be con-
nected to different channels. You can create dedicated spare disks 
for each RAID 1, RAID 0/1, and RAID 5 array. You can also create a 
pool of spares that can be used by any RAID 1, RAID 0/1, or RAID 5 
array on the Adaptec Array1000 Family product.3

2 RAID 0 arrays, which do not store redundant data, are an exception to this 
definition.

3 A disk in a spare pool can only be used to replace a failed disk in an array 
if it is at least as large as the smallest disk in the array.
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The array management software and firmware support RAID 0, 
RAID 1, RAID 0/1, and RAID 5 arrays. The advantages, disadvan-
tages, and requirements of these RAID levels are as follows:

RAID 0 Arrays
Maximum Disks Allowed: 164

Minimum Disks Allowed: 15

In a RAID 0 array, data is distributed, or striped, across the disks in 
the array. The capacity of the array is approximately equal to the 
combined capacity of the physical disks. The I/O performance of a 
RAID 0 array is much better than that of a single physical disk 
because multiple reads and writes can be handled in parallel and 
because when large files are accessed the striped data is retrieved 
simultaneously from several disks.

RAID 0 arrays do not store redundant data and therefore are not 
true RAID applications. If one disk fails, the entire array fails and all 
data is lost. This means that the fault tolerance of a RAID 0 array is 
less than that of any single disk in the array. The term RAID 0 is 
widely used for these arrays, however, because they are conceptu-
ally similar to true RAID applications.

RAID 1 Arrays
Maximum Disks Allowed: 2
Minimum Disks Allowed: 2

RAID 1 arrays use a single pair of disks. They are called mirrored 
arrays because both disks in the pair contain the same data. When 
data is written to a RAID 1 array it is written to each disk in the pair. 
The read performance of a RAID 1 array can be much better than 
that of a single disk, while the write performance is slightly worse. 
Mirrored arrays are highly reliable because the data is still safe if one 
disk in the pair fails. They are more costly, however, because you 
only get one disk of actual storage capacity from the pair of disks.

4 The maximum would be 15 disks if the system has a single SCSI channel.
5 One-disk RAID 0 arrays are used only to control the virtual device order of 

single disks.
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RAID 0/1 Arrays
Maximum Disks Allowed: 16 (must be an even number)6

Minimum Disks Allowed: 4

RAID 0/1 disks use from two to eight pairs of disks. They are called 
mirrored arrays because both disks in each pair contain the same 
data. The read and write performance of a RAID 0/1 array is much 
better than that of a single physical disk. RAID 0/1 arrays are highly 
reliable; the array data remains safe so long as at least one disk of 
each mirrored pair is good. Thus, in a 12-disk RAID 0/1 array, the 
array could continue working with up to six failed disks if one disk 
in each pair is still good. Because of the mirrored arrangement, 
RAID 0/1 arrays require twice as many disks as the actual amount 
of storage space.

RAID 5 Arrays
Maximum Disks Allowed: 167

Minimum Disks Allowed: 3

RAID 5 arrays contain redundant information in the form of parity 
data, which is calculated block-by-block for all user data. The parity 
data is distributed across all the disks in the array and occupies the 
equivalent capacity of about one disk. User data is interspersed with 
this parity data. If one disk in the array fails, its data can be recon-
structed from the user data and parity data on the other disks. Two 
disks must fail before the entire array fails. The read performance of 
RAID 5 arrays is excellent and is comparable to that of a RAID 0 
array. Write performance is slower than that of a RAID 0 array, 
because new parity data must also be calculated and written when 
user data is written.

❒

6 The maximum would be 14 disks if the system has a single SCSI channel.
7 The maximum would be 15 disks if the system has a single SCSI channel.
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A▼  ▼  ▼  ▼
Configuration Settings
This appendix describes the configuration variables that control the 
appearance of the Adaptec CI/O Array Management Software user 
interface and the way in which array and system operations are car-
ried out. The variables controlling the user interface appearance are 
in the Windows NT registry. The other variables are defined in the 
iomgr.ini. and cioams.ini files

Many of the variables are configured for you once you install the 
software or start the program. If you are an advanced user and you 
want to customize your settings, you can edit the variables in the NT 
registry, or you can open iomgr.ini or cioams.ini in a text editor and 
manually make changes.
Adaptec Array1000 Family Array Management Guide
Stock Number: 511468-00, Rev. A Page: A-1
Print Spec Number: 496645-00
Current Date: 3/2/99 ECN Date: 4/29/97

A-1



Adaptec Array1000 Family Array Management Guide
iomgr.ini
The iomgr.ini file is located in the directory where the Adaptec CI/O 
Array Management Software is installed on your server. The section 
name, for example [ARRAYOPERATIONS], and the variables under 
each section are described below:

[ARRAYOPERATIONS]

RecreatePriority=
This variable specifies the priority of the automatic Re-create opera-
tion. Valid values are Low, Medium, or High. The default is Medium.

VerifyIfDirty=
This variable specifies whether you want to start the Verify opera-
tion if the array is dirty (meaning that the array was not shut down 
properly). Valid values are Yes or No. The default value is No.

DriverMonitoringFrequencyInSecs=
This variable specifies the maximum interval in seconds before 
Adaptec CI/O Array Management Software polls the driver. Any 
number of seconds can be specified; small values affect perfor-
mance, large values (greater than 10 seconds) affect responsiveness 
to problems. The default value is 5.

[SYSTEM]

PauseEnabled=
This variable specifies whether the Pause I/O capability is enabled 
or disabled. Valid values are Yes and No.

ServerLogSizeInMegabytes=
This variable is used to limit the size of the Server Log database file. 
The Server Log database will be truncated if it grows beyond the 
size specified by the parameter. The size can be specified in incre-
ments of 1 MByte, up to a maximum of 10 MBytes.

StatisticsCollectionInterval=
This variable specifies the interval at which system statistics will be 
collected, assuming that the driver supports statistics collection. Val-
ues must be entered as whole numbers. The default value is 1.

WarnAfterFirstPFAEvent=
If set to Yes, this variable specifies that if SMART events (PFA) are 
received from any drive the first event will be reported as a Critical 
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event and all events after that will be reported as Warning events. If 
set to No, all SMART events will be reported as Critical. The default 
is Yes.

[TASKS]

TestAllSpares=
This variable schedules the Test All Spares operation. These jobs are 
not written to the Scheduler Database and are scheduled every time 
iomgr.nlm (NetWare) or iomgr.exe (Windows NT) is started. Valid 
values are 

■ Yes,H—Starts test every hour on the hour. For example, 
TestAllSpares=Yes,H

■ Yes,D,Time—Starts test daily at a specified time (military time 
format). For example, TestAllSpares=Yes,D,11:34. (The default 
value is to test all spares daily at 2:00 A.M.)

■ Yes,W,Day of the week,Time—Starts test weekly at a specified 
day and time (Day of the week: 0=Sun, 1=Mon, 2=Tues., etc.). 
For example, TestAllSpares=Yes,W,2,11:34 (starts every week 
on Tuesday at 11:34).

■ No—No tests are scheduled. For example, TestAllSpares=No.

[CAPABILITIES]

EnableRAID5=
This variable enables or disables the option of creating RAID 5 
arrays. If it is set to No users cannot create RAID 5 arrays. Valid val-
ues are Yes and No. The default is Yes.

EnableRAID10=
This variable enables or disables the option of creating RAID 0/1 
arrays. If it is set to No users cannot create RAID 0/1 arrays. Valid 
values are Yes and No. The default is Yes.
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cioams.ini
The cioams.ini file is located in the directory where the Adaptec CI/O 
Array Management Software is installed on your client. The section 
name, for example [CORE], and the variables under each section are 
described below:

[CORE]

ConfigPath=
This variable specifies the default path name for the server 
configuration file. (The configuration file keeps a record of the 
server information.) For example, ConfigPath=configs.dat.

[VIEW]

ServerView=
This variable specifies whether the Server View window is dis-
played when the program starts. Valid values are 0 (is not displayed) 
and 1 (is displayed). If this variable is not specified, the default is 0.

[PROTOCOL]

IP=
If set to 1, Adaptec CI/O Array Management Software will attempt 
to load IP protocol when the program starts.

IPX=
If set to 1, Adaptec CI/O Array Management Software will attempt 
to load IPX protocol when the program starts.

[RPC ICONS]

Visibility=
Set this variable to Visibility=Hide to hide the RPC services icons 
when running Adaptec CI/O Array Management Software on a net-
worked client.

[HEARTBEAT]

Interval=
This variable indicates the frequency, in seconds, at which the net-
worked client attempts to connect to the server to get updated infor-
mation. The default is 10.
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Windows NT User Interface Variables
The Adaptec CI/O Array Management Software user interface vari-
ables are located in the Windows NT registry under 
HKEY_LOCAL_MACHINE\SOFTWARE\Adaptec\Adaptec CI/O 
Array Management Software. These variables apply only to the server 
console version of Adaptec CI/O Array Management Software, not to 
the networked client installations:

■ Config Path: REG_SZ: configs.dat
This is the storage path for the configuration file.

■ Display Activity: REG_DWORD: 0
If the value is non-zero, the application will display the Activ-
ity Monitor window on startup.

■ Display Config: REG_DWORD: 0x2
If the value is non-zero, the application will display the Storage 
Configuration window on startup.

■ Display Server Log: REG_DWORD: 0
If the value is non-zero, the application will display the His-
toric Event Log window on startup.

■ Display Server View: REG_DWORD: 0
If the value is non-zero, the application will display the Server 
View window on startup. (This is not applicable to the desktop 
version of Adaptec CI/O Array Management Software.)

■ End Date: REG_SZ: 12/31/1999

■ End Time: REG_SZ: 23:59:59

■ Notifications: REG_DWORD: 0
Popup Box is 0x1, Beep is 0x2, Flash Titlebar is 0x4, and None 
is 0x0. These values may be OR’ed together.

■ Server Name: REG_SZ: 

■ Severity: REG_DWORD: 0xd
Informational is 0x1, Warning is 0x4, and Critical is 0x8. These 
values may be OR’ed together.

■ Start Date: REG_SZ: 1/1/1990

■ Start Time: REG_SZ: 00:00:00

❒
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B▼  ▼  ▼  ▼
Understanding Arrays and 
RAID Technology
What Is an Array?
An array is defined as two or more disks grouped together to appear as a 
single device to the host system. Figure Figure B-1 illustrates this 
concept.

In common usage, the term “array” implies the use of some form of 
redundancy to increase overall data availability, data integrity, and 

Figure B-1. What Is an Array?
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performance. There are several different RAID “levels” or redun-
dancy schemes; each one has characteristics that make it suited to a 
specific set of applications or network requirements.

Understanding RAID

What is RAID Technology?
RAID technology was first defined by a group of computer scientists 
at the University of California at Berkeley in 1987. The scientists 
studied the possibility of using two or more disks to appear as a sin-
gle device to the host system.

Although the array’s performance was better than that of large, sin-
gle-disk storage systems, reliability was unacceptably low. To 
address this, the scientists proposed redundant architectures to pro-
vide ways of achieving storage fault tolerance. In addition to defin-
ing RAID Levels 1 through 5, the scientists also studied data 
striping—a non-redundant array configuration that distributes files 
across multiple disks in an array. Often known as RAID 0, this con-
figuration actually provides no data protection. However, it does 
offer maximum throughput for some data-intensive applications 
such as desktop digital video production.

No individual RAID level is inherently superior to any other. Each 
of the five array architectures is well-suited for certain types of 
applications and computing environments. For client/server appli-
cations, storage systems based on RAID levels 1, 0/1, and 5 have 
been the most widely used. This is because popular Network Oper-
ating Systems (NOSs) such as Windows NT Server and NetWare 
manage data in ways similar to how these architectures perform.
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The table on page B-19 compares the relative strengths and weak-
nesses of each RAID level. Figure B-2 illustrates the most popular 
RAID levels.

DRIVE 1
DRIVE 2

Figure B-2. Popular RAID Levels
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RAID 0 —Data Striping; 
minimum of 2 drives; no 
data protection

RAID 0/1 —Data Striping 
and Mirroring; minimum of 4 
drives

RAID 5 —Data Striping with 
Distributed Parity; minimum 
of 3 drives

Standard
Host Adapter

Standard
Host Adapter

Standard
Host Adapter

Mirroring

Duplexing

RAID 1 —Mirroring and 
Duplexing; minimum of 2 
drives
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What Does RAID Provide?
RAID technology does not prevent drive failures. However, RAID 
does provide insurance against business-crippling drive failures by 
enabling real-time data recovery without data loss.

The fault tolerance of arrays can also be significantly enhanced by 
choosing the right storage enclosure. Enclosures that feature redun-
dant, hot-swappable power supplies and fans can greatly increase 
storage system uptime based on a number of widely accepted mea-
sures—Mean Time to Data Loss (MTDL), Mean Time of Data Avail-
ability (MTDA), Mean Time to Repair (MTTR), and Mean Time 
Between Failure (MTBF). For brief definitions of these terms, please 
refer to the Glossary of RAID Terms on page B-12.
B-4

Adaptec Array1000 Family Array Management Guide
Stock Number: 511468-00, Rev. A Page: B-4
Print Spec Number: 496645-00
Current Date: 3/2/99 ECN Date: 4/29/97
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Types of Arrays
There are three primary array implementations, as shown in 
Figure B-3: software-based arrays, bus-based array adapters/con-
trollers, and subsystem-based external array controllers.

Software-based Array

Host CPURunningRAID Software

Standard
Host Adapter

Bus-based Array Adapter/Controller

Figure B-3. Array Types

External Array Controller

Standard
Host Adapter
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As with the various RAID levels, no one implementation is clearly 
better than another—although software-based arrays are rapidly 
losing favor as high-performance, low-cost array adapters become 
increasingly available. Each array solution meets different server 
and network requirements, depending on the number of users, 
types of applications, and storage requirements.

All RAID code is based on software. The difference among the solu-
tions is where the software code is executed—on the host CPU 
(software-based arrays) or offloaded to an onboard processor (bus-
based and external array controllers).

Software-Based Arrays

Primarily used with entry-level servers, software-based arrays rely 
on a standard host adapter and execute all I/O commands and 
mathematically intensive RAID algorithms in the host server CPU. 
This can slow system performance by increasing host PCI bus traffic, 
CPU utilization, and CPU interrupts. Some NOSs such as NetWare 
and Windows NT include one or more of the following embedded 
RAID level software: RAID 0, RAID 1 (mirroring), or RAID 5. The 
chief advantage of this embedded RAID software has been its lower 
cost compared to higher-priced RAID alternatives. However, this 
advantage is disappearing with the advent of lower-cost, bus-based 
array adapters such as the AAA-130 series and the ARO-1130 RAID-
port card from Adaptec.

Bus-Based Array Adapters/Controllers

Unlike software-based arrays, bus-based array adapters/controllers 
plug into a host bus slot (typically a 133-MBytes/sec. PCI bus) and 
offload some or all of the I/O commands and RAID operations to 
one or more secondary processors. Originally used only with mid- 
to high-end servers due to cost, lower-cost bus-based array adapters 
(such as the AAA-130 series adapters from Adaptec) are now avail-
able specifically for entry-level server network applications.

In addition to offering the fault-tolerant benefits of RAID, bus-based 
array adapters/controllers perform connectivity functions that are 
similar to standard host adapters. By residing directly on a host PCI 
bus, they provide the highest performance of all array types. Bus-
based arrays also deliver more robust fault-tolerant features than 
embedded NOS RAID software.
B-6

Adaptec Array1000 Family Array Management Guide
Stock Number: 511468-00, Rev. A Page: B-6
Print Spec Number: 496645-00
Current Date: 3/2/99 ECN Date: 4/29/97



Understanding Arrays and RAID Technology
As newer, high-end technologies such as Fibre Channel become 
readily available, the performance advantage of bus-based arrays 
compared to external array controller solutions may diminish.

External Array Controllers (or “Bridge Controllers”)

Intelligent external array controllers “bridge” between a servers’ 
I/O interfaces and one or more device channels. These controllers 
feature an onboard microprocessor that provides high performance 
and handles functions such as executing RAID software code and 
supporting data caching.

External array controllers—such as the AEC-4312A and AEC-7312A 
array controllers from Adaptec—offer complete operating system 
independence, the highest availability, and the ability to scale stor-
age to extraordinarily large capacities (up to a terabyte and beyond). 
These controllers are usually installed in networks of Intel-based 
and UNIX servers and in high-performance clustered environments.

Is Duplexing Effective?
Duplexing—which eliminates the host adapter as a single point of 
failure—is one of the most popular methods for increasing fault tol-
erance under RAID 1 (mirroring). Used exclusively with low-perfor-
mance, software-based RAID solutions, duplexing host adapters 
alone unfortunately offers no protection against the failure of other 
server or storage system components. For example, the failure of 
power supplies and fans, which have relatively low MTBF ratings, 
can bring down a system more often than a host adapter failure.

Basics of Simple Parity
The concept behind RAID is relatively simple. The fundamental 
premise is the ability to recover data on-line in the event of a disk 
failure by using a form of redundancy called parity. In its simplest 
form, parity is an addition of all the drives used in an array. Recov-
ery from a drive failure is achieved by reading the remaining good 
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data and checking it against parity data stored by the array, as 
shown in Figure B-4.

Parity is used by RAID levels 2, 3, 4, and 5. RAID 1 does not use par-
ity because all data is completely duplicated (mirrored). RAID 0, 
which is used only to increase performance, offers no data redun-
dancy at all.

Building an Array Storage Subsystem
Adaptec array adapters and controllers are the cornerstones of a 
fault-tolerant storage solution. But building a complete subsystem 
requires additional hardware components that can greatly enhance 
the reliability and data availability of an array. These components 
include the storage enclosure, drives, terminators, and cables.

X

Figure B-4. Parity Calculation
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Storage Enclosures
To create an array solution, users can choose from two types of stor-
age enclosures: internal or external, as shown in Figure B-5.

Many entry-level, PCI-based servers now include internal hot-
swappable drives for array applications. Both the Adaptec AAA-130 
series and the OEM-offered ARO-1130 RAIDport card are well-
suited for these types of servers. (Visit the Adaptec Web site at 
www:adaptec.com/RAID to view a list of ARO-1130 PCI RAIDport card 
OEMs.)

The second option is to buy an external array enclosure1 and add 
drives. When choosing the enclosure, it is important to balance cost 
with the need for storage system reliability. Various features found 
in array enclosures—such as redundant, hot-swappable power sup-
plies and fans—can dramatically improve data availability, data 
integrity, and system serviceability.

1 For a list of array enclosure manufacturers, see Appendix E of the AAA-130 
Series Installation and Hardware Guide or the ARO-1130 PCI RAIDport Card 
Installation and Hardware Guide.

Figure B-5. Array Enclosure Types

An internal (within the server) RAID 
solution usually incorporates removable 
drives to provide an inexpensive, com-
pact, real-time data recovery storage 
system.

In addition to increased storage capacity, 
an external RAID solution may provide non-
stop features beyond the server’s capabili-
ties, such as redundant power and cooling 
systems.
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Array enclosures also differ in the way they allow drive replace-
ment. Many server and storage manufacturers claim to have array 
storage systems with removable, hot-swap drive bays. Over the past 
few years, the term “hot swap” has been applied to everything from 
being able to replace a drive while on-line and under load to simply 
permitting the system power to remain on when adding or remov-
ing a drive. The latter feature is more correctly referred to as “warm 
swap.”

For true on-line, under-load, hot-swap functionality, users should 
select a server or an array enclosure that has a SCSI backplane 
printed circuit board (PCB) or connector on the drive tray with 
power and ground pins that are longer than the data pins. This 
design ensures that power will always be disconnected after the data 
pins are removed from the SCSI bus and vice-versa. The result is 
that no power spike “glitches” can occur on the active SCSI bus, 
thereby avoiding data corruption or loss. For “warm-swap” enclo-
sures, network managers must see to it that all activity on the SCSI 
bus has ceased before replacing a drive. To verify whether a particular 
server or storage enclosure offers hot-swap support, check with the manu-
facturer.

Any Adaptec AAA-130 series adapter, ARO-1130 RAIDport card, 
AEC-4312A controller, or AEC-7312A controller will provide an 
effective array solution when choosing an external storage sub-
system. With a warm-swap enclosure, Adaptec’s CI/O Array Man-
agement software gives network managers the added flexibility of 
pausing activity on the SCSI bus during drive replacement, without 
affecting the NOS.

Disk Drives
The choice of disk drives can greatly impact the overall performance 
and capacity of array storage. Drives with relatively high MTBFs 
and high RPM speeds will fail less often and provide better perfor-
mance than inferior drives. Keep in mind that mixing drives of dif-
ferent storage capacities will limit the capacity of all drives in the 
array to that of the lowest-capacity drive. This ensures that there is 
disk space available for parity information on all stored data.1

1 For a list of popular disk drive manufacturers, see Appendix E of the 
AAA-130 Series Installation and Hardware Guide or the ARO-1130 PCI 
RAIDport Card Installation and Hardware Guide.
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In addition, disk drives equipped with Self-Monitoring, Analysis 
and Reporting Technology (S.M.A.R.T.) can be set up to report pre-
dicted failures, giving network managers the opportunity to activate 
a spare drive before problems arise.

Adaptec array adapters and controllers support mixing of different 
capacity drives within the same array. However, Adaptec strongly 
recommends using drives with similar spindle speeds and capacities 
to achieve maximum performance and capacity.

Termination and Cabling
Proper termination and high-quality cables should always be used 
with SCSI devices, particularly when building an array storage sub-
system. When implementing Fast, Wide, or UltraSCSI technology, it 
is a good idea to use active terminators and impedance-matched 
cables to avoid signal reflections and data corruption. In addition, 
the maximum cable lengths outlined in the SCSI specification 
should be strictly followed.

Termination must be at the end of the cable or on the storage enclo-
sure’s backplane, not at the device. External array enclosures typi-
cally require an external active terminator that attaches to the SCSI 
connector on the back of the enclosure.1

Both the AAA-130 series of array adapters and AEC-4312A2 and 
AEC-7312A2 array controllers are available in kits that include high-
quality cabling and active termination.

1 For a list of SCSI cable kits available from Adaptec, see Appendix D of the 
AAA-130 Series Installation and Hardware Guide or the ARO-1130 PCI 
RAIDport Card Installation and Hardware Guide.

2 Kits available in subsequent releases.
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Glossary of RAID Terms
AAA
Adaptec Array Adapter. For example, the AAA-130 Array Adapter 
series.

AEC
Adaptec External Controller. For example, the AEC-4312A and 
AEC-7312A external array controllers.

ARO
Adaptec RAID Option. For example, the ARO-1130 RAIDport card.

Array
Two or more disks grouped together to appear as a single disk to the 
host system.

Array adapter
A bus-based (usually PCI) hardware device—such as an add-in 
card, group of motherboard ASICs, or a combination of both—that 
converts the timing and protocol of a host’s memory bus and an I/O 
bus. Usually used in entry-level servers, an array adapter also 
includes an on-board RAID co-processor to offload most of the 
RAID operations—for example, secondary RAID 1 writes and 
RAID 5 parity calculations—from the host CPU. This is in contrast to 
the microprocessor-based array controllers used in midrange and 
high-end servers, which also offload I/O commands. Array adapt-
ers improve performance over software RAID solutions embedded 
within network operating systems such as NetWare and 
Windows NT. These adapters provide the same connectivity func-
tions as a standard host adapter.

Bootable array
Allows a server to boot from the array while protecting the network 
operating system files—and other data on the array—from drive 
failure.

CI/O
Comprehensive Input/Output. Refers to Adaptec’s CI/O Array 
Management Software.

Clustering
The concept of using independent computer systems working 
together as a single logical system. Clustering is usually imple-
mented to address both availability and scalability.
B-12

Adaptec Array1000 Family Array Management Guide
Stock Number: 511468-00, Rev. A Page: B-12
Print Spec Number: 496645-00
Current Date: 3/2/99 ECN Date: 4/29/97



Understanding Arrays and RAID Technology
Cold swap
Power must be switched off before the removal or insertion of a 
component.

Disk array
See Array.

Disk/data striping
Spreading data evenly over multiple disks to enhance performance. 
Sometimes referred to as RAID 0, data striping actually has no 
redundancy scheme and, therefore, does not provide any fault toler-
ance (data protection).

Downtime
A period of time during which a network cannot be used due to 
equipment failure or another cause.

Drive
Synonym for hard drive, hard disk, disk, disk drive.

Duplexing
Mirroring across two host adapters. Used only with software-based 
RAID storage systems (usually the embedded network operating 
system RAID software such as NetWare and Windows NT).

Embedded SCSI ASIC (host adapter)
An integrated circuit that is attached directly to the host mother-
board and performs the same functions as a standard add-in host 
adapter. (See Host Adapter.)

Exclusive OR (XOR)
A process based on a mathematical algorithm that is used by RAID 
levels 2, 3, 4, and 5 to compare computer data (binary 0s and 1s) cre-
ated by a write or read request during a drive failure. The result of 
the XOR process is parity information that will be stored along with 
data for real-time data recovery in the event of a disk failure.

External array controller
In contrast to bus-based array adapters and microprocessor-based 
array controllers, external array controllers reside in the external 
RAID storage enclosure. They connect to the host through a stan-
dard SCSI or serial (such as Fibre Channel) host adapter. These 
external controllers are similar to bus-based, microprocessor-based 
array controllers in that they include an on-board microprocessor to 
offload all RAID functions (I/O commands and RAID operations) 
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from the host CPU. They are usually used in midrange and high-end 
servers—especially in clustering environments.

Failed-drive mode
A mode of reduced-performance operation that a disk array is in 
after a drive failure.

Fault tolerance
The ability of a system to continue to perform its functions, even 
when one or more components have failed.

Fibre Channel
A high-speed, serial interface capable of supporting data I/O rates 
of up to 100 MBytes/sec.

Host adapter
A bus-based (PCI, EISA, ISA) hardware device, such as an add-in 
card or ASIC, that converts the timing and protocol of a host’s mem-
ory bus and an I/O bus. Also see Embedded SCSI ASIC and array 
adapter.

Hot spare
RAID storage feature that allows a spare drive (or other component) 
to be configured for automatic (in contrast to hot-swap) replacement 
and reconstruction in the event of a disk failure. Users can remain 
on-line and continue to access data. See also Hot swap and Warm swap.

Hot swap
A storage system’s ability to allow the removal and replacement of a 
disk drive (or other component) while users are on-line and access-
ing data. In contrast to hot-spare, this is a manual operation. Hot 
swap requires that the storage (or server) enclosure drive tray con-
nectors be designed so that when a drive is removed, power is dis-
connected before the ground connection, and that the ground is 
restored before the power is reconnected when the drive is rein-
serted. This is usually accomplished by making the ground pin(s) in 
the drive tray connector slightly longer than the data pins. See also 
Hot spare and Warm swap.

I/O
Input/output. Refers to network user data requests and host over-
head such as swapping and file system activity.
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JBOD
Just a bunch of drives. Refers to an array of drives without data 
redundancy.

MTBF
Mean time between failure. Used to measure computer component 
average reliability/life expectancy. MTBF is not as well-suited for 
measuring the reliability of array storage systems as MTDL, MTTR 
or MTDA because it does not account for an array’s ability to 
recover from a drive failure. In addition, enhanced enclosure envi-
ronments used with arrays to increase uptime can further limit the 
applicability of MTBF ratings for array solutions.

MTDA
Mean time between data access (or availability). The average time 
before non-redundant components fail, causing data inaccessibility 
without loss or corruption.

MTDL
Mean time to data loss. The average time before the failure of an 
array component causes data to be lost or corrupted.

MTTR
Mean time to repair. The average time required to bring an array 
storage subsystem back to full fault-tolerance.

Member (disk)
A disk that is in use as a member of a disk array.

Microprocessor-based array controller
In contrast to an array adapter, a microprocessor-based array con-
troller includes an onboard microprocessor (for example, an Intel 
i960) to offload I/O commands and RAID operations from the host 
CPU. Usually used in midrange and high-end servers. See also Array 
adapters.

Mirroring
Also known as RAID 1, or duplexing (when using two host bus 
adapters). Full redundancy is obtained by duplicating all data from 
a primary disk on a secondary disk. The overhead of requiring 100 
percent data duplication becomes costly when more than two drives 
are used.
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NOS
Network Operating System. For example, NetWare, Windows NT 
Server, OS/2, SCO, and UnixWare.

PCI - Peripheral Component Interconnect
An industry-standard specification that refers to a high-speed 
(133 MBytes/sec.) host bus commonly used for host adapters, Ether-
net adapters, and video cards.

Parity
A form of data redundancy used by RAID levels 2, 3, 4, and 5 to rec-
reate the data of a failed drive in a disk array.

RAID
Redundant Array of Inexpensive (or “Independent”) Disks. The 
term coined in 1987 by researchers at the University of California at 
Berkeley to describe a series of redundant architectures used in 
fault-tolerant disk arrays.

RAID Advisory Board (RAB)
Industry organization of manufacturers and users of disk systems 
and related products whose mission is to educate users regarding all 
aspects of storage technology, and in particular, RAID technology.

RAID levels

Numbered 0 through 5, RAID levels refer to different array architec-
tures that offer various advantages in terms of data availability, cost, 
and performance.

Redundant
A duplicate disk or component that provides a recovery path in case 
of a failure.

SCSI
(Pronounced scuzzy) Small computer system interface. The fast, 
intelligent, input/output parallel bus used by high-performance 
peripheral devices.

SIMM
Single in-line memory module.

SLED
Single Large Expensive Disk. Refers to older mainframe hard disks 
that were used as a basis for comparison during the initial UC Ber-
keley RAID studies.
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S.M.A.R.T.
Self-Monitoring, Analysis and Reporting Technology. Drives 
equipped with this feature report predicted failures based on thresh-
old values determined by the manufacturer. This allows the network 
manager to replace a drive before it fails.

Software-based arrays
An array in which all management functions including mathemati-
cally intensive parity calculation (XOR) are performed by the host 
server CPU. These products are low-priced but have high CPU utili-
zation and limited fault-tolerant features. High-performance, low-
cost array adapters (such as the AAA-130 series and the ARO-1130 
RAIDport card) are quickly replacing these inferior software-based 
arrays.

System disk
The disk (or array) on which a system’s operating system is stored 
and from which it is initially loaded into system memory. (See also 
Bootable array.)

Usable storage capacity
Disk array capacity that is usable for data storage (as opposed to for 
mirroring or parity data). For example, in a mirrored (RAID 1 and 
0/1) array, usable storage remains a constant fifty percent (half of 
storage is always used for redundancy). This is in contrast to other 
RAID levels such as RAID 5, in which usable storage capacity is 
determined by the formula of “n-1” (where “n” is the total number 
of disk drives and “1” is the single disk’s worth of capacity used for 
parity, or redundancy overhead). So, as the number of disks in the 
array grows, the usable storage capacity percentage increases in 
relation to redundancy (parity) information.

Warm swap
The ability to remove and replace a disk drive while the power is on. 
All bus activity must be paused (usually done through a utility 
within the array management software) to maintain data integrity 
during removal or replacement. Typically used when hot swap is 
not supported by the server or storage enclosure drive tray. (See also 
Hot spare and Hot swap.)
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RAID Level Comparison
Each RAID level has inherent cost, performance, and availability 
(fault-tolerance) characteristics designed to meet different storage 
needs. Most RAID levels can effectively satisfy only one or two of 
these criteria. For example, RAID 0/1 offers the highest performance 
and availability but also has the highest implementation cost. How-
ever, RAID 5 is the exception, providing the best overall balance of 
cost, performance, and availability for most servers.

The table on the next page shows the relative advantages and disad-
vantages of each RAID level.
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❒

RAID Level Comparison

RAID Level
Minimum #
of Drives Description Strengths Weaknesses

RAID 0 2 Data striping with-
out redundancy

Highest performance No data protection

RAID 1 2 Disk mirroring Very high perfor-
mance; Very high data 
protection; Very mini-
mal penalty on write 
performance

High redundancy cost 
overhead; Because all 
data is duplicated, 
twice the storage 
capacity is required

RAID 2 Not used in LAN 
environments

No practical use Previously used for 
RAM error correction 
(known as Hamming 
code) and in disk drives 
before the use of 
embedded error cor-
rection

No practical use; Same 
performance can be 
achieved by RAID 3 at 
lower cost

RAID 3 3 Byte-level data 
striping with dedi-
cated parity drive

Excellent performance 
for large, sequential 
data requests

Not well-suited for 
transaction-oriented 
network applications; 
Single parity drive does 
not support multiple, 
simultaneous read and 
write requests

RAID 4 3 (not widely 
used)

Block-level data 
striping with dedi-
cated parity drive

Data striping supports 
multiple simultaneous 
read requests

Write requests suffer 
from same single par-
ity-drive bottleneck as 
RAID 3; RAID 5 offers 
equal data protection 
and better performance 
at same cost

RAID 5 3 Block-level data 
striping with dis-
tributed parity

Best cost/performance 
for transaction-ori-
ented networks; Very 
high performance, very 
high data protection; 
Supports multiple 
simultaneous reads 
and writes; Can also be 
optimized for large, 
sequential requests

Write performance is 
slower than RAID 0 or 
RAID 1

RAID 0/1 4 Combination of 
RAID 0 (data 
striping) and 
RAID 1 (mirror-
ing)

Highest performance; 
Highest data protec-
tion (can tolerate multi-
ple drive failures)

High redundancy cost 
overhead; Because all 
data is duplicated, 
twice the storage 
capacity is required; 
Requires minimum of 
four drives
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▼  ▼  ▼  ▼    Index
(AC) = task done in ArrayConfig
(NW) = task done in NetWare version of 
CI/O Array Management Software
(NT) = task done in Windows version of 
CI/O Array Management Software

A
Aborting a running activity 

(NT) 11-4
Aborting a running activity 

(NW) 6-5
Activity

aborting (NW) 6-5
changing priority of (NW) 6-6
deleting (NW) 6-5
monitoring (NT) 11-5
monitoring (NW) 6-7
scheduling (NT) 11-1
scheduling (NW) 6-2
viewing activity queue (NT) 11-3
viewing activity queue (NW) 6-4

Adaptec CI/O Array Management 
Software
overview of 1-2
overview of NetWare version 1-2
overview of Windows client 

version 1-2
overview of Windows NT server 

version 1-2
tips for using 1-3
see also CI/O Software

Adding a dedicated spare (AC) 2-10
Adding a dedicated spare (NT) 8-15
Adding a dedicated spare 

(NW) 3-16

Adding a new server address 7-1
Advanced array options

restoring defaults (NT) 8-10
setting (NT) 8-9

Advisories 1-4
arconfig

see ArrayConfig
Array

blinking drive lights (NT) 10-8
blinking drive lights (NW) 5-5
bootable, creating (NT) 8-10
bootable, creating (NW) 3-7
booting from (AC) 2-2
creating (AC) 2-2–2-5
creating (NT) 8-4–8-9
creating (NW) 3-3–3-7
critical status 13-1
deleting (AC) 2-6
deleting (NT) 8-11
deleting (NW) 3-9–3-10
initializing (NT) 8-13
initializing (NW) 3-10–3-12
off-line status 13-3
optimizing performance 13-4
pausing I/O to (NT) 10-5
pausing I/O to (NW) 5-3
reactivating when off-line 

(NT) 10-9
reactivating when off-line 

(NW) 5-7
reconstructing (NT) 10-2
reconstructing (NW) 5-1
renaming (NT) 10-9
renaming (NW) 5-7
setting advanced options 

(NT) 8-9
Index-1
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size of disks 13-4
status of 4-4
verifying (NT) 10-6
verifying (NW) 5-4
viewing information for (AC) 2-6
viewing information for (NT) 9-3

Array performance
optimizing 13-4

ArrayConfig
creating an array 2-2
deleting an array 2-6
displaying array information 2-6
overview of 1-2

B
Blinking array drive lights 

(NT) 10-8
Blinking array drive lights (NW) 5-5
Blinking device drive lights 

(NT) 10-14
Blinking device drive lights 

(NW) 5-13
Blinking spare drive lights 

(NT) 10-13
Boot order, changing (AC) 2-5
Bootable array

creating (AC) 2-5
creating (NT) 8-10
creating (NW) 3-7

C
Changing an activity’s priority 

(NT) 11-4
Changing an activity’s priority 

(NW) 6-6
Changing filter options (NT) 7-9
Channel information

viewing (NT) 9-7
viewing (NW) 4-6

Choosing notification settings 7-10
CI/O software

exiting from (NW) 3-2

starting (NT) 8-2
starting (NW) 3-1

Configuration file A-4
Controller information

viewing (NT) 9-6
viewing (NW) 4-6

Conventions, formatting 1-4
Creating a boot array (AC) 2-5
Creating a boot array (NT) 8-10
Creating a boot array (NW) 3-7
Creating a spare pool (NW) 3-13
Creating an Array (AC) 2-2
Creating an array (NT) 8-4–8-9
Creating an array (NW) 3-3–3-7
Critical status

responding to 13-1

D
Dedicated spare

adding (AC) 2-10
adding (NT) 8-14
adding (NW) 3-16
defined 2-8
deleting (AC) 2-11
deleting (NT) 8-17
deleting (NW) 3-17

Deleting a dedicated spare 
(AC) 2-11

Deleting a dedicated spare 
(NT) 3-17

Deleting a dedicated spare 
(NW) 3-17

Deleting a scheduled activity 
(NT) 11-4

Deleting a scheduled activity 
(NW) 6-5

Deleting a server address 7-6
Deleting a spare pool disk (AC) 2-10
Deleting a spare pool disk (NT) 3-14
Deleting a spare pool disk 

(NW) 3-14
Deleting an array (AC) 2-6
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Index
Deleting an array (NT) 8-11
Deleting an array (NW) 3-9–3-10
Device icons 9-1
Disk

downing (NT) 10-15
downing (NW) 5-11

Downing a disk drive (NT) 10-15
Downing a disk drive (NW) 5-11
Drive

see disk
Drive light

blinking for array (NT) 10-8
blinking for array (NW) 5-5
blinking for device (NT) 10-14
blinking for device(NW) 5-13
blinking for spare (NT) 10-13

E
Editing the permanent list 7-15
Entering and viewing options 

settings 7-14
Event log

viewing (NW) 4-1
Event notifications

setting options for (NT) 7-14
severity levels 4-2, 7-13

F
Filter options, changing (NT) 7-9
first virtual device 3-7, 8-10
Forcing a spare (NT) 10-10
Forcing a spare (NW) 5-8

G
Guest access (NT) 12-5
gui.ini A-4

H
Hot swapping 10-3

I
.ini files A-1
Icons 9-1
Initializing an array (AC) 2-7
Initializing an array (NT) 8-13
Initializing an array (NW) 3-10–3-12
iomgr.ini A-2
IP/IPX protocol 7-2

L
Low-level formatting

advantages and 
disadvantages 2-7

M
Monitoring an activity (NT) 11-3
Monitoring an activity (NW) 6-7

O
Off-line array

reactivating (NW) 5-7, 10-9
Off-line status, responding to 13-3
Optimizing array performance 13-4

P
Parity

verifying for array (NT) 10-6
verifying for array (NW) 5-4

Partitions, checking for 8-6
Password 12-1

changing (NT) 12-3
guest access (NT) 12-5
setting (NT) 12-2
setting (NW) 5-13
time-out options (NT) 12-4

Pausing/Resuming I/O
to a device (NW) 5-12
to a device (NT) 10-16
to an array (NT) 10-5
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to an array (NW) 5-3
Permanent list, editing 7-15
Polling the driver A-2
Preferences dialog box (NT) 7-14

R
RAID 0 13-6
RAID 0/1 13-7
RAID 1 13-6
RAID 5 13-7
RAID Activity Monitor (NT) 11-3
RAID level

RAID 0 13-6
RAID 0/1 13-7
RAID 1 13-6
RAID 5 13-7
selecting 13-5

Reactivating an off-line array 
(NT) 10-9

Reactivating an off-line array 
(NW) 5-7

Reconstructing an array (NT) 10-2
Reconstructing an array (NW) 5-1
Recreate operation A-2
Remote access password (NW) 5-13
Renaming an array (NT) 10-9
Renaming an array (NW) 5-7
Rescanning the server (NT) 9-9
Rescanning the server (NW) 4-8
Running activity

aborting (NT) 11-4
aborting (NW) 6-5
changing priority of (NW) 6-6
monitoring (NT) 11-5
monitoring (NW) 6-7

S
S.M.A.R.T. 5-11
Scheduler dialog box (NT) 11-2
Scheduling a new activity (NT) 11-2
Scheduling a new activity (NW) 6-2

Scheduling array activities
overview (NW) 6-1

Scheduling options
setting (NT) 11-1

SCSI device
blinking drive lights (NT) 10-14
blinking drive lights (NW) 5-13
pausing I/O to (NT) 10-16
pausing I/O to (NW) 5-12

SCSI device information
viewing (NT) 9-8

SCSI device status, viewing 
(NW) 4-7

Server address
adding 7-1
deleting 7-6

Server configuration file A-4
Server events

viewing a list of (NT) 7-6
Server Historic Event Log

changing filter options 7-9
notification settings 7-10

Server information
viewing (NT) 7-11
viewing and editing (NT) 7-4

Server log
viewing (NW) 4-3

Server view A-4
Server, scanning (NT) 9-9
Server, scanning (NW) 4-8
Setting advanced array options 

(NT) 8-9
Setting the password (NW) 5-13
Severity levels 4-2
Spare

viewing information for (NT) 9-5
Spare pool

advantages of 3-12
creating (AC) 2-9
creating (NT) 8-14
creating (NW) 3-13
defined 2-8
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Index
deleting disk from (NT) 8-17
deleting disk from (NW) 3-14
limitations of 2-9, 3-13
viewing information for 

(NT) 8-15
viewing information for 

(NW) 3-15
Spare, dedicated

adding (AC) 2-10
adding (NW) 3-16
deleting (AC) 2-11
deleting (NT) 8-17
deleting (NW) 3-17

Spare, forcing (NT) 10-10
Spare, forcing (NW) 5-8
Spares

testing (NT) 10-11
testing (NW) 5-10

Spares, automatic testing of 3-12
Status, array 4-4
Stripe size 8-9

T
Test all spares operation A-3
Testing all spares (NT) 10-11
Testing all spares (NW) 5-10

V
Verifying an array A-2
Verifying an array (NT) 10-6
Verifying an array (NW) 5-4
Viewing a list of server events 

(NT) 7-6
Viewing array information (NT) 9-3
Viewing channel information 4-6, 

9-7

Viewing controller information 
(NT) 9-6

Viewing controller information 
(NW) 4-6

Viewing historical server 
information (NT) 7-11

Viewing SCSI device information 
(NT) 9-8

Viewing SCSI device information 
(NW) 4-7

Viewing spare information (NT) 9-5
Viewing spare pool information 

(NW) 3-15
Viewing the activity queue 

(NW) 6-4
Viewing the event log (NW) 4-1
Viewing the server log (NW) 4-3
Viewing/editing server information 

(NT) 7-4
virtual device order 3-7, 8-10

❒
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	Using the �ArrayConfig Initial Boot Array Installation Utility
	Creating an Array with �ArrayConfig
	1 Insert the copy of the �ArrayConfig diskette in drive A of the server with the Adaptec Array100...
	2 Select Disk Array Operations from the Main Menu.
	3 Select Create New Array from the Disk Array Operations menu.
	4 Type an array name and press Enter. The name can be up to 15 characters long and can include sp...
	5 Select an array type from the list. Your options are
	6 Type the number of drives you want in the array and press Enter. This number should not include...
	7 When the next screen appears, press Tab to highlight a channel (if your Adaptec Array1000 Famil...
	8 If you do not want a spare, type n and continue with Step�10. If you want to select dedicated s...
	a At the prompt, type y.
	b At the next prompt, type 1 or 2.
	c Select one or two spares, using the same method you used to select disks for the array.

	9 When the Initialize Mode menu appears, select Initialize Array to Zero. Formatting begins immed...
	10 When the menu of block sizes appears, select a block size. (This menu does not appear if the a...
	11 When you see the message Initialization of [array name] is complete, press any key to return t...
	12 To create additional arrays (if disks are available), repeat Steps 3-10. When all arrays are c...

	Making the Array Bootable
	1 Select Display Boot Order from the Main Menu. The Boot Order for Singles and Arrays window appe...
	2 If the newly created array is at the top of the list, preceded by the words Unit 0, no changes ...
	3 Use the arrow keys to move the selected array to the top of the list. Then press Enter to de-se...
	4 When you are finished, press Esc to return to the Main Menu.

	Other �ArrayConfig Options
	Displaying Array Information
	1 Select Disk Array Operations from the Main Menu.
	2 Select Display Arrays from the Disk Array Operations menu.
	3 When the list of arrays appears, highlight the array for which you want information and press E...
	4 View the information that appears on the screen. This includes array type and status, array siz...
	5 Press any key to return to the Disk Array Operations menu.

	Deleting an Array
	1 Select Disk Array Operations from the Main Menu.
	2 Select Delete Array from the Disk Array Operations menu.
	3 When the list of arrays appears, select the array you want to delete.
	4 View information about the array and make sure you really want to delete it. Press any key to c...
	5 Type y to delete the array (or n to cancel the operation).
	6 When the message [Array name] deleted appears, press any key to continue.

	Initializing an Array
	1 Select Disk Array Operations from the Main Menu.
	2 Select Format/Initialize Array from the Disk Array Operations menu.
	3 When the list of arrays appears, select the array you want to initialize.
	4 Type y to confirm that you want to format the array.
	5 When the Select Format Mode menu appears, select Initialize Array to Zero or Low-Level Format.
	6 When the list of block sizes appears, select a block size. The allowable block sizes are 8, 16,...
	7 When you see the message Initialization of [array name] is complete, press any key to return to...

	Creating and Deleting Spares
	Adding a Disk to a Spare Pool
	1 Select Spare Pool Operations from the �ArrayConfig Main Menu.
	2 Select Add Device to Spare Pool from the Spare Pool menu.
	3 Select a channel from the list, if necessary.
	4 Highlight a disk to add to the spare pool and press Enter.
	5 Repeat Steps 2-4 to add another disk to the spare pool. Spare pool disks can be connected to an...
	6 When you have finished adding disks, press Esc to return to the �ArrayConfig Main Menu.

	Deleting a Disk from a Spare Pool
	1 Select Spare Pool Operations from the �ArrayConfig Main Menu.
	2 Select Delete Device from Spare Pool from the Spare Pool menu. The disk most recently added to ...
	3 Repeat Step 2 to delete another disk from the spare pool, if desired.
	4 When you have finished deleting disks, press Esc to return to the �ArrayConfig Main Menu.

	Viewing Spare Pool Information
	1 Select Spare Pool Operations from the �ArrayConfig Main Menu.
	2 Select Display Spare Pool Devices from the Spare Pool menu.
	3 View the spare pool information that appears on the screen. When you are finished, press any ke...

	Adding a Dedicated Spare
	1 Select Disk Array Operations from the Main Menu.
	2 Select Add/Delete Spare Drive from the Disk Array Operations menu.
	3 Select the array to which you want to add the dedicated spare.
	4 Select Add Spare Drive from the Add/Delete Spare menu.
	5 Select a SCSI channel on the left, if necessary, and then press Æ to move to the list of disks ...
	6 Press any key to continue.

	Deleting a Dedicated Spare
	1 Select Disk Array Operations from the Main Menu.
	2 Select Add/Delete Spare Drive from the Disk Array Operations menu.
	3 When the list of spare drives appears, select the one you want to delete and press Enter.
	4 Select Delete Spare Drive from the Add/Delete Spare Drive menu. The dedicated spare is deleted ...
	5 Press any key to continue. The disk that was formerly a dedicated spare can now be used as a sp...






	Part 2
	Using Adaptec CI/O Array Management Software for NetWare

	3
	Configuring Arrays and Spares
	Starting and Exiting the Program
	1 Start the server, if it is not already running.
	2 Mount the sys volume, if it is not already mounted.
	3 At the �NetWare prompt, enter the command load cioams.nlm.
	4 When the Main Menu appears, as shown in Figure�3�1, you are ready to use Adaptec CI/O Array Man...
	Figure 3�1. CI/O Array Management Software Main Menu

	5 To exit Adaptec CI/O Array Management Software, return to the Main Menu and press Esc.
	6 Type y in response to the prompt to confirm that you want to exit. Then reboot the server if ne...

	Creating an Array
	1 Select Disk Array Operations from the Main Menu.
	2 When the Array Operations menu appears, select Create a New Array. The Select Drives to Create ...
	Figure 3�2. Select Drives to Create Array Window

	3 Highlight each disk you want to include as a member of the array (not as a spare) and press F5 ...

	Minimum Disks
	Maximum Disks
	Dedicated Spares
	Pool
	Spares
	1
	16
	None
	None
	2
	2
	1 or 2
	up to 8
	4
	16
	1 or 2
	up to 8
	3
	16
	1 or 2
	up to 8
	4 When all the disks needed for the array are highlighted, press Enter.
	5 When the prompt appears, enter a name for the array. You can use up to 15 characters, including...
	6 When the prompt appears, select a RAID level for the array. Then press Enter.
	7 When the prompt appears, select a Stripe Size for the array. Then press Enter. (This menu does ...
	8 (Optional) When you are prompted, select dedicated spares for the array by highlighting one or ...
	9 Press Enter when you are finished selecting spares. An event notification may appear at this po...
	10 When prompted, select Yes to initialize the array.
	11 Read the event notifications that indicate the array has been created successfully. Then press...
	12 A message appears indicating that the initialization process has started successfully. Press E...
	Figure 3�3. Graph of Initialization Process

	13 If you want to create another array, return to Step 1 and repeat the process. When you have de...
	Making an Array the First Virtual Device
	1 Select Disk Array Operations from the Main Menu.
	2 Select Make First Virtual Device from the Array Operations menu. The Make First Virtual Device ...
	Figure 3�4. Make First Virtual Device Window

	3 Highlight the array you want to select as the boot array, and press Enter.
	4 When the message appears, select Yes to confirm that you want this array to be the boot array. ...
	5 Read the event notification and press Esc to continue. The notification should indicate that th...
	6 Exit Adaptec CI/O Array Management Software. If the selected array does not already have a boot...

	Deleting an Array
	1 Select Disk Array Operations from the Main Menu.
	2 When the Array Operations menu appears, select Delete an Array. The Delete Array window appears...
	Figure 3�5. Delete Array Window

	3 Highlight the array you want to delete, and press Enter.
	4 When the message appears, select Yes to confirm that you want to delete this array.
	5 Read the event notifications that appear on the screen and press Esc to continue.

	Initializing an Array
	1 Select Disk Array Operations from the Main Menu.
	2 When the Array Operations menu appears, select Initialize an Array. The Initialize an Array win...
	Figure 3�6. Initialize an Array Window

	3 Highlight the array you want to initialize and press Enter.
	4 Select Yes to confirm that you want to initialize the array.
	5 A message appears indicating that the initialization process has started successfully. Press Es...
	6 Press Alt-Esc to return to the other screen. If you want to abort the initialization (not recom...
	7 When the initialization process is complete, exit Adaptec CI/O Array Management Software and re...

	Creating and Deleting Spares
	Using a Spare Pool
	Adding a Disk to the Spare Pool
	1 Select Spare Pool Operations from the Main Menu.
	2 Select Create a Pool Spare from the Spare Pool Operations menu. A screen similar to Figure�3�7 ...
	Figure 3�7. Create a Pool Spare Window

	3 Highlight a disk on the list and press Enter.
	4 Select Yes to confirm your choice.
	5 Read the event notifications that appear on the screen and press Esc to dismiss them.
	6 Repeat Steps 2-5, if necessary, to add more disks to the spare pool.

	Deleting a Disk from the Spare Pool
	1 Select Spare Pool Operations from the Main Menu.
	2 Select Delete a Pool Spare from the Spare Pool Operations menu. A screen similar to Figure�3�8 ...
	Figure 3�8. Delete a Pool Spare Window

	3 Highlight a disk on the list and press Enter.
	4 Select Yes to confirm your choice.
	5 Read the event notifications that appear on the screen and press Esc to dismiss them.
	6 Repeat Steps 2-5, if necessary, to delete other disks from the spare pool.

	Viewing Spare Pool Information
	1 Select Spare Pool Operations from the Main Menu.
	2 Select Display Spare Pool Drives from the Spare Pool Operations menu. A screen similar to Figur...
	Figure 3�9. Spare Pool Information Screen

	3 Press Enter to display detailed information about the selected spare pool device. Press Esc whe...


	Adding a Dedicated Spare
	1 Select Disk Array Operations from the Main Menu.
	2 Select Create a Dedicated Spare from the Array Operations menu. A list of arrays appears.
	3 Highlight the array to which you want to add a dedicated spare and press Enter. A list of avail...
	4 Highlight the disk you want to use as a spare and press Enter. Spares must have at least as muc...
	5 Select Yes to confirm that you want to add the dedicated spare.
	6 Read the event notifications that appear on the screen and press Esc to dismiss them.
	7 Repeat this process, if necessary, to add a second dedicated spare to the array.

	Deleting a Dedicated Spare
	1 Select Disk Array Operations from the Main Menu.
	2 Select Delete a Dedicated Spare from the Array Operations menu. A list of arrays appears.
	3 Highlight the array whose dedicated spare(s) you want to delete and press Enter. A list of arra...
	4 Highlight the dedicated spare you want to delete and press Enter.
	5 Select Yes to confirm that you want to delete the dedicated spare.
	6 Read the event notifications that appear on the screen and press Esc to dismiss them.
	7 Repeat this process, if necessary, to delete another dedicated spare from the array.






	4
	Viewing Server, Array, and Device Information
	Viewing the Event Log
	1 Select Display Event Log from the Main Menu. The Event Log appears, similar to Figure�4-1.
	Figure 4-1. Event Log

	2 View the Event Log entries.
	3 When you are done viewing the Event Log, press Esc to return to the Main Menu.

	Viewing the Server Log
	1 Select Display Server Log from the Main Menu. The Server Log appears, similar to Figure�4-2.
	Figure 4-2. Server Log

	2 View the log entries. The most recent entries are listed first. Each entry lists the time and d...
	3 When you are done viewing the Server Log, press Esc to return to the Main Menu.

	Viewing Array Information
	1 Select Disk Array Operations from the Main Menu.
	2 Select Display Array Configuration from the Array Operations menu. A screen similar to Figure�4...
	Figure 4-3. Array Information

	3 Select an array and press Enter. Read the array information listed in the window. This includes...
	4 Press Enter again. The Array Members Information window appears.
	5 Read the additional information, which includes the disk status (OKAY is the normal status), an...
	6 To view detailed information on a single array member or spare, including manufacturer and stor...
	7 When you have finished viewing this information, press Esc until you return to the Main Menu.

	Viewing Spare Information
	Viewing Controller and Channel Information
	1 Select Display Device Information from the Main Menu. A screen similar to Figure�4-4 appears.
	Figure 4-4. Controller and Channel Information

	2 Use the � and Ø keys to highlight the Adaptec Array1000 Family product you want in the window o...
	3 Press the Æ key to move to the Channels window, and highlight the device you want (if there is ...
	4 Press the Æ key to move to the Device Information window, and highlight the device you want. Th...
	5 When you have finished viewing information, press Esc to return to the Main Menu.

	Viewing SCSI Device Information
	1 Select Device Operations from the Main Menu.
	2 Select Display Device Information from the Select Device Operation menu. A screen similar to Fi...
	Figure 4-5. Drive Information

	3 Read the device information in the window.
	4 To view additional information, highlight a device in the window and press Enter.
	5 Read the additional SCSI device information, then press Esc repeatedly until you return to the ...

	Rescanning the Server
	1 Select Rescan System from the Main Menu.
	2 Select Yes to confirm that you want to rescan the system. A message appears on the screen while...
	3 Wait until the System rescan complete message appears.
	4 Press Esc to clear the message.
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	Performing Array, Device, and Password Operations
	Performing Array Operations
	Reconstructing an Array
	1 Determine which array is in Critical status and which disk in the array has failed. To do this,...
	2 If the drive enclosure does not support hot swapping, pause I/O to the array. (See Pausing I/O ...
	3 Replace the failed disk (or disks) with a good disk of at least the same storage capacity. Be s...
	4 Wait for I/O to resume after the pause period, if you paused it in Step�2.
	5 If you installed a new disk (or disks), make the disk into a spare by following the directions ...
	6 Select Disk Array Operations from the Main Menu.
	7 Select Reconstruct an Array from the Array Operations menu. The Reconstruct Array window appears.
	8 Highlight the Critical array and press Enter. A list of array members appears, similar to the o...
	Figure 5�1. Reconstruct Array Window

	9 Highlight the array member whose status is Down and press Enter. (In this example, the disk at ...
	10 Select Yes to confirm that you want to reconstruct the array.
	11 A message appears indicating that the reconstruct process has been started successfully. Press...
	12 Press Alt-Esc to return to the other screen. Press Esc to remove the event notification that a...
	13 View the Event Log to verify that the reconstruction completed successfully. (See Viewing the ...

	Pausing I/O on an Array
	1 Select Disk Array Operations from the Main Menu.
	2 Select Pause/Resume I/O on an Array from the Array Operations menu. The Pause Array window appe...
	3 Highlight the array you want to pause and press Enter.
	4 Read the message and enter a pause period that does not exceed the maximum pause period.
	5 Press Enter to pause I/O, and then wait a few seconds for all data I/O to stop.
	6 Do whatever you need to do to the array disks, such as reconnecting a cable or replacing a disk...

	Verifying the Integrity of an Array
	1 Select Disk Array Operations from the Main Menu.
	2 Select Verify Integrity of an Array from the Array Operations menu. The Verify Array window app...
	3 Select the array you want to verify.
	4 Select Yes to allow the program to automatically fix data miscompares, if any are detected. The...
	5 A message appears indicating that the verification has started successfully. Press Esc to remov...
	6 Press Alt-Esc to return to the other screen and wait for the verification process to finish.

	Blinking Member Drive Lights of an Array
	1 Select Disk Array Operations from the Main Menu.
	2 Select Blink Member Drives of an Array from the Array Operations menu. A screen similar to Figu...
	Figure 5�2. Blink Member Drives of an Array Window

	3 Highlight the array whose lights you want to blink and press Enter.
	4 Select Yes to confirm that you want to blink the array lights. A message appears to indicate th...
	5 Observe which disk lights are blinking. If the light on a drive that you know is an array membe...
	6 Press Esc to remove the message and stop the lights from blinking.

	Reactivating an Off-line Array
	1 Select Disk Array Operations from the Main Menu.
	2 Select Reactivate Offline Array from the Array Operations menu. The Reactivate Array window app...
	3 Highlight the off-line array on the list and press Enter.
	4 Select Yes to confirm that you want to reactivate the array. A confirmation message appears, an...
	5 Read the message and press Esc to dismiss it.

	Renaming an Array
	1 Select Disk Array Operations from the Main Menu.
	2 Select Change Name of an Array from the Array Operations menu. A list of arrays appears.
	3 Select the array you want to rename from this list and press Enter.
	4 Erase the current name with the Backspace key and type a new name for the array. You can use up...
	5 Press Enter.
	6 Read the event notifications that appear and press Esc to remove them.

	Forcing the Use of a Spare
	1 Be sure that one or more spares are available for the array. These can be either dedicated spar...
	2 Select Disk Array Operations from the Main Menu.
	3 Select Force the Use of a Spare from the Array Operations menu. A list of arrays appears in a �...
	4 Select an array and press Enter. A list of array members appears, similar to the one shown in F...
	Figure 5�3. Force a Spare Window

	5 Select the array member for which you want to force the use of a spare and press Enter.
	6 Select Yes to confirm your choice.
	7 Read the messages indicating that the disk has been downed and that a spare is being activated ...

	Testing All Spares
	1 Select Spare Pool Operations from the Main Menu.
	2 Select Test all Spares from the Spare Pool Operations menu. A message appears indicating that t...
	3 Press Esc to dismiss the message. Testing all spares takes very little time.
	4 Read the popup message that appears when the test is completed. (The message is also recorded i...
	5 If there are any failed spares, replace the disks with good disks of at least the same capacity...


	Performing Device Operations
	Downing a Device
	1 Select Device Operations from the Main Menu.
	2 Select Down a Drive from the Device Operations menu. A list of drives appears.
	3 Highlight a drive on the list and press Enter.
	4 Select Yes to confirm that you want to down the drive.
	5 Read the event notification message that appears and press Esc to dismiss it.

	Pausing I/O to a Drive
	1 Select Device Operations from the Main Menu.
	2 Select Pause/Resume I/O on Drive from the Device Operations menu. The Pause Device window appea...
	3 Highlight the drive you want and press Enter.
	4 Read the message and enter a pause period that does not exceed the maximum pause period.
	5 Press Enter to pause I/O.
	6 Do whatever you need to do to the disk, such as reconnecting a cable or replacing a disk. Be su...

	Blinking a Device
	1 Select Device Operations from the Main Menu.
	2 Select Blink a Device from the Device Operations menu. A screen similar to Figure�5�2 appears.
	3 Highlight the disk whose light you want to blink and press Enter.
	4 Select Yes to confirm that you want to blink the device’s light. A confirmation message appears.
	5 Observe which light is blinking in the RAID enclosure.
	6 Press Esc to remove the message and stop the light from �blinking.


	Setting the Remote Access Password
	1 Select Set Remote Access Password from the Main Menu. The screen shown in Figure�5�4 appears.
	Figure 5�4. Remote Access Password Screen

	2 Type the new password, using any combination of upper- or lower-case letters and the numerals 0...
	3 When you are prompted, type the new password again and press Enter. A message appears notifying...
	4 Press Esc to remove the message from the screen.
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	Scheduling and Monitoring Array Activities
	Scheduling a New Activity
	1 Select Activity Scheduler from the Main Menu.
	2 Select Schedule a New Activity from the Activity Scheduler menu. A screen similar to Figure�6-1...
	Figure 6-1. Select Activity to Schedule Window

	3 Select an activity from the list. A list of arrays appears.
	4 Select an array from the list.
	a If you selected Verify Array, select Yes or No for the Auto fix in case of error option. Then c...
	b If you selected Reconstruct Array, select the array member to reconstruct. Then continue with S...
	c If you selected Test All Spares, continue with Step�5.

	5 If you are running a Verify or Reconstruct activity, select Low, Medium, or High priority for t...
	6 Select one of the following Activity Schedule Modes (enter the options, if any, and press Enter):
	7 Press Esc to remove the message. The newly-scheduled activity is now an entry in the activity q...

	Viewing the Activity Queue
	1 Select Activity Scheduler from the Main Menu.
	2 Select Display Activity Queue from the Activity Scheduler menu. A screen similar to Figure�6-2 ...
	Figure 6-2. Scheduled Activity Information Window

	3 View the information in the Scheduled Activity Information window. The activity status can be R...
	4 Press Esc to continue.

	Deleting a Scheduled Activity
	1 Select Activity Scheduler from the Main Menu.
	2 Select Delete a Scheduled Activity from the Activity Scheduler menu. A screen similar to Figure...
	3 Highlight an activity on the queue and press Enter.
	4 Select Yes to confirm the immediate deletion of the activity.
	5 Press Esc to dismiss the confirmation message.

	Aborting a Running Activity
	1 Select Activity Scheduler from the Main Menu.
	2 Select Abort a Running Activity from the Activity Scheduler menu. A list of running activities ...
	3 Highlight an activity on the list and press Enter to abort it.
	4 Select Yes to confirm that you want to abort the activity. An event notification appears.
	5 Read the event notification and press Esc to dismiss it.

	Changing an Activity’s Priority
	1 Select Activity Scheduler from the Main Menu.
	2 Select Change Priority of an Activity from the Activity Scheduler menu. A list of running activ...
	3 Highlight a Verify or Reconstruct activity and press Enter. The Select Activity Priority window...
	4 Highlight the priority level you want—Low, Medium, or High—and press Enter.
	5 Read the confirmation message and press Esc to delete it.

	Monitoring the Progress of an Activity
	1 Select Activity Scheduler from the Main Menu.
	2 Select Watch Activity Progress from the Activity Scheduler menu. A list of running activities a...
	3 Highlight an activity in the Watch Activity Progress window and press Enter. A Running Activity...
	Figure 6-3. Running Activity Progress Window

	4 Wait until the window disappears, or press Esc to remove it and continue.
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	Entering and Viewing Client and Server �Information
	Entering and Viewing Server Information
	Adding a New Server Address
	1 Start the program by double-clicking the icon in the Adaptec CI/O Array Management Software group.
	2 Click the button. The New Server dialog box appears, as shown in Figure�7�1.
	Figure 7�1. New Server Dialog Box

	3 Select the IP or IPX radio button to indicate which kind of access is the default.
	4 Enter the server’s name or IP/IPX address, which can be up to 32 characters. This name will app...
	5 Enter a description of the server—for example, Application Server or Video Server. This descrip...
	6 Click OK to add the new server information. You will see one of the following error messages if...

	Viewing and Editing Server Information
	1 Click the button on the toolbar. The Server View window appears. Each server is represented by ...
	2 Double-click a server icon in the Server View window. The Server Information dialog box appears...
	Figure 7�2. Server Information Dialog Box

	3 View the server name, IP address, or IPX address.
	4 View or edit the server description. The description is for your information only and appears o...
	5 Click OK to exit the Server Information dialog box and to register any updated server information.

	Deleting a Server Address
	1 Select Server View from the File menu.
	2 Click the icon of the server you want to delete.
	3 Select Server Delete from the File menu. A prompt appears asking you to confirm the deletion of...
	4 Click Delete to delete the server address.

	Viewing a List of Current Server Events
	1 Select Server View from the File menu. The Server View window appears. The Global Current Event...
	Figure 7�3. Listing of Server Events

	2 View the event information for one or all servers. New entries appear on the list as the server...
	3 To view detailed information about an event, double-click the list entry. The Log Detail dialog...
	Figure 7�4. Log Detail Dialog Box

	4 Click OK when you are finished viewing the Log Detail dialog box. When you do this, you notify ...
	5 Click Filter in the Server View window to filter the events notifications in this window by sev...
	6 Click Save As in the Server View window to save the event list to a file.
	7 Close the Server View window when you are finished viewing the server events or, if you wish, l...
	Changing Filter Options
	1 Click the button on the toolbar. The Preferences dialog box appears.
	2 Click Filter. The Default Event Viewing Filter dialog box appears, as shown in Figure�7�5.
	Figure 7�5. Default Event Viewing Filter Dialog Box

	3 Select or deselect the Critical, Warning, or Informational entries to control which kinds of me...
	4 Click OK to record the filter option changes.

	Selecting Notification Settings
	1 Click the button on the toolbar. The Preferences dialog box appears.
	2 Click the Notification button; the Event Notification Options dialog box appears, as shown in F...
	Figure 7�6. Event Notification Options Dialog Box

	3 Select Pop-up Box, Beep, and/or Flash Title Bar to control how you will be notified of events t...
	4 Click OK to save these settings.


	Viewing Historical Server Information
	1 Click the button on the toolbar. The Server Historic Event Log window for the currently selecte...
	Figure 7�7. Server Historic Event Log Window

	2 View the historical information for the server. New entries are added to the top of the list as...
	3 To view detailed information about an entry on the list, �double-click the entry. The Log Detai...
	4 Click OK when you are finished viewing the Log Detail dialog box.
	5 Click Filter to change the message filter options. Click Clear All to delete all existing log e...
	6 Close the window when you are finished viewing log entries, or minimize it as an icon on the sc...


	Interpreting and Responding to Server Event Messages
	Entering and Viewing Preference Information
	1 Click the button. The Preferences dialog box appears, as shown in Figure�7�8.
	Figure 7�8. Preferences Dialog Box

	2 If you wish, enter a different name for the configuration file that is stored on the networked ...
	3 Click the Notification button to change the way in which you are alerted of event notifications...
	4 Click the Filter button to view the Log Filter dialog box. By selecting or deselecting the chec...
	5 Select a Password Time-out option to set the level of password protection for this workstation ...
	6 Click OK to change the option information or to close the dialog box.
	Editing the Permanent List
	1 Open the Server View window and select the icon of the server whose permanent list you want to ...
	2 Select Server Administration from the View menu.
	3 Select Edit Permanent List. Enter the server’s password when you are prompted to do so. The Edi...
	Figure 7�9. Edit Permanent List Dialog Box

	4 To add a new networked client entry, type the IP or IPX address in the field at the top of the ...
	5 To delete a networked client entry, highlight the entry in the list box and click the Delete bu...
	6 Click Close when you are finished. The changes are registered in the server’s permanent list file.
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	Configuring Arrays and Spares
	Starting the Program
	1 Start Windows.
	2 Double-click the icon in the Adaptec CI/O Array Management Software group to start the program.
	3 If you are running Adaptec CI/O Array Management Software from a server console, skip to Step�5...
	4 Click the icon of the server whose arrays and spares you want to configure, as shown in Figure�...
	Figure 8-1. Server Icons

	5 Open the Storage Configuration window by clicking the icon on the toolbar. All array and spare ...

	Creating an Array
	1 Start Adaptec CI/O Array Management Software and open the Storage Configuration window, as desc...
	Figure 8-2. Storage Configuration Window

	2 Before you start defining the new array, decide what RAID level you want to use, how many disks...

	Minimum Disks
	Maximum Disks
	Dedicated Spares
	Pool Spares
	1
	16
	None
	None
	2
	2
	1 or 2
	up to 8
	4
	16
	1 or 2
	up to 8
	3
	16
	1 or 2
	up to 8
	3 Select disks for the new array by clicking disk icons that have the word Single beneath them, a...
	Figure 8-3. Selecting Array Members

	4 Click the Create Array... button. The Create Array dialog box appears, as shown in Figure�8-4.
	Figure 8-4. Create Array Dialog Box

	5 Type a name for the new array. The name can be up to 15 characters, including spaces and any ot...
	6 Select a RAID level for the array by clicking one of the buttons on the left. The bar graphs on...
	7 Select one or two disks from the list as dedicated spares (if desired). (Use Ctrl-Click to sele...
	8 Click the Advanced... button if you want to examine or change the Advanced Array options. The A...
	9 Click OK and then click Yes to confirm that you want to create the array. You will see error me...
	10 Wait until the new array is initialized. A popup box will appear to inform you that event noti...
	11 Exit from Adaptec CI/O Array Management Software. Then reboot the server. (You cannot use the ...
	Setting Advanced Array Options
	Figure 8-5. Advanced Array Options Dialog Box

	Making an Array the First Virtual Device
	1 Start Adaptec CI/O Array Management Software and open the Storage Configuration window, as desc...
	2 Click the icon in the right part of the window for the array that you want to make bootable.
	3 Click the Operations button.
	4 Click the button.
	5 When the message appears, click OK to confirm that you want to make this array the boot device.
	6 Exit from the Adaptec CI/O Array Management Software. If the selected array does not already ha...
	7 Install the operating system on the array. See your Adaptec Array1000 Family product’s Installa...

	Deleting an Array
	1 Start Adaptec CI/O Array Management Software and open the Storage Configuration window, as desc...
	2 Click the icon in the right-hand area of the window for the array you want to delete.
	3 Click the Operations button.
	4 When the Array Operations dialog box appears, click the button to delete the array.
	5 When the confirmation message appears, click OK to confirm that you want to delete the array.

	Initializing an Array
	1 Start Adaptec CI/O Array Management Software and open the Storage Configuration window, as desc...
	2 Click the icon of the array you want to initialize. The Operations button becomes active.
	3 Click the Operations button.
	4 When the Array Operations window appears, click the button.
	5 When the confirmation message appears, click Initialize to confirm that you want to initialize ...

	Creating Dedicated Spares or a Spare Pool
	1 Start Adaptec CI/O Array Management Software and open the Storage Configuration window, as desc...
	2 Select the disk you want to configure as a spare by clicking on its icon in the left-hand part ...
	3 Click Create Spare... The Create Spare dialog box appears, as shown in Figure�8-6. A list of al...
	Figure 8-6. Create Spare Dialog Box

	4 If you want to dedicate the spare to a specific array, select Dedicated To and click the array ...
	5 Click OK to create the spare. A warning message appears if you select a disk that has a partiti...

	Deleting a Spare
	1 Start Adaptec CI/O Array Management Software and open the Storage Configuration window, as desc...
	2 Click the icon in the Array part of the window for the spare you want to delete.
	3 When the confirmation message appears, click OK to confirm that you want to delete the spare.
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	Viewing Array and Device Information
	1 Select Configuration from the View menu, or click the icon on the toolbar.
	2 When the Storage Configuration window appears, double- click the icon that represents the devic...
	Viewing Array Information
	Figure 9-1. Array Information Dialog Box

	Viewing Spare Information
	Figure 9-2. Spare Information Dialog Box

	Viewing Controller Information
	Figure 9-3. Controller Information Dialog Box

	Viewing Channel Information
	Figure 9-4. Channel Information Dialog Box

	Viewing SCSI Device Information
	Figure 9-5. SCSI Information Dialog Box

	Rescanning the Server
	1 Click the button on the toolbar. The Storage Configuration window appears.
	2 Click the Rescan button, which appears in the area between the Physical Resources and Array are...
	3 When the message appears, click Yes to confirm that you want to rescan the server. When the res...
	4 Click OK when the message appears indicating that the rescan was completed successfully.
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	Performing Array, Spare, and Disk Operations
	1 Select Configuration from the View menu, or click the icon on the toolbar.
	2 When the Storage Configuration window appears, single-click the icon that represents the array ...
	3 Click the Operations button. The Array Operations, Spare Operations, or Disk Operations dialog ...
	4 Click the button for the operation you want to perform. See the appropriate section of this cha...
	Performing Array Operations
	Reconstructing an Array
	1 Determine which array is in Critical status and which disk in the array has failed.
	2 If the array enclosure does not support hot swapping, pause I/O to the array. (See Pausing I/O ...
	3 Replace the failed disk (or disks) with a good disk of at least the same storage capacity. Be s...
	4 If you paused I/O in Step�2, wait until it automatically resumes after the pause period. If you...
	5 If you installed a new disk (or disks), make the disk into a spare by following the directions ...
	6 Select Configuration from the View menu. The Storage Configuration window appears.
	7 Click on the array icon that looks like this . The Operations button becomes active.
	8 Click the Operations button. The Array Operations dialog box appears, as shown in Figure�10-1.
	Figure 10-1. Array Operations Dialog Box

	9 Click the button. If the array has one failed drive the Scheduler dialog box appears.
	10 Enter the required information for the Reconstruct operation in the Scheduler dialog box. You ...
	11 Select an Execution Priority - high, medium, or low.
	12 Click OK.
	13 When the message appears, confirm that you want to reconstruct the array member.
	14 Read the event notifications that appear in the Server View window (they may also appear as po...

	Pausing I/O on an Array
	1 Open the Storage Configuration window and select the icon of the array you want to pause.
	2 When the Array Operations dialog box appears, click the button.
	3 When the Pause I/O dialog box appears, enter a pause interval that does not exceed the maximum ...
	4 Do whatever you need to do with the array disks. Data I/O resumes automatically at the end of t...

	Verifying Array Integrity
	1 Select Configuration from the View menu. The Storage Configuration window appears.
	2 Click on the array icon . The Operations button becomes active.
	3 Click the Operations button.
	4 When the Array Operations dialog box appears, click the button to verify the data on the array....
	Figure 10-2. Scheduler Dialog Box

	5 Leave the autocorrect box checked so that any data parity or mirroring mismatches will be corre...
	6 Select Immediate if you want to verify parity immediately, or select Scheduled if you want to s...
	7 If you select Scheduled, enter a start time, start day of the week, and other information. (See...
	8 Select an Execution priority - high, medium, or low. This determines how much system resources ...
	9 Click OK to start the operation (if you selected Immediate) or to enter it on the list of sched...
	10 When the message appears, confirm that you want to verify parity information.

	Blinking Array Drive Lights
	1 Select Configuration from the View menu. The Storage Configuration window appears.
	2 Click on an array icon in the right side of the dialog box. The Operations button becomes active.
	3 Click the Operations button.
	4 When the Array Operations dialog box appears, click the button.
	5 Look at the array enclosure to see which disks are members of the array.
	6 Click the Unblink all button in the Storage Configuration dialog box to stop the drive lights f...

	Reactivating an Off-line Array
	1 Select Configuration from the View menu. The Storage Configuration window appears.
	2 Click on the grayed-out icon of the off-line array. The Operations button becomes active.
	3 Click the Operations button.
	4 When the Array Operations dialog box appears, click the button.
	5 When the message appears, confirm that you want to reactivate the array. Be sure that any hardw...

	Changing an Array Name
	1 Select Configuration from the View menu. The Storage Configuration window appears.
	2 Click the icon of the array whose name you want to change. The Operations button becomes active.
	3 Click the Operations button.
	4 When the Array Operations dialog box appears, click the button. The Change Name dialog box appe...
	5 Type the new array name and click OK.
	6 When the confirmation message appears, confirm that you want to change the array name. This cha...

	Forcing a Spare
	1 Be sure that one or more spares are available for the array. These can either be dedicated spar...
	2 Select Configuration from the View menu. The Storage Configuration window appears.
	3 Click on the icon of the array with the suspect disk. The Operations button becomes active.
	4 Click the Operations button.
	5 When the Array Operations dialog box appears, click the button. This button is grayed out if no...
	6 Select the disk that you want to replace.
	7 Click OK to replace this disk with a spare.
	8 When the confirmation message appears, confirm that you want to replace the disk with the spare.


	Performing Spare Operations
	Testing All Spares
	1 Select Configuration from the View menu. The Storage Configuration window appears.
	2 Click on the icon of any spare on the right side of the dialog box. The Operations button becom...
	3 Click the Operations button.
	4 When the Spare Operations dialog box appears, click the button. The Scheduler dialog box appear...
	5 Select Immediate if you want to test all spares immediately, or select Scheduled if you want to...
	6 If you select Scheduled, enter a starting time, starting day, and other information.
	7 Select an Execution priority - high, medium, or low.
	8 Click OK to start the operation (if you selected Immediate) or to enter it on the list of sched...
	9 When the confirmation message appears, confirm that you want to test the spares.
	10 Read the popup message that appears when the test is completed. (The message is also recorded ...
	11 Replace any failed disks immediately with good disks of at least the same capacity.

	Blinking the Spare Drive Light
	1 Select Configuration from the View menu. The Storage Configuration window appears.
	2 Click on a spare icon in the right side of the dialog box. The Operations button becomes active.
	3 Click the Operations button.
	4 When the Spare Operations dialog box appears, click the button.
	5 Look at the array enclosure to see which disk light is blinking.
	6 Click the Unblink all button in the Storage Configuration window to stop the drive light from b...


	Performing Disk Operations
	Blinking the Drive Light
	1 Select Configuration from the View menu. The Storage Configuration window appears.
	2 Click on a disk icon in the left side of the window. The Operations button becomes active.
	3 Click the Operations button.
	4 When the Drive Operations window appears, click the button.
	5 Look at the array enclosure to see which disk light is blinking.
	6 Click the Unblink all button in the Storage Configuration dialog box when you want to stop the ...

	Downing the Drive
	1 Select Configuration from the View menu. The Storage Configuration window appears.
	2 Select the icon of the disk you want to pause.
	3 Click the Operations button.
	4 When the Drive Operations dialog box appears, click the button. If a spare is available, it rep...
	5 Wait until the Reconstruct operation is completed, and then continue with your work in the prog...

	Pausing I/O to a Disk Drive
	1 Select Configuration from the View menu. The Storage Configuration window appears.
	2 Select the icon of the disk you want to pause.
	3 Click the Operations button. When the Array Operations dialog box appears, click the button.
	4 When the Pause I/O dialog box appears, enter a pause interval that does not exceed the maximum ...
	5 Do whatever you need to do to the disk. Be sure to complete your work before the pause period e...
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	Scheduling and Monitoring Array Operations
	Setting Scheduling Options
	1 Define a new scheduled operation: Reconstruct an Array, Verify Integrity of Array, or Test All ...
	Figure 11-1. Scheduler Dialog Box

	2 Select Immediate to perform the action immediately or Scheduled to schedule it for later.
	3 If you select Scheduled, select Once, Periodically, Daily, or Weekly. Enter other information s...
	4 Click OK to record the scheduling options. You may be prompted to confirm the activity.

	Viewing and Managing Scheduled Activities
	1 Select Activities from the View menu. The Array Activity Monitor window appears, as shown in Fi...
	Figure 11-2. Array Activity Monitor Window

	2 Select an activity icon from the left part of the window. Information about the activity is sho...
	3 If you want to change the priority of a Verify or Reconstruct operation that is currently runni...
	4 If you want to delete an activity that is not currently running, select its icon and click the ...
	5 If you want to abort a currently-running activity, select its icon and click the Abort button. ...
	6 Click the Watch button to open a small window to monitor the selected, currently running activi...

	Monitoring Activities that are Running
	1 Select Activities from the View menu. The Array Activity Monitor window appears.
	2 Select the icon of a currently-running activity from the scrollable list at the top of the window.
	3 Click the Watch button. A small Watch window for this activity appears, as shown in Figure�11-3...
	Figure 11-3. Watch Window
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	Setting Security Options
	Setting the Initial Password
	1 Run Adaptec CI/O Array Management Software on the console of the server whose password you want...
	2 Select Server Administration from the View menu. Then select Change Password. The Change Passwo...
	Figure 12-1. Change Password Dialog Box

	3 Type the new password in the New Password field.
	4 Type the new password again in the Confirm Password field.
	5 Click OK to register the initial password.

	Changing the Password
	1 If you are working on a networked client, open the Server View window by clicking the button. T...
	2 Select Server Administration from the View menu. Then select Change Password. The Change Passwo...
	3 Type the existing password in the Old Password field.
	4 Type the new password in the New Password field.
	5 Type the new password again in the Confirm Password field.
	6 Click OK to accept the new password.

	Setting Password Time-out Options
	1 Click the button on the toolbar. The Preferences dialog box appears.
	2 Select one of the three Password Time-out options listed on the right of the dialog box. Here i...
	3 Click OK to accept the password time-out change. You may be required to enter the password in o...

	Controlling Guest Access
	1 On the networked client, open the Server View window by clicking the button. Then select the ic...
	2 Select Server Administration from the View menu. Then select Guest Access.
	3 When the Enable/Disable Guest Access dialog box appears, select or deselect the Enable Guest Ac...
	4 Click OK to enter the change. Enter the Adaptec CI/O Array Management Software password when yo...
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	Managing Arrays and Spares
	Responding to a Critical Array
	1 Click the array icon and observe the disk icons of the array members on the left of the screen....
	2 Click the icon and then click the Operations button.
	3 When the Drive Operations window appears, click the button to blink the drive light on the fail...
	4 Observe which drive light is blinking. This is the disk that you need to replace. If no lights ...
	a The disk is still connected but has failed so badly that it cannot respond to the Blink command...
	b The disk has been removed or its power cord or SCSI cable has been disconnected.
	c The disk does not have an LED that indicates I/O activity.

	5 If the array enclosure does not support hot swapping, pause I/O to the array before you continu...
	6 Replace the failed disk with a good disk, or replace the missing disk. Be sure to complete this...
	7 After I/O resumes automatically, select the icon of the new disk, and issue a Create a Spare co...
	8 When the spare has been created, select the array icon and issue a Reconstruct command, if nece...

	Responding to an Off-line Array
	Optimizing Array Performance
	Selecting a RAID Level for an Array
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